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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer
Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial
license.

Copyright Notice
© Copyright 1997 - 2014 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® andWindows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of TheOpenGroup.

Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go to: http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

The following table indicates changes made to this document since the last released edition.

Publication Date Summary of Changes

9.22 (2nd Edition, November 2013) l Added instructions about how to install the HP APM for PPM 9.22, see "Roadmap Entity Added to HP APM in
PPM Center Version 9.22" on page 76

l Added information about the SKIP_REQUEST_CREATE_CONFIRMATION_PAGE parameter, see "Request Creation
Confirmed Page Skippable" on page 148

9.22 (3rd Edition, December 2013) l Added onemore workaround for the issue that PPM Workbench cannot open after installing JRE7u25
l Updated the "Integrating HP APM with Universal CMDB" section to includemore details

9.22 (4th Edition, January 2014) l Added Swedish support in "Certifications" on page 174
l Added description about the three jar files contained in the PPM Center version 9.22 zip package in the

"Installation Notes" on page 3

Document Changes

Support
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed tomanage
your business. As a valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training
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Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions tomeet your
business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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Chapter 1: Overview
This document is an overview of the changes made to Project and Portfolio Management Center
(PPM Center) for version 9.22. It contains important information that is not included in themanuals.
You can find information about the following in this document:

l "Installation Notes" on page 3

l "New Features in PPM Center 9.22" on page 9

l "New Features in PPM Center 9.21" on page 85

l "Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.22" on page 100

l "Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.21" on page 185

l "Known Problems and Limitations in PPM Center 9.22" on page 251

l "Known Problems and Limitations in PPM Center 9.21" on page 261

l "Documentation Errata" on page 267

Software and Hardware Requirements
For information about the installation requirements and compatibility with other products, see the
System Requirements and Compatibility Matrix for PPM Center version 9.22. The support matrix
may be updated between releases, and so is only available at the HP Support web site:

http://support.openview.hp.com/selfsolve/manuals

Protecting Your Deployment from Security
Vulnerabilities

Make sure you take the necessary precautions to protect your PPM Center deployment from
general security vulnerabilities, especially those related toWeb server and related infrastructure
vulnerabilities. Patch and configure yourWeb server’s operating system and DNS servers to
prevent malicious attacks that could put your organization and data at risk. You can take such
steps as disabling unused ports or enabling SSL in your environment. Consult yourWeb server
vendor for the latest patches to prevent harmful attacks such as cross-site scripting.
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Chapter 2: Installation Notes

Note: The zip package of PPM Center version 9.22 contains three jar files:

l ppm-922-SP2.jar, the installation jar file for PPM Center version 9.22. The installation
instructions are provided below.

l ppm-922-LP-multi-lang.jar, language packs installation jar file for PPM Center version
9.22. Required only when you want to install a language pack.

Instructions for installing language packs are provided in theRelease Notes for Language
Pack for PPM Center 9.22, available at the HP Manuals site.

l ppm-922-APM.jar, the latest installation jar file for the HP APMmodule, offering the new
Roadmap feature in addition to all existing HP APM functionalities. Required only when you
need to use the Roadmap feature available with the HP APMmodule on PPMCenter
version 9.22.

For instructions about installing the HP APMmodule, see "Installing HP APM for PPM
9.22" on page 77.

This installation procedure includes steps that are valid for PPM Center version 9.22.

To install version 9.22:

1. Back up your database.

2. Back up your customized data.

The upgrade script may overwrite your customized files.

For example, if you configured LDAP integration previously, to avoid data loss, make sure you
back up the LdapAttribute.conf file, which is located in the <PPM_
Home>/integration/ldap directory on the PPM Server.

3. Stop the PPM Server. The Service Pack cannot be installed on an active server.

4. Copy the Service Pack file ppm-922-SP2.jar to the <PPM_Home> directory. This is the
directory where the PPM Server is installed.

5. Change to the <PPM_Home>/bin directory.
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6. Start the installation using the following command:
sh ./kDeploy.sh -i SP2

7. Follow the on-screen instructions to complete the Service Pack installation.

8. Restore your customized data (if any).

9. Start the PPM Server.

Note:HP recommends you back up your customized files including scripts before applying
version 9.22.
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Out-of-Sync Actuals Data
The following sections describe what to do if the pre-validation process during installation
determines that data is not synchronized between the HP TimeManagement and HP Project
Management modules or between the HP TimeManagement and HP DemandManagement
modules.

Data Out of Sync Between HP Time Management and
HP Demand Management

If, during the installation of PPM Center 9.22, the pre-validation process determines that actuals
data in the HP TimeManagement and HP DemandManagement modules are out of sync, an error
occurs and you cannot continue with the installation.

To resolve the problem:

1. Navigate to the <PPM_Home>/deploy/922/SP2/phases/prevalidation directory and run the
CorrectDMTMActualsOutOfSync.sql script.

2. After the CorrectDMTMActualsOutOfSync.sql script has run successfully, re-install PPM
Center 9.22.

Data Out of Sync Between HP Time Management and
HP Project Management

If, during the installation of PPM Center 9.22, the pre-validation process determines that actuals
data in the HP TimeManagement and HP Project Management modules are out of sync, an error
occurs and you cannot continue with the installation.

To resolve the problem:

1. To tag these data for synchronization, navigate to the
<PPM_Home>/deploy/922/SP2/phases/prevalidation directory and run the
MarkPMTMActualsOutOfSync.sql script.

2. Re-install PPM Center 9.22.

3. After you successfully install PPM Center 9.22, navigate to the <PPM_Home>/bin directory and
run the kPMTMSync.sh script, as follows, and redirect the output to a file:
sh ./kPMTMSync.sh -username<username> -password <password>
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Supported Upgrades

Note:HP strongly recommends upgrading to the latest version of PPM Center. In general,
each new PPMCenter version includes important product improvements that are not provided
in earlier versions.

Current PPM Center Version Can be upgraded to

8.0x 9.1x 9.2x

7.5 SP3 or earlier 1 8.00 or later 9.10 or later 9.20~9.22

7.5 SP4, 7.5 SP5, 7.5 SP6 1 8.02 or later 9.10 or later 9.20~9.22

7.5 SP7 1 8.03 or later 9.12 or later 9.20~9.22

8.00 2 8.00.01 or later 9.10 or later 9.20~9.22

8.00.01 2 8.02 or later 9.10 or later 9.20~9.22

8.02 2 8.03 or later 9.10 or later 9.20~9.22

8.03 2 (build 1189 and build 1208) 8.04 9.12 or later 9.20~9.22

8.04 — 9.14 (build 1460) 9.20~9.22

9.10 — 9.11 or later 9.20~9.22

9.11 — 9.12 or later 9.20~9.22

9.12 — 9.13 or later 9.20~9.22

9.13 — 9.14 (build 1460) 9.20~9.22

9.14 (build 1435 or build 1460) — — 9.20~9.22

9.14.0001~9.14.0004 3 — — 9.20~9.22

9.14.0005~9.14.0006 3 — — 9.21, 9.22

9.14.0007~9.14.0009 3 — — 9.22

9.20 — — 9.21, 9.22

9.21 — — 9.22

Table 1-1 Supported upgrades for current PPM Center versions
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Current PPM Center Version Can be upgraded to

8.0x 9.1x 9.2x

1. If you are upgrading from a version prior to version 8.00, incremental upgradesare necessary (for example:
version 7.5 to 8.00, followed by8.00 to 9.10, and then 9.10 to 9.20, and finally 9.20 to 9.22).

2. If you are upgrading from version 8.0x to 9.1x, youmust initially upgrade to version 9.10 before upgrading to
version 9.1x.

For example, PPMCenter versions9.10 and 9.11 were released before versions8.03 and 9.12. Versions8.03
and 9.12 include improvements to core functionalities that are not supported on the older versions9.10 and 9.11.

If PPMCenter is running at version 8.03, do not upgrade to and then run at version 9.10, 9.11, or 9.12. Instead,
upgrade from version 8.03 to version 9.10 temporarilywithout running PPMCenter, and then upgrade
immediately to version 9.12 or later.

3. Defect fixes included in patches (up until 9.14.0004) on top of version 9.14 are rolled into version 9.20. Version
9.21 contains defect fixes included in patches9.14.0001~9.14.0006. Version 9.22 contains defect fixes included in
patches9.14.0001~9.14.0009.

If PPMCenter is running at patch 9.14.0005 (or later, up until 9.14.0009), do not upgrade to and then run at
version 9.20 or 9.21. Instead, upgrade from patch 9.14.0005 (or later, up until 9.14.0009) to version 9.20
temporarilywithout running PPMCenter, and then upgrade immediately to version 9.22.

If PPMCenter is running at patch 9.14.0010 or later patch on top of version 9.14, do not upgrade to version 9.22
yet, otherwise youmayencounter some regression regarding the defect fixes in 9.14.0010 (and later).Youmust
wait, for the next available patch release, which contains the fixes through your current version. This compatibility
information can be found in the potential target release notes (table Supported upgrades for current PPMCenter
versions).

Table 1-1 Supported upgrades for current PPM Center versions, continued

Regenerating Web Service Stubs for Integrating
with HP ServiceCenter

If you have integrated your PPM Center deployment with HP ServiceCenter, you canmodify which
fields are available throughWeb services, but youmust regenerate theWeb service stubs for the
integration after installing any PPMCenter service pack.

After installing the service pack, regenerate theWeb service stubs in the PPM Server from the new
Web Services Description Language (WSDL) descriptor as follows:

1. Navigate to the <PPM_Home/bin/sdi> directory on the PPM Server.

2. Run the script:
sh ./kGenerateServiceCenterStub.sh <wsdl-url> <PPM_Server_Name>

where

<wsdl-url> represents the ServiceCenterWSDLURL for ChangeManagement.
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<PPM_Server_Name> represents the subdirectory of <PPM_Home>/server specified during
installation as the value for the KINTANA_SERVER_NAME parameter in the server.conf file. (It is
not necessarily the actual host name of the server.) When generated, the stubs will be placed
under this subdirectory.

For example, run the script:

sh ./kGenerateServiceCenterStub.sh http://host:12670/ChangeManagement?wsdl
kintana

Note: The stub configurationmight fail if the host is not resolvable by name. To resolve the
host by name, make an entry in the hosts file for themachine you want to connect. See
the documentation for your operating system for the location of the hosts file.

PPM Community on HPLN
The HP Project and Portfolio Management Center Community on HP Live Network
(http://www.hp.com/go/livenetwork) is now live! The PPMCommunity on HPLN
(http://www.hp.com/go/PPM_HPLN) is a virtual community for HP Experts, Partners and
Customers to collaborate and share knowledge, best practices, and add-on content for the PPM
product. You can log in to the PPMCommunity on HPLN to access the latest Content Packs.

Access to HP Live Network is available at no additional cost to all PPM customers. Customers
must log in using an HP Passport account. Customers without Passport accounts can register for
free on HP Live Network.
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Chapter 3: New Features in PPM Center 9.22
The following new features are included in PPM Center version 9.22:

l "Creating a Dashboard Datasource (and List Portlet) from a SQL SELECT Statement in the
Administration Console SQLRunner" below

l "Integrating HP APMwith Universal CMDB" on page 13

l "Integrating PPM Center Time Sheets with HP Agile Manager" on page 42

l "Roadmap Entity Added to HP APM in PPMCenter Version 9.22" on page 76

Creating a Dashboard Datasource (and List Portlet)
from a SQL SELECT Statement in the
Administration Console SQL Runner

Before version 9.22, if you want to create a Dashboard Datasource, you can only create it from
PPMWorkbenchmanually, writing the different parts of the SQL yourself and add all the columns
(with their types) one by one.

If you want to create a list portlet, you need to create a new portlet definition, select the datasource,
then add all the columns one by one.

Starting from version 9.22, this new feature allows you to create a dashboard datasource and a list
portlet from any SQL statement that runs in the Administration Console SQLRunner.

You can choose whether the dashboard and/or the list portlet is enabled or disabled upon creation.
Default choice is enabled, however youmight want to disable it if it is created on a production
environment and that some specific access grants should be added to it to restrict its access before
it can be used by PPMUsers.

Once created from the Administration Console, the datasource can be edited from PPMWorkbench
(to add filters and access grants) and the list portlet can be edited from the PPMCenter portlet
definition page, like any datasource or custom list portlet.

To create a dashboard datasource and a list portlet from the Administration Console,

1. Log on to PPM Center.

2. From themenu bar, select Open > Administration > Open Administration Console.
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3. Under the Administration Console node, select Administration Task > SQL Runner.

4. In the SQL Statement text box, run the SQL statement that you want to create a Dashboard
Datasource with.

5. Click theCreate Dashboard Datasource button.

The Create Dashboard Datasource dialog opens.

6. Specify names of the datasource and the list portlet that you want to create as described in the
table below.

Field/Option Description

Datasource
Name

Specify a name for the datasource that you want to create.

List Portlet
Name

Specify a name for the list portlet that you want to create.

The List portlet creation is optional. If you keep this field empty, no list portlet
will be created, and button name changes accordingly.
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Field/Option Description

Enable
Datasource

Select to enable the datasource upon its creation.

Enable List
Portlet

Optional. Select to enable the list portlet upon its creation.

If you choose to enable the List Portlet, any PPM User can add it directly to
their dashboard after the portlet creation.

Note:

n YouCANNOT enable the list portlet but disable the datasource.

n If you enter a name for the list portlet or datasource that already exists, you get an error
message.

For example,

7. Click Create Dashboard Datasource and List Portlet.

The Creation Successful confirmation pops up.

8. Click OK.
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9. If you chose to enable the List portlet, any PPM User can now add it directly to their dashboard.

SQL Syntax Accepted and Limitation
Most of the SQL syntax is accepted as long as it is a SELECT statement.

You can use the * operator for columns, such as:

SELECT * FROM KNTA_USERS;

All columns and their types will be discovered automatically.

However, you cannot use bind variables in the SQL. If you need to use bind variables, first create
the datasource with constants values set in place of variables, and then edit the datasource
definition in the PPMWorkbench to add the bind variables.
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Integrating HP APM with Universal CMDB
This section includes the following:

l "Overview" below

l "Supported Versions" on page 15

l "How to Integrate UCMDB and HP APM" on page 15

l "View UCMDB Data in HP APM" on page 25

l "Customize the Integration" on page 26

l "Developer References" on page 30

l "Troubleshooting and Limitations" on page 39

Overview
The integration between HP APM andHP Universal CMDB (UCMDB) enables you to share
information from UCDMB with HP APM.

You can use the integration to automate the creation and update of applications in HP APM, freeing
you from repetitive andmanual input of information in HP APM. This also ensures that HP APM is
kept up to date with real, accurate, discovered data in your environment.

The following table provides an overview of the HP APM integration with UCMDB:

Integration direction From UCMDB to HP APM

Integration technology Push adapter

Pushed data CIs created in UCMDB are pushed to HP APM to create
requests in HP APM

HP Universal CMDB adapter HP APM Push Adapter (APMPushAdapter)

How Data is Synchronized Between HP APM and UCMDB
When referring to the concept of data information, it is important to distinguish between a UCMDB
CI (Configuration Item) and an HP APM Application. Both are defined in a different DataModel, and
theremust be a conversion before transferring CIs in UCMDB to Applications in HP APM.
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The following graphic shows the high-level components of the integration:

Note: The Push Adapter is executed in the Data Flow Probe/Integration Service process.

UCMDB stores its information using CIs. The integration chooses which data to pull from UCMDB
by defining integration TQL queries. Each TQL query defines a superset of data relevant for the
integration.

TheUCMDB Push Engine:

l Retrieves the required data from the UCMDB, using the given TQL query.

l Filters the data to include only the data that has changed since the last execution of this
synchronization.

l Splits the data into multiple chunks without breaking consistency.

l Sends the information to the Probe/Adapter.

The Push Adapter is a generic framework for easily configuring push adapters, using only XML and
Groovy. It allows easy mapping of the data from the UCMDB datamodel into the HP APM data
model, and the transfer of this converted data into the HP APM database through REST APIs
called from HP APM.

For more information about push adapter, seeDeveloping Push Adapters in theHP Universal
CMDB Developer ReferenceGuide.

For details about REST APIs that this integration call from HP APM, see "REST APIs Called in the
Integration" on page 37.

For entity mappings and field mappings between HP APM andUCMDB, see "Default Entity and
Field Mappings between HP APM andUCMDB" on page 31.
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Supported Versions
The HP APM adapter supports the following:

l Universal CMDB version 10.00 and later

l HP Project and Portfolio Management Center (PPM Center) version 9.22 (and later) where HP
APM for PPM 9.20 is installed

How to Integrate UCMDB and HP APM
To set up integration between UCMDB and HP APM, youmust complete the following steps:

l "Deploy the APM Push Adapter" below

l "Create an Integration Point between HP APM andUCMDB" on the next page

l "(Optional) Push CI Data from UCMDB to HP APM" on page 20

l "Schedule Data Push Jobs" on page 24

Deploy the APM Push Adapter
To integrate HP APMwith UCMDB, administrators must deploy the APM Push Adapter.

Note: If your UCMDB version is 10.10, you can skip the steps below and proceed to "Create
an Integration Point between HP APM andUCMDB" on the next page. The APM Push Adapter
is deployed by default.

To download the APM Push Adapater zip package and deploy it,

1. Obtain the APM Push Adapter from the HP Live Network.

a. Go to the HP Live Network page for Integrations andOther Content for Discovery and
Dependency Mapping: https://hpln.hp.com//node/32/contentfiles?dir=17109

b. If you have not logged in, the HP Passport sign-in page opens.

Provide your User ID and Password, and click Sign-in.

c. Click APM integration package to download the APMPushAdapter.zip package.

2. Start the UCMDB server.
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3. Open a browser and log on to UCMDB as an administrator.

Example of the UCMDB login page URL:
http://<UCMDBServerName.Domain>:8080/ucmdb-ui/login_page.jsp

4. From the left navigation bar, click theAdministration tab.

5. Click Package Manager.

6. Click Deploy packages to server (from local disk) .

The Deploy Packages to Server dialog opens.

7. Click Add .

8. Browse to the folder where APMPushAdapter.zip is located. Select the zip file, and click
Open.

9. Click Deploy.

10. Click OK when the following confirmationmessage displays: Resources were deployed
successfully.

Create an Integration Point between HP APM and UCMDB
1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

UCMDB displays a list of existing integration points.

3. Click theNew Integration Point button.

The New Integration Point dialog box opens.

4. Complete the Integration Properties andAdapter Properties fields as shown in the following
table:

Field
(*Required)

Description

Integration Properties section
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Field
(*Required)

Description

*Integration Name Type the name (unique key) of the integration point.

Integration Description Type a description of the current integration point.

*Adapter Click theSelect Adapter button and select HP Software
Products > APM > APM Push Adapter from the Select Adapter
dialog

*Is Integration
Activated?

Select this option to indicate the integration point is active.

Adapter Properties section

*Protocol Type Select http or https from the drop-down list

*Hostname/IP Type the hostname or IP Address of the PPM Server. For
example, 16.166.16.16 or hostname.

*Port Type the communication port of the PPM Server. The default
value is 80. Example: 30000

*Path Type the path of the PPM Server. The default value is itg.
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Field
(*Required)

Description

*Credentials ID Click theSelect Credential Id button, then select Generic
Protocal orDefaultDomain > Generic Protocal in the Protocal
pane, and from the Credentials list, select a credential or create a
new credential that is to be used by UCMDB to access HP APM.

To create a credential for this integration point,

a. Click theSelect Credential Id button. The Choose
Credentials dialog opens.

b. Click theCreate new connection details for selected
protocol type button. TheGeneric Protocol Parameters
dialog opens.

c. Provide values for the following fields and click OK:

o Network Scope:Use the default value ALL.
o User Label: Type a label for the credential.
o User Name:Provide the user name for the HP APM

account that is to be used by UCMDB to access HP APM.
o Password:Click and provide the password for the

HP APM account that is to be used by UCMDB to access
HP APM.

d. Click OK twice.

Tip: Users of any of the following security groups can be
used as Credentials ID:

n APMUser
n APM Administrator
n APM Analyst
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Field
(*Required)

Description

*Data Flow Probe The name of the Data Flow Probe/Integration service used to
execute the synchronization from.

Select IntegrationService for this integration.

Note: If the IntegrationService option does not exist, consult
with your UCMDB administrator for the best selection for your
requirements.

Additional Probes Not required for this integration point.

Below is an example of the completed dialog:
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5. Click Test Connection to make sure there is a valid connection.

6. Click OK.

The integration point is created and its details are displayed. (It is not saved to the server until
you click on theOK button)

UCMDB creates a default data push job when creating the integration point. The default data
push job includes everything, it runs immediately and performs a Full Synchronization.

Note: The first Full Synchronizationmay take a while to complete.

If needed youmay create or edit the existing job. To create or edit and run a customized data
push job, see "(Optional) Push CI Data from UCMDB to HP APM" below.

For instructions about scheduling the data push job, see "Schedule Data Push Jobs" on page
24.

(Optional) Push CI Data from UCMDB to HP APM
Data push jobs copy or update CI or CI relationship records from the local UCMDB system to your
HP APM system.

To run a customized data push job, complete the following steps:

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

UCMDB displays a list of existing integration points.

3. Select the integration point you created for HP APM.

4. Select the default data push jobAPM Push.

Or, if the default data push job does not satisfy your needs, youmay add a new data push job
as follows:

a. Click theNew Integration Job button in the right panel.

b. In theName field, type a unique name for the job.
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c. Click theAdd Query button to add existing TQL queries to the job.

UCMDB creates a default data push job when creating the integration point for HP APM.
The following table lists the Topology Query Language (TQL) queries in the default data
push job. If required, youmay create, update, or remove TQL queries for the push job. You
may also need to update themapping. See .

Note: To access theseOOTB TQL queries for push, navigate toModelling >
Modeling Studio > Resources, select Queries from the drop-down list for the
Resource Type field and then navigate toRoot > Integration > APM Push.

TQL Query Description

APM Location
Push

Pushes Location CIs.

Mapping XML: pushMappingAPMLocation.xml

APM Process Push Pushes BusinessProcess CIs.

Mapping XML: pushMappingAPMProcess.xml

APM Process
Relation Clear
Push

Clears old relations between processes in HP APM.

This TQL query synchronizationmust have been run BEFORE
the 'APM Process Relation Push' TQL query synchronization.

Mapping XML: pushMappingAPMProcessRClear.xml

APM Process
Relation Push

Pushes relations between Processes (pushed by APM Process
Push) to other business elements or to processes.

BusinessProcess CIs must have been pushed before this TQL
query synchronization in the ‘APM Process Push’ TQL query
synchronization.

Mapping XML: pushMappingAPMProcessR.xml

APM Server Push Pushes Node CIs (Computers, Network Devices, etc.).

Mapping XML: pushMappingAPMServer.xml
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TQL Query Description

APM Server
Relation Clear
Push

Clears old relations between Servers in HP APM.

This TQL query synchronizationmust have been run BEFORE
the 'APM Server Relation Push' TQL query synchronization.

Mapping XML: pushMappingAPMServerRClear.xml

APM Server
Relation Push

Pushes relations between Servers (pushed by APM Server
Push) to other servers.

Node CIs must have been pushed before this TQL query
synchronization in the ‘APM Server Push’ TQL query
synchronization.

Mapping XML: pushMappingAPMServerR.xml

APM Application
Push

Pushes BusinessApplication CIs.

Location, BusinessProcess, and/or Node CIs must have been
pushed before this TQL query synchronization.

Mapping XML: pushMappingAPMApplication.xml

APM Application
Relation Clear
Push

Clears old relations (except for the downstream relations)
between Applications in HP APM.

This TQL query synchronizationmust have been run BEFORE
the 'APM Application Relation Push' TQL query synchronization.

Mapping XML: pushMappingAPMApplicationRClear.xml

APM Application
Relation Push

Pushes relations (except for the downstream relations) between
Applications (pushed by APM Application Push) to other
business elements or to nodes.

BusinessApplication CIs must have been pushed before this
TQL query synchronization in the ‘APM Application Push’ TQL
query synchronization.

Mapping XML: pushMappingAPMApplicationR.xml
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TQL Query Description

APM Application
Relation Clear
Down Push

Clears old downstream relations between Applications in HP
APM.

This TQL query synchronizationmust have been run BEFORE
the 'APM Application Relation Down Push' TQL query
synchronization.

Mapping XML: pushMappingAPMApplicationDownRClear.xml

APM Application
Relation Down
Push

Pushes downstream relations between Applications (pushed by
APM Application Push) to other business elements or to nodes.

BusinessApplication CIs must have been pushed before this
TQL query synchronization in the ‘APM Application Push’ TQL
query synchronization.

Mapping XML: pushMappingAPMApplicationDownR.xml

d. Select theAllow Deletion option for each query.

This allows deletion of synchronized data in HP APM when data in UCMDB are deleted.
Otherwise requests created in HP APM as a result of synchronization remain even when
their original data in UCMDB are deleted.

Note: For scheduling configuration, see "Schedule Data Push Jobs" on the next page.

e. Click OK.

f. Save the integration point.

5. Run the jobmanually to see if the integration job works properly:

a. To push all the relevant data for the job, click the All Data Synchronization button (or

Full Synchronization ).

b. To push only the changes in the data since the job last executed, click the Changes

Synchronization button (orDelta Synchronization ).

6. The job is inRunning status. Wait for the job to complete; click theRefresh
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buttonmultiple times as needed until the job is completed.

You can also look at the Query tab as that gives a progress bar against the query it is running.

7. When the job is completed, the job status becomes one of the following depending on the
results:

n Succeeded
n Passed with failures
n Failed

8. Click theStatistics tab to view the results; if any errors occur, click theQuery Status tab and
Job Errors tab for more information. For more information about errors, see "Troubleshooting
and Limitations" on page 39.

Schedule Data Push Jobs
UCMDB allows you to schedule job executions directly from a data push job.

1. Log in to UCMDB as an administrator.

2. Navigate toData Flow Management > Integration Studio.

UCMDB displays a list of existing integration points.

3. Select the integration point you created for the APM - UCMDB integration.

4. Select the APM Push job.

5. Click theEdit Integration Job button.

The Edit Integration Job dialog opens.

Note:UCMDB allows you to define two different schedules for two types of data push:
Changes Synchronization (orDelta Synchronization) andAll Data Synchronization
(or Full Synchronization). It is recommended to use the Changes Sync schedule to only
synchronize changes and avoid synchronizing the entire set of data each time.

6. Define a schedule for Changes Synchronization or Delta Synchronization.
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a. Click on theChanges Synchronization tab (orDelta Synchronization).

b. Select theScheduler enabled option.

c. Select the scheduling options you want to use.

7. Click theAll Data Synchronization tab (or Full Synchronization) and select the scheduling
options you want to use.

8. Click OK.

9. Save the integration point.

View UCMDB Data in HP APM
After a push job is successfully completed, you can search for and verify that the pushed
CI/relationship data is in HP APM.

To view UCMDB data in HP APM,

1. Log on to PPM Center.

2. On theOpenmenu, click Application Portfolio > Search Entities.

The Search Entities page opens.

3. In theEntities section, click one of the following entities:

n Application
n Location
n Process
n Server

The Search: APM - <Entity> page opens.

In this example, click Application and the Search: APM - Application page opens.

4. Click Search.

The Search Results page displays request search results.

5. Click any Application No to view an APM - <Entity> request.

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 25 of 310HP Project and Portfolio Management Center (9.22)



Customize the Integration
This section includes:

l "Overview" below

l "Customize an ExistingMapping" on the next page

l "Add a New Mapping to the Integration" on page 28

Overview
This section contains details about the architecture of the integration.

Data Flow Architecture

1. The Push Engine executes the TQL query.

2. For a differential flow, the data is compared to the last synchronized data, and only the
changes are forwarded.

3. Data is converted into Composite CIs (instances of data according to the TQLRoot elements).

4. Data is then pushed to the Push Adapter.

5. The Push Adapter loads the correct mapping for the specific TQL query.

6. All dynamic_mappings are executed and saved tomaps, to allow usage in the next mapping
stage.

For more information, seeDeveloping Push Adapters in theHP Universal CMDB Developer
ReferenceGuide.

7. Data is sent to HP APM database via REST APIs from HP APM, where REST APIs converts
data to HP APM compatible data.

Integration TQL Queries

A TQL query used for the integrationmust contain a root query node.

Any attribute used in themapping flow of the Push Adapter must bemarked in the selected layout
of the query node. Each TQL query may only have onemapping.
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Formore information, seeData Flow Management > Integration > Integration Studio >
Integration Studio User Interface > Integration Jobs Pane.

Customize an Existing Mapping
This example shows you how to add the NAME attribute to the integration including the TQL query
and Push Adapter Mapping. It allows the integration to push the NAME attribute to Location in HP
APM.

After completing the following steps, youmay run the job with the customizedmapping:

1. Add the NAME attribute to the APM Location Push TQL query layout.

In this step we add the NAME attribute of the Location to the integration TQL query (APM
Location Push TQL) so that we can use the attribute and value in themapping.

a. Navigate toModeling > Modeling Studio > Resources and select theQueries
Resource Type.

b. Navigate toQuery: Root > Integration > APM Push > APM Location Push.

c. Select Root, right-click and select Query Node Properties.

d. Go to the Element Layout tab.

e. Move theName to the Specific Attributes box.

f. Click OK.

g. Save the Query.

2. Add the NAME Mapping to the pushMappingAPMLocation.xml push adapter mapping.

In this step we take the value from the TQL result and remodel it to the HP APMDataModel.

a. Navigate toData Flow Management > Adapter Management > Packages >
APMPushAdapter > Configuration Files > pushMapingAPMLocation.xml.

b. Navigate to the <target_ci_type name="fields"> XML tag.

c. Below the tag, add the following XML tag to hold the value of the Description:

<target_mapping name="REQ.DESCRIPTION" datatype="STRING" value="APMPushFu
nctions.subString(Root['name'],200)"/>
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where, "REQ.DESCRIPTION" is the request Name field token of Location.

d. Click OK.

Add a New Mapping to the Integration
This example shows how to add a new TQL query and push-mapping to the integration. It also
shows how to push Locations from UCMDB to HP APM. It consists of the following steps:

Step 1: Create a TQL Query

1. Navigate toModeling > Modeling Studio > New > Query.

2. From theCI Types tab, add a Location to the query.

3. Right-click the Location Query Node and select Query Node Properties.

4. Rename theElement Name toRoot.

5. Navigate to theElement Layout tab.

6. Select Select attributes for layout.

7. In theAttributes condition drop down, select Specific Attributes, and add theName
attribute

8. Click OK.

9. Save the query toRoot > Integration > APM Push > APM Location Push.

Step 2: Create a Push-Mapping

1. Navigate toData Flow Management > Adapter Management > APMPushAdapter.

2. Click theCreate new resource button and select New Configuration File.

3. Type the following Name: APMPushAdapter/mappings/pushMappingAPMLocation.xml.

4. Select theAPMPushAdapter package.

5. Click OK.
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6. Copy the following into the newly created XML file:

<integration xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<info>

<source name="UCMDB" versions="10.0" vendor="HP"/>
<target name="APM" versions="2.0" vendor="HP"/>

</info>
<import>

<scriptFile path="mappings.scripts.APMPushFunctions"/>
</import>
<targetcis>

<source_instance_type query-name="APM Location Push" root-element-nam
e="Root" >

<target_ci_type name="request">
<target_mapping name="uuid" datatype="STRING" value="Root['globa

l_id']"/>
<target_mapping name="requestType" datatype="STRING" value="'APM

- Location'"/>
<target_mapping name="description" datatype="STRING" value="Root[

'name']"/>
<target_ci_type name="fields">

<target_mapping name="REQ.DESCRIPTION" datatype="STRING" value=
"APMPushFunctions.subString(Root['name'],200)"/>

</target_ci_type>
</target_ci_type>

</source_instance_type>
</targetcis

</integration>

In the following line:

<target_mapping name="requestType" datatype="STRING" value="'APM - Locatio
n'"/>

The value is the request type name in HP APM. In this example, it is APM - Location.

7. Click OK.

Step 3: Create a Job with the New TQL Query

1. Navigate toData Flow Management > Integration Studio.

2. Create an Integration Point with HP APM.

3. In the Integration Jobs tab, click theNew Integration Job button .
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4. Insert a job name in theName field.

5. Click the button, and choose theAPM Location Push query.

6. Click OK.

Step 4: Run the Job

1. Click on the job created in "Step 3: Create a Job with the New TQLQuery" on the previous
page.

2. Click the All Data Synchronization button (or Full Synchronization ).

3. Wait for the job to finish. You should click theRefresh button to see progress.

4. Make sure that the status is Succeeded.

Step 6: View the Results

1. Log on to PPM Center.

2. On theOpenmenu,

n Click Application Portfolio > Search Entities, then in theEntities section, click
Location. Or,

n Click Search > Requests, then from theRequest Type drop-down list, select APM -
Location.

3. Click Search.

The Search Results page displays request search results.

Developer References
This section includes the following:

l "Adapter" on the next page

l "Default Entity and Field Mappings between HP APM andUCMDB" on the next page

l "REST APIs Called in the Integration" on page 37
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Adapter
This integration job uses the adapter called APM Push Adapter. It is displayed as APM Push in the
Job Name.

Input CI Type

destination_config

Triggered CI Data

Name Value

adapterId ${ADAPTER.adapter_id}

attributeValues ${SOURCE.attribute_values}

credentialsId ${SOURCE.credentials_id}

destinationId ${SOURCE.destination_id}

Adapter Parameters

Name Value

credentialsId

domain itg

host

port 80

probeName

protocalType http

Default Entity and Field Mappings between HP APM and
UCMDB

The following sections describe out of the box mappings that are available with the APM Push
Adapter for integration with HP APM andUCMDB.
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The following table provides an overview of typemappings between HP APM entities and UCMDB
CI Types:

HP APM
Entity

PPM Center
Request Type

UCMDB CI Type Remarks

Application APM -
Application

BusinessApplication For detailedmappings, see
"Default Field Mappings between
HP APM Application and
UCMDB BusinessApplication"
below.

Process APM - Process BusinessProcess For detailedmappings, see
"Default Field Mappings between
HP APM Process and UCMDB
BusinessProcess" on page 34.

Location APM - Location Location For detailed field mappings, see
"Default Field Mappings between
HP APM Location and UCMDB
Location" on page 35.

Server APM - Server Node For detailed field mappings, see
"Default Field Mappings between
HP APM Server and UCMDB
Node" on page 36.

Default Field Mappings between HP APM Application and UCMDB
BusinessApplication

The following table describes the default field mappings that can bemodified for the integration
between the HP APM entity of Application and the UCMDB CI Type of BusinessApplication.

HP APM Field Name and Field
Type

UCMDB CI Attribute and Field Type

Name
KNTA_PROJECT_NAME
Text Field - 300

Name
name
string

Updated By a (N/A)
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HP APM Field Name and Field
Type

UCMDB CI Attribute and Field Type

Create On b

CREATION_DATE
Date

(N/A)

Purpose
APM_APP_PURPOSE
Text Field - 4000

Description
description
string

Business Criticality c

APM_RATING_BUSINESS_CRIT
Drop Down List

BusinessCriticality
business_criticality
integer

Created Bya

CREATED_BY
Auto Complete List

(N/A)

Supported Processes
APM_SUPPORTED_PROCESSES
Auto Complete List

Name (of CI Type BusinessProcess)
name (of CI Type BusinessProcess)

string

Downstream Applications
APM_DOWNSTREAM_APPS
Auto Complete List

Name (of downstream CI Type BusinessApplication)
name (of downstream CI Type BusinessApplication)
string

Upstream Applications
APM_UPSTREAM_APPS
Auto Complete List

Name (of upstream CI Type BusinessApplication)
name (of upstream CI Type BusinessApplication)

string

Service Level Agreement
APM_APP_SLA
Text Field - 200

Name (of CI Type ServiceLevelAgreement)
name (of CI Type ServiceLevelAgreement)
string

Servers
APM_SERVER_LIST
Auto Complete List

Name (of CI TypeNode)
name (of CI TypeNode)
string

Database
APM_DATABASE_LIST
Text Field - 200

Name (of CI TypeDatabase)
name (of CI TypeDatabase)
string
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HP APM Field Name and Field
Type

UCMDB CI Attribute and Field Type

a. The HP APM account you provided when creating the integration point (see "Create an Integration
Point between HP APM and UCMDB" on page 16).

b. Time when the request is created for the first time in HP APM.

c. The following mapping rule is used for this mapping:
<target_mapping name="REQD.APM_RATING_BUSINESS_CRIT" datatype="STRING"
value="APMPushFunctions.getPropertyValue('bc', Root['business_
criticality'].toString() , '')"/>
where the definition of ‘bc’ token is defined as follows in the server.properties field:

bc.0=0 - Least critical
bc.1=1 - Slightly critical
bc.2=2 - Less than average
bc.3=3 - More than average
bc.4=4 - Critical
bc.5=5 - Highly critical

When synchronizing the Business Criticality field from UCMDB to HP APM, if the value is ‘1’ in
UCMDB, then the field value will be set to ‘1 - Slightly critical’ in APM.

Default Field Mappings between HP APM Process and UCMDB
BusinessProcess

The following table describes the default field mappings that can bemodified for the integration
between the HP APM entity of Process and the UCMDB CI Type of BusinessProcess.

HP APM Field Name,
Database ID,
and Field Type

UCMDB CI Attribute,
Database ID,
and Field Type

Process Name
DESCRIPTION
Text Field - 200

Name
name
string

Parent Process
APM_PARENT
Auto Complete List

Name of parent BusinessProcess
name of parent BusinessProcess
string

Description
APM_DESCRIPTION
Text Area - 4000

Description
description
string

Created By a

CREATED_BY
Auto Complete List

(N/A)
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HP APM Field Name,
Database ID,
and Field Type

UCMDB CI Attribute,
Database ID,
and Field Type

Created On b

CREATION_DATE
Date

(N/A)

a. The HP APM account you provided when creating the integration point (see "Create an Integration
Point between HP APM and UCMDB" on page 16)

b. Time when the request is created for the first time in HP APM.

Default Field Mappings between HP APM Location and UCMDB
Location

The following table describes the default field mappings that can bemodified for the integration
between the HP APM entity of Location and the UCMDB CI Type of Location.

HP APM Field Name,
Database ID,
and Field Type

UCMDB CI Attribute,
Database ID,
and Field Type

Location Name
DESCRIPTION
Text Field - 200

Name
name
string

Description
APM_DESCRIPTION
Text Field - 4000

Description
description
string

Address
APM_LOC_ADDRESS
Text Field - 200

StreetAddress+ExtendedStreetAddress
street_address+extended_street_address
string+string

Postal Code
APM_LOC_ZIPCODE
Text Field - 20

PostalCode
postal_code
string

Country
APM_LOC_COUNTRY
Text Field - 200

CountryOrArea
country_or_area
string

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 35 of 310HP Project and Portfolio Management Center (9.22)



HP APM Field Name,
Database ID,
and Field Type

UCMDB CI Attribute,
Database ID,
and Field Type

Region
APM_LOC_REGION
DDL

Region
region
string

Longitude
APM_LONGITUDE
Text Field - 40

Longitude
longitude
string

Latitude
APM_LATITUDE
Text Field - 40

Latitude
latitude
string

City
APM_LATITUDE
Text Field - 200

Citya

city
string

State/Province
APM_STATE
Text Field - 200

Statea

state
string

a. The CI attribute is removed from UCMDB version 10.x, but exists in earlier versions of UCMDB. For
UCMDB instances that upgraded from an earlier version to 10.x, this CI attribute exists but is read-
only. If the CI attribute has a value, the value can be synchronized to HP APM, otherwise the HP APM
field remains empty after you run the synchronization push job in UCMDB.

Default Field Mappings between HP APM Server and UCMDB Node

The following table describes the default field mappings that can bemodified for the integration
between the HP APM entity of Server and the UCMDB CI Type of Node.

HP APM Field Name,
Token,
and Component Type

UCMDB CI Attribute Display Name,
Name,
and Type

Server Name
DESCRIPTION
Text Field - 200

Name
name
string
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HP APM Field Name,
Token,
and Component Type

UCMDB CI Attribute Display Name,
Name,
and Type

Description
APM_DESCRIPTION
Text Area - 4000

Description
description
string (value size: 1000)

IP Address
APM_IP_ADDRESS
Text Field, Max Length: 15

IP Address (of IpAddress)
ip_address (of IpAddress)
string

OS
APM_OS
Drop-down List

OsDescription
os_description
string

Running Software
APM_RUNNING_SOFTWARE
Text Area - 4000

ProductName:Name (of RunningSoftware)
product_name:name (of RunningSoftware)
product_name_enum:string

Location
APM_LOCATION
Auto Complete List

Name (of Location)
name (of Location)
string

REST APIs Called in the Integration
The following HP DemandManagement REST APIs are called in this integration to convert data
from UCMDB into HP APM compatible data:

l Get a request

For more information, seeGet Details of a Request section of theRESTful Web Services
Guide for PPM Center 9.20.

l Create a request

For more information, seeCreate/Update a Request section of theRESTful Web Services
Guide for PPM Center 9.20.

l Update a request

For more information, seeCreate/Update a Request section of theRESTful Web Services
Guide for PPM Center 9.20.
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l Delete a request

Added in version 9.22. For more information, see "Delete a Request" below

Delete a Request

Request: http://<PPM_Server_IP>:<port>/itg/rest/dm/requests/{reqId}

HTTP Method: DELETE

Description: Delete a request with a specific ID. To perform this operation, youmust be in one or
more of the authorized security groups for the create/update action.

Request path variables:

Attribute Description Required?

reqId Request ID. Indicates which request will be deleted. Yes

Response entity body:

l on success: When the operation is successfully executed, nomessage is returned. However,
the REST API automatically calls the GET operation and returns the followingmessage in
Response Header (with empty message body):

Status Code: 204 No Content
Cache-Control: no-cache
Date: Mon, 26 Aug 2013 09:20:29 GMT
Expires: -1
Pragma: no-cache

l on failure: The followingmessage codes are returned if the operation fails:

Message
Code

Message Cause Possible Corrective Action

PPMC_
WSE108

Not Found The quest is not found. The request ID is not passed
or the request of this ID
doesn’t exist.

PPMC_
WSE001

Internal Server
Error

There was an error
when you tried to delete
a request.

N/A
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Message
Code

Message Cause Possible Corrective Action

PPMC_
WSE116

Internal Server
Error

There was an error
when you tried to delete
a request.

N/A

Limitation:

This operation supports field security check, but it ignores user interface (UI) rules or status
dependency. Such constraints have to be validated and enforced on the client side before this
operation is invoked.

Troubleshooting and Limitations
This section includes the following:

l "Limitations" below

l "Troubleshooting Problems" on the next page

l "Logs" on page 41

Limitations
l The Data Flow Probe or Integration Servicemust be installed on aWindows OS.

l For requests created in HP APM from CIs pushed from UCMDB, any changes made in HP APM
are overwritten when you run the data push job in UCMDB.

l The APM Application request form holds a single value for Location, therefore it is designed to
push only one value for Location of the Application from the UCMDB BusinessApplication.

In the definition of Location of the Application (see the pushMappingAPMApplicationR.xml
file), the Location of the Server is used for the Location of the Application is used. For an
Application that contains multiple servers, select one of the servers and then you can get its
Location.

l For valuemappings between UCMDB and HP APM, certain mapping rules are followed.
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For example, when synchronizing the Business Criticality field of Application, the following
mapping rule is used for themapping:

<target_mapping name="REQD.APM_RATING_BUSINESS_CRIT" datatype="STRING" value="
APMPushFunctions.getPropertyValue('bc', Root['business_criticality'].toString(
) , '')"/>

where the definition of ‘bc’ token is defined as follows in the
<APMPushAdapter.zip>/mappings/scripts/server.properties file:

bc.0=0 - Least critical
bc.1=1 - Slightly critical
bc.2=2 - Less than average
bc.3=3 - More than average
bc.4=4 - Critical
bc.5=5 - Highly critical

When synchronizing theBusiness Criticality field from UCMDB to HP APM, if the value is ‘1’
in UCMDB, then the field value will be set to ‘1 - Slightly critical’ in APM.

If you need to use this valuemapping for other fields from UCMDB to APM, make sure you
customize themapping by following the example above.

l This integration does not support synchronizing values in languages that are not supported by
UCMDB. For example, Simplified Chinese.

l The ";" character is not supported. If a UCMDB CI name contains a ";" character, it would be
treated as a separator and two entries would show up in HP APM after synchronization.

Troubleshooting Problems
l Problem:SomeUCMDB CIs include characters that are not supported in APM Entities. For

example, semicolon (;).

Solution: The suggested solution is to modify the content synchronized from UCMDB to APM.
You can use the Replace function to replace the unsupported characters for this field mapping in
the XMLmapping file. However, note that this may cause inconsistent content between
UCMDB and APM.

An example, in the pushMappingAPMApplication.xml file, the semicolon character (;) is
replaced with a space:

<target_mapping name="REQ.KNTA_PROJECT_NAME" datatype="STRING" value="APMPushF
unctions.stringReplace(Root['name'], ';', ' ')"/>
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l Problem: For some fields, the field value lengths between HP APM andUCMDB are different,
therefore youmay need to customize the field mapping. You can follow the example below:

Example

Use a substring as illustrated below to limit the field length to 200 characters:

<target_mapping name="REQ.DESCRIPTION" datatype="STRING" value="APMPushFunctio
ns.subString(APMPushFunctions.stringReplace(Root['name'],';',' '),200)"/>

Logs
The push adapter framework uses a different logging system for the normal fcmdb.adapters.*.log
files.

To change the level of the log files to debug, edit the following file:

l On the Data Flow Probemachine:

..\DataFlowProbe\conf\log\fcmdb.push.properties

l If using the integration service, on the UCMDB server:

..\UCMDB Server\Integrations\conf\log\fcmdb.push.properties

Change the log level to DEBUG:

loglevel=DEBUG

The integration generates fcmdb.push.* logs in the following folder:

l On the Data Flow Probemachine:

..\DataFlowProbe\runtime\log\

l If using the integration service, on the UCMDB server:

..\UCMDB Server\Integrations\runtime\log\
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Integrating PPM Center Time Sheets with HP Agile
Manager

This section contains the following:

l "Introduction to Integrating PPM Center Time Sheets with HP Agile Manager" below

l "Downloading and Installing the Agile Manager Integration Plug-in for PPM Version 1.2" on page
46

l "Configuring the Integration between PPMCenter Time Sheets and HP Agile Manager" on page
49

l "Importing Agile Effort from HP Agile Manager to PPM Center Time Sheets " on page 51

l "Troubleshooting and Limitations" on page 73

Introduction to Integrating PPM Center Time Sheets
with HP Agile Manager

Version 9.22 implemented this new feature to extend the capability of the integration solution
between PPMCenter and HP Agile Manager. The integration between PPMCenter time sheets
and HP Agile Manager allows end users to import agile effort from HP Agile Manager into their PPM
Center time sheets, freeing them from reporting their time repeatedly and thus ensuring data
consistency between different management tools. This integration also ensures information sharing
between product development teams and project managers, which facilitates project execution with
right decisions.

This integration is a one-way (from HP Agile Manager to PPM Center) and one-multiple mapping
relationship (one time sheet to multiple releases).

Implementation of the feature includes the following:

l Leveraged and enhanced the existing Agile Manager Integration Plug-in for PPM

Formore information about the plug-in, see "Compatibility of Agile Manager Integration Plug-in
for PPM" on page 46.

l Introduced new server configuration parameters

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 42 of 310HP Project and Portfolio Management Center (9.22)



Parameter Name Description, Usage Default and Valid
Values

ENABLE_TM_
WORK_ITEM_
EXTERNAL_DATA

Setting the parameter to truemakes the
External Data option available in the following
PPMWorkbench windows:

n On theWork Items and Activities tabs of the
Time Sheet Policy window

Selecting theExternal Data option on the
Work Items tab ensures that,

o TheAdd External Data option is
available in theAdd Items action list of
the Time Sheet page

o TheExternal Data option is available on
the CreateWork Allocations page as a
work item type.

For information about the usage of
activities, see theHP TimeManagement
Configuration Guide and theHP Time
Management User’s Guide.

n In theWork Item Type drop-down list (under
the Dependencies section) of the Override
Rule window

Note:Changes made to the time sheet
policy and override rules apply to new time
sheets only.

Default: true

Valid values: true,
false
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Parameter Name Description, Usage Default and Valid
Values

MAX_
CONCURRENT_
AGM_REST_CALL_
FOR_TIMESHEET

Specifies themaximum number of concurrent
users to import time information from HP Agile
Manager.

Default: 10

Valid values:
integer

Recommended
value range: 1~50

l Introduced a new time sheet item typeExternal Data to the HP TimeManagement module.

Features available with the new item type include:

n Enable/Disable External Data items to have time information imported and tracked in PPM
Center

n Charge code can be allocated to External Data items

n Override rules can be applied to External Data items
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n Work allocations can be applied on External Data items

n Activities can be specified on External Data items

How Data is Imported from HP Agile into PPM Center
Time Sheets

After users click Add External Data on their time sheets, select HP Agile Manager from the
Select an external system drop-down list, and provided required credentials, the Agile Manager
Integration Plug-in for PPM calls HP Agile Manager REST APIs to get data in the following
sequence,

1. Get release list for a specific project from HP Agile Manager

2. Get sprint list from available releases, where the sprints shall fall into the user's current time
sheet period

3. Get backlog list from qualified sprints

A qualified sprints shall satisfy the following criteria:

n The sprint start date is the same or later than the time sheet period start date

n The sprint end date is same as or earlier than the time sheet period end date.
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If the time sheet period contains unqualified sprints, the effort in these unqualified sprints will
not be retrieved by the plug-in. Users will get a warningmessage when the release contains
unqualified sprints.

4. Get task list by assign-to value and status value, where assign-to value is the HP Agile
Manager user email address, and the status value is Completed.

5. Then the Agile Manager Integration Plug-in for PPM,

a. Adds together values for the Invested (h) field for all returned tasks for each of the releases

b. Imports the total effort of a release as an entry

c. Divides the total effort by available working days in the current time sheet period, and

d. Fills the average effort value to each of the working days in the time line.

For details about the REST APIs, see "REST APIs Called in the Integration" on page 54.

Downloading and Installing the Agile Manager
Integration Plug-in for PPM Version 1.2

To integrate PPM Center time sheets with HP Agile Manager, administrators must download and
install the free Agile Manager Integration Plug-in for PPM. This is a one-time action.

Compatibility of Agile Manager Integration Plug-in for
PPM

The table below describes compatibility of the Agile Manager Integration Plug-in for PPM with PPM
Center.

Agile Manager Integration
Plug-in for PPM version

PPM Center version

9.20 9.21 9.22

1.0 X — —

1.1 a X X —

1.2 b — — X
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Agile Manager Integration
Plug-in for PPM version

PPM Center version

9.20 9.21 9.22

a. Though version 1.1 plug-in can be deployed on both versions (9.20 and 9.21) of PPMCenter, system behaves
differently due to the new feature available with PPMCenter 9.22 ("AssociatingWaterfall Projects to PPMCenter Tasks"
on page 85):

l When deployed on PPMCenter version 9.20, users see the sameAgile Project tab on the TaskDetails page and
Agile Project Timeline tab on the Project Overview page;When deployed on PPMCenter version 9.21, the Agile
Project tab ismerged into the newHybrid Project tab on the TaskDetails page, and the Agile Project Timeline tab is
merged into the Timeline tab on the Project Overview page. For more information, see "SystemBehavioral
Differenceswith the Enhanced Agile Manager Integration Plug-in for PPM " on page 238

l OnPPMCenter version 9.21, two new charts are available for linked agile projects on the Timeline tab of the Project
Overview page.

b. For new users of the integration solution between PPMCenter and HPAgile Manager, you can simply download and
deploy version 1.2 of the Agile Manager Integration Plug-in for PPM on PPMCenter version 9.22 instance. See
"Downloading and Installing the Agile Manager Integration Plug-in for PPMVersion 1.1" on page 240

For existing users of the integration solution between PPMCenter and HPAgile Manager, after upgrading PPMCenter
to version 9.22, to continue to use the integration solution and/or to use the new feature, make sure you download and
deploy version 1.2 of the Agile Manager Integration Plug-in asearly aspossible. Otherwise the integrationmaynot work
due to changesmade byHPAgile Manager.

Installation Instructions
To download and install the Agile Manager Integration Plug-in for PPM:

1. Obtain the plug-in bundles from the HP Live Network.

a. Go to the PPMCommunity on HP Live Network..

b. On the PPMCommunity home page, click Content Catalog.

c. Click Agile Manager Integration Plug-in for PPM (where HP is the provider).

d. Click Downloads.

The Agile Manager Integration Plug-In for PPM - Downloads page opens.

e. Click theAgile Manager Integration Plug-In for PPM 1.2 folder.

f. Click ppm-922-AgilePlugin.zip to download the package.

This package contains the following two bundles:
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Bundle name Description

ppm-922-PluginAgile.jar Contains basic structure of version 1.2 plug-
in for integrating PPM Center with agile
project management tools.

ppm-922-PluginAgileManagement.jar Contains version 1.2 plug-in files specifically
for integrating PPM Center with HP Agile
Manager product, including:

o Integrating PPM Center tasks with HP
Agile Manager releases, and

o Integrating PPM Center time sheets with
HP Agile Manager

2. Stop PPM Server.

3. Unzip the package and copy the two bundles to the <PPM_Home> directory.

4. Deploy the bundles by running the following commands from the <PPM_Home>/bin directory:

sh ./kDeploy.sh -i PluginAgile

sh ./kDeploy.sh -i PluginAgileManagement

5. Repeat step 3 and step 4 for each of the server nodes in a cluster.

6. Restart PPM Server.

Entities Installed by the Agile Manager Integration Plug-
in for PPM Version 1.2

The following entities are installed:

l The Agile Integration Solution configuration page

The Agile Integration Solution option is now available on the integration configuration landing
page. Administrators can register HP Agile Manager servers on the Agile Integration Solution
configuration page.

l Agile Solution Sync Service

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 48 of 310HP Project and Portfolio Management Center (9.22)



The Agile Solution Sync Service synchronize status and progress charts of agile projects from
HP Agile Manager to PPM Center. The default synchronization interval is 24 hours. You can set
the synchronization interval on the Schedule Services page.

l For the integration between PPMCenter tasks and HP Agile Manager only:

n The "Associate Agile Project to this Task" section and theMapping Agile Project button on
theHybrid Project tab of the Task Details page

n Support for displaying Gantt charts of associated agile projects on the Timeline tab of the
Project Overview page

l For the integration between PPMCenter time sheets and HP Agile Manager only:

n In the Import External Data window, HP Agile Manager appears as an available value for the
Select an external system field. SelectingHP Agile Manager loads more configuration
settings to the window.

If the Agile Manager Integration Plug-in is not deployed, theSelect an external system field
is empty.

Configuring the Integration between PPM Center Time
Sheets and HP Agile Manager

This section describes the steps that PPM Center administrators must perform to set up the
integration between PPMCenter time sheets and HP Agile Manager.

Prerequisites
Make sure you satisfy the following prerequisites before you can proceed to set up the integration:

l PPMCenter is on version 9.22 and the Agile Manager Integration Plug-in for PPM version 1.2 is
installed.

l You have obtained a valid HP Agile Manager account.
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Setting Up the Integration
To set up the integration,

1. Log on to PPM Center as administrator.

2. (Optional) Launch the Administration Console and check that the ENABLE_TM_WORK_
ITEM_EXTERNAL_DATA server configuration parameter is set to true.

The parameter is set to true by default. In case you changed the parameter value to false,
change it back to true.

3. In the PPMWorkbench, enable theExternal Data option on theWork Items tab of the desired
time sheet policy.

a. From themenu bar, select Open > Administration > Open Workbench (orOpen
Workbench on Desktop).

The PPMWorkbench opens.

b. From the shortcut bar, select Time Mgmt > Time Sheet Policies.

The Time Sheet Policy Workbench opens.

c. Click List.

d. From theResults tab, select and open the desired time sheet policy.

In this example, the Semi-Monthly - Day - Hours time sheet policy opens.

e. Click theWork Items tab.

f. Select the checkbox for theExternal Data option.

Note: This setting applies to new time sheets only. Existing time sheets still load the
old time sheet policy, therefore users cannot add external data to their old time sheets.

g. Click OK.

4. Add an agile integration configuration for the target HP Agile Manager server system on the
integration landing page.
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For detailed instructions, seeChapter 11, Integrating PPM Center with HP Agile Manager in
theHP Solution Integrations Guide.

Importing Agile Effort from HP Agile Manager to PPM
Center Time Sheets

To import agile effort from HP Agile Manager into your PPM Center time sheet,

1. Log on to PPM Center.

2. From themenu bar, select Create > Time Sheet.

The Create Time Sheet page appears.

3. Complete the following fields or option:

n Time Period

n Resource

n Description

n Include Items fromMy Items List

For detailed information about these fields, seeHP TimeManagement User’s Guide.

4. Click Create.

The time sheet is created and the Edit Time Sheet page appears.

5. Click Add Items, and then select Add External Data from the available actions.

The Import External Data window appears.

6. From theSelect an external system drop-down list, select HP Agile Manager.
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More configuration settings are loaded.

7. From theSelect a system server drop-down list, select an HP Agile Manager server that was
configured by your administrator on the integrations landing page.

8. In theUsername andPassword fields, enter the username and password of your HP Agile
Manager account.

By default, the username is the current login user’s email address in PPM Center. You can edit
the username if the email address is not the HP Agile Manager login account.

9. Click Next.

The system retrieves and loads effort data for tasks with status of Done from available
releases in HP Agile Manager.

Note: It takes around 40 seconds to retrieve and load the effort data.
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Review the list of available releases. If necessary, you can click the icon to remove the
unwanted release from the list.

Note: If you see a warningmessage as shown in the screenshot below, it indicates that
the release from HP Agile Manager is not aligned with the PPMCenter time sheet period.

10. Click Import.

The HP Agile Manager effort are imported and distributed to each of the working days of the
time sheet.
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The time sheet line Item name is displayed in the following format:

<HP_Agile_Server_Name>:<Release_Name>
<Domain_Name>><Project_Name>

The imported entries are displayed under theExternal Data section.

11. Review and edit the time sheet lines if necessary.

12. Click Save orSave&Submit.

REST APIs Called in the Integration
The following HP Agile Manager REST APIs are called in this integration to retrieve and import data
from HP Agile Manager into PPM Center time sheets.

Sequence and
Description

HP Agile Manager REST API called

1. Get domain list https://<AgileManager_Server_URL>/qcbin/rest/domains/

2. Get project list of
one domain

https://<AgileManager_Server_
URL>/qcbin/rest/domains/<domain_name>/projects/

3. Get release list of
one project

https://<AgileManager_Server_
URL>/qcbin/rest/domains/<domain_name>/projects/<project_
name>/releases/
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Sequence and
Description

HP Agile Manager REST API called

4. Get a specific
release

https://<AgileManager_Server_
URL>/qcbin/rest/domains/<domain_name>/projects/<project_
name>/releases?query={id[<release_id>]}

5. Get sprint list of one
release

https://<AgileManager_Server_
URL>/qcbin/rest/domains/<domain_name>/projects/<project_
name>/release-cycles?query={parent-id[<release_id>]}

6. Get backlog list of
sprints

https://<AgileManager_Server_
URL>/qcbin/rest/domains/<domain_name>/projects/<project_
name>/release-backlog-items?query={entity-type
[requirement];sprint-id[<sprint_id1> OR <sprint_id2> OR
...]}

7. Get task list of one
backlogs by assign-
to and status

https://<AgileManager_Server_
URL>/qcbin/rest/domains/<domain_name>/projects/<project_
name>/project-tasks?query={release-backlog-item-id
[<backlog_id1> OR <backlog_id2> OR …];assigned-to[<agile_
user_mail_address>];status[Completed]}

Data Table Changes
This section describes the changes to the datamodel as a result of the implementation of this
integration solution.

Table Name Impact Change Details

PPM_INT_TIMESHEET_DATA Added in 9.22

PPM_INT_WORK_ITEM_SET Added in 9.22

ITG_ACTIVITIES Modified in 9.22 Added the following column:

l IS_USED_FOR_ITG

KTMG_POLICIES Modified in 9.22 Added the following two columns:

l ITG_ACTIVITIES_REQUIRED_
FLAG

l WORKITEM_INT_ENABLED_FLAG

Table changes in 9.22 as compared to 9.21
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Table Name Impact Change Details

TM_TIME_SHEETS Modified in 9.22 Added the following two columns:

l ITG_ACTIVITIES_REQUIRED_
FLAG

l WORKITEM_INT_ENABLED_FLAG

Table changes in 9.22 as compared to 9.21, continued
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PPM_INT_TIMESHEET_DATA
This table stores time sheet line data that created by imported external data..

Foreign Keys

Primary Key Table Primary Key Column Foreign Key Column

PPM_INT_CONFIGURATIONS SOLUTION_ID SOLUTION_ID

PPM_INT_WORK_ITEM_SET WORK_ITEM_SET_ID WORKING_SET_ID

Column Descriptions

Column Name Null? Data Type Description

ID NOT NULL NUMBER(19) Identifier for time

SOLUTION_ID NOT NULL NUMBER(19) The Integration solution Id

NAME NOT NULL VARCHAR2(200) The time sheet line name

WORKING_SET_
ID

NOT NULL NUMBER(19) ID of the work set that the time
sheet line belongs to

DATA_JSON NOT NULL VARCHAR2(4000) The json formatted data of external
data for time sheet

DESCRIPTION NOT NULL VARCHAR2(4000) Description of the time sheet line

EFFORT NOT NULL NUMBER The effort of imported external data
for time sheet line. DEFAULT: 0

ERROR_
MESSAGE

NOT NULL VARCHAR2(4000) The error message when retrieve
external time sheet line data

CREATION_DATE NOT NULL DATE Date record was created

Indexes

This table uses no indexes.

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 57 of 310HP Project and Portfolio Management Center (9.22)



Sequences

Sequence Name Sequence Type

PPM_INT_TIMESHEET_DATA_S ID
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PPM_INT_WORK_ITEM_SET
This table stores data for integrated work item sets.

Foreign Keys

This table uses no foreign keys.

Column Descriptions

Column Name Null? Data Type Description

WORK_ITEM_SET_ID NOT NULL NUMBER(19) Identifier for work item set
ID

WORK_ITEM_SET_
NAME

NOT NULL VARCHAR2(200) Identifier for work item set
name

CREATION_DATE NOT NULL DATE Date record was created

Indexes

This table uses no indexes.

Sequences

This table uses no sequences.
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ITG_ACTIVITIES
This table stores the definitions for activities.

Foreign Keys

Primary Key Table Primary Key Column Foreign Key Column

KNTA_USERS USER_ID LAST_UPDATED_BY

KNTA_USERS USER_ID CREATED_BY

Column Descriptions

Column Name Null? Data Type Description

ACTIVITY_ID NOT NULL NUMBER System-generated identifier

VERSION NOT NULL NUMBER System-generated version for the entity. This
columnmust not be updatedmanually

ACTIVITY_
NAME

NOT NULL VARCHAR2
(255)

Defines the name given to this activity

DESCRIPTION NULLABLE VARCHAR2
(650)

Describes the activity.

ENABLED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether the activity is enabled

CATEGORY_
CODE

NULLABLE VARCHAR2
(255)

SOP 98-1 Category for the activity

CAPEX_
OPEX_
ENABLED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether the activity can be
capitalized. Y indicates that the activity can be
capitalized.

IS_USED_
FOR_
REQUEST

NULLABLE VARCHAR2
(1)

Indicates whether the activity can be used for
requests
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Column Name Null? Data Type Description

IS_USED_
FOR_ASSET

NULLABLE VARCHAR2
(1)

Indicates whether the activity can be used for
assets

IS_USED_
FOR_
PACKAGE

NULLABLE VARCHAR2
(1)

Indicates whether the activity can be used for
packages

IS_USED_
FOR_
PROJECT

NULLABLE VARCHAR2
(4)

For the token evaluation engine. Contains the
primary key of a table (see KNTA_TOKEN). The
reference to this table is used to resolve all the
tokens from this context after update

IS_USED_
FOR_TASK

NULLABLE VARCHAR2
(4)

For the token evaluation engine. Contains the
primary key of a table (see KNTA_TOKEN). The
reference to this table is used to resolve all the
tokens from this context after update

IS_USED_
FOR_MISC

NULLABLE VARCHAR2
(1)

Indicates whether the activity can be used for
miscellaneous items.

CREATED_BY NOT NULL NUMBER Identifier for the user who created the record

CREATION_
DATE

NOT NULL DATE Date record was created

LAST_
UPDATED_BY

NOT NULL NUMBER Identifier for the user who last updated the record

LAST_
UPDATE_
DATE

NOT NULL DATE Date record was last updated

DEFINITION_
LANGUAGE

NOT NULL VARCHAR2
(40)

Default definition language

IS_USED_
FOR_ITG

NOT NULL VARCHAR2
(1)

(Added in 9.22) Flag to show whether this
activity can be used on External Data items in
time sheet
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Indexes

Index Name Index Type Sequence Column Name

SYS_C005200169 UNIQUE 1 ACTIVITY_NAME

SYS_C005201533 UNIQUE 1 ACTIVITY_ID

Sequences

Sequence Name Sequence Type

ITG_ACTIVITIES_S ACTIVITY_ID
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KTMG_POLICIES
This table stores information about time sheet policies that can be associated with time sheet
users.

Foreign Keys

Primary Key Table Primary Key Column Foreign Key Column

KNTA_USERS USER_ID CREATED_BY

KNTA_USERS USER_ID LAST_UPDATED_BY

KTMG_PERIOD_TYPES_NLS PERIOD_TYPE_ID PERIOD_TYPE_ID

Column Descriptions

Column Name Null? Data Type Description

POLICY_ID NOT NULL NUMBER System-generated identifier

CREATION_
DATE

NOT NULL DATE Date record was created

CREATED_BY NOT NULL NUMBER Identifier for the user who created the record

LAST_
UPDATE_DATE

NOT NULL DATE Date record was last updated

LAST_
UPDATED_BY

NOT NULL NUMBER Identifier for the user who last updated the
record

ENTITY_LAST_
UPDATE_DATE

NOT NULL DATE Date a record in the entity was last updated

POLICY_NAME NOT NULL VARCHAR2
(80)

User defined name for the policy

DESCRIPTION NULLABLE VARCHAR2
(240)

Description of the policy

PERIOD_
TYPE_ID

NOT NULL NUMBER Foreign key to KTMG_PERIOD_TYPES table
that determines the duration of the period

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 63 of 310HP Project and Portfolio Management Center (9.22)



Column Name Null? Data Type Description

TIME_ENTRY_
DURATION_
CODE

NOT NULL VARCHAR2
(30)

Whether the user will be logging time by the
day or some other defined period

TIME_ENTRY_
UNIT_CODE

NOT NULL VARCHAR2
(30)

If entering time by a Period, whether entering
the time in hours or as a percent of the hours in
the period.

PERIOD_
HOURS_CALC_
TYPE_CODE

NULLABLE VARCHAR2
(30)

Lookup code for 'TMG - Time Period
Calculation Types'. Determines how he
number of hours in a period are calculated.

PERIOD_
HOURS

NULLABLE NUMBER Number of hours in the Period if the PERIOD_
HOURS_CALC_TYPE_CODE is fixed.

WORKDAY_
HOURS

NULLABLE NUMBER Number of hours in a day if the PERIOD_
HOURS_CALC_TYPE_CODE is the number
of days times the hours in each day.

OVERRIDE_
WORK_ALLOC_
CC_FLAG

NOT NULL VARCHAR2
(1)

Either 'Y' or 'N'. Determines whether any
existing charge codes for theWork Allocation
will be overridden by the resource charge code.

DUPLICATE_
ALLOWED_
FLAG

NOT NULL VARCHAR2
(1)

Flag to specify duplicate time sheets (multiple
time sheets for the same period) is allowed or
not.

TIMESHEET_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(1)

Flag to specify if the resource is required to fill
in a time sheet

MAX_HOURS_
PER_DAY

NULLABLE NUMBER Specifies allowedmaximum total hours per day

MAX_HOURS_
PER_
TIMESHEET

NULLABLE NUMBER Specifies allowedmaximum total hours per
time sheet

MIN_HOURS_
PER_
TIMESHEET

NULLABLE NUMBER Specifies allowedminimum total hours per time
sheet
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Column Name Null? Data Type Description

MIN_MAX_
HOURS_CALC_
TYPE_CODE

NULLABLE VARCHAR2
(30)

Lookup code for 'TMG - Time Period
Calculation Types'. Determines how the
number of hours in a period are calculated.

PREVENT_
VIOLATION_
FLAG

NOT NULL VARCHAR2
(1)

Flag to determine whether the time sheet can
be released when there is a violation on the
policy

GLOBAL_
POLICY_FLAG

NOT NULL VARCHAR2
(1)

Specifies if the policy is the default policy for all
resources without a policy

AUTO_
APPROVAL_
FLAG

NOT NULL VARCHAR2
(1)

Indicates whether the user's time is
automatically approved

MAX_
PERCENT_
PER_
TIMESHEET

NULLABLE NUMBER If entering in percent, what is themaximum
percentage allowed.

MIN_
PERCENT_
PER_
TIMESHEET

NULLABLE NUMBER If entering in percent, what is theminimum
percentage allowed.

REQ_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is required to enter
activities on their time sheet for requests (Y/N)

TSK_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is required to enter
activities on their time sheet for tasks
(Y/N)

PKG_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is required to enter
activities on their time sheet for packages
(Y/N)
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Column Name Null? Data Type Description

MISC_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is required to enter
activities on their time sheet for misc items
(Y/N)

ACTIVITIES_
DISPLAY_FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is allowed to specify
activities on their time sheet for work items
(Y/N)

EXP_HRS_
DISPLAY_FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the time sheet is showing
the expected hours (Y/N)

WORKITEM_
REQ_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is allowed to have
requests as work items on their time sheet
(Y/N)

WORKITEM_
PRJ_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is allowed to have
projects as work items on their time sheet
(Y/N)

WORKITEM_
TSK_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is allowed to have
tasks as work items on their time sheet (Y/N)

WORKITEM_
PKG_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is allowed to have
packages as work items on their time sheet
(Y/N)

WORKITEM_
MSC_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is allowed to have
misc as work items on their time sheet
(Y/N)

PRJ_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether the user is required to enter
activities on their time sheet for project items
(Y/N)
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Column Name Null? Data Type Description

ALLOW_
EMPTY_LINE_
FLAG

NULLABLE NUMBER Level how to deal with the empty time sheet
line in a time sheet

ITG_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(1)

(Added in 9.22) Flag to show whether the
activity is required on Item type External Data
of the time sheet policy

WORKITEM_
ITG_ENABLED_
FLAG

NOT NULL VARCHAR2
(1)

(Added in 9.22) Flag to show whether External
Data is enabled as an work item of the time
sheet policy

Indexes

Index Name Index Type Sequence Column Name

KTMG_POLICIES_U1 UNIQUE 1 POLICY_ID

KTMG_POLICIES_U2 UNIQUE 1 POLICY_NAME

Sequences

Sequence Name Sequence Type

KTMG_POLICIES_S POLICY_ID
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TM_TIME_SHEETS
This table stores the definition of each time sheet including the copied policy information from the
resource's time sheet policy.

Foreign Keys

Primary Key Table Primary Key Column Foreign Key Column

ITG_TRUSTEE TRUSTEE_ID BASE_TRUSTEE_ID

KNTA_SECURITY_GROUPS_
NLS

SECURITY_GROUP_
ID

BILLING_APPROVER_SEC_
GRP_ID

ITG_CALENDAR CALENDAR_ID CALENDAR_ID

KNTA_USERS USER_ID CREATED_BY

KNTA_USERS USER_ID LAST_UPDATED_BY

KTMG_PERIODS PERIOD_ID PERIOD_ID

RSC_RESOURCES RESOURCE_ID RESOURCE_ID

Column Descriptions

Column Name Null? Data Type Description

TIME_SHEET_
ID

NOT NULL NUMBER System-generated identifier

VERSION NOT NULL NUMBER System-generated version for the entity. This
columnmust not be updatedmanually

RESOURCE_
ID

NOT NULL NUMBER Identifies the Resource that this time sheet
belongs to.

PERIOD_ID NULLABLE NUMBER Identifies the period for which this time sheet
tracks actuals

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 68 of 310HP Project and Portfolio Management Center (9.22)



Column Name Null? Data Type Description

CALENDAR_
ID

NOT NULL NUMBER Identifies the unique internal calendar for the
time sheet. It is used by the system to keep
track of actual information andmust not be
modified. This calendar does not reference the
Resource's calendar.

STATUS_
CODE

NULLABLE NUMBER Indicates the status of the time sheet

DESCRIPTION NULLABLE VARCHAR2
(650)

Describes the time sheet. This value defaults to
the format "Resource - Period".

SEQ NULLABLE NUMBER Contains the internal order of time sheets for
display when a Resource has multiple time
sheets for a given period.

EXCEPTION_
MESSAGE

NULLABLE VARCHAR2
(650)

Stores the policy exceptions for display in the
time sheet, if any exceptions exist.

BASE_
TRUSTEE_ID

NULLABLE NUMBER Identifies the billing approver of the time sheet if
it is configured to be a participant group.

BILLING_
APPROVER_
SEC_GRP_ID

NULLABLE NUMBER Identifies the billing approver of the time sheet if
it is configured to be a Security Group.

TIME_ENTRY_
DURATION_
CODE

NULLABLE VARCHAR2
(255)

Indicates the granularity of effort entered into the
time sheet. This is controlled by the time sheet
Policy. Valid values are DAY and PERIOD.

TIME_ENTRY_
UNIT_CODE

NULLABLE VARCHAR2
(255)

Indicates the unit of measurement for time entry
into the time sheet. This is controlled by the time
sheet Policy. Valid values are HOURS and
PERCENT.

PERIOD_
HOURS_
CALC_TYPE_
CODE

NULLABLE VARCHAR2
(255)

Indicates the setting for calculating the number
of hours in a period. This is controlled by the time
sheet policy. Valid values areWORKDAY and
FIXED.
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Column Name Null? Data Type Description

PERIOD_
HOURS

NULLABLE NUMBER If PERIOD_HOURS_CALC_TYPE_CODE is
set to FIXED, this column indicates the fixed
number of hours in a period.

WORKDAY_
HOURS

NULLABLE NUMBER If PERIOD_HOURS_CALC_TYPE_CODE is
set toWORKDAY, this column indicates the
number of hours in a working day.

DUPLICATE_
ALLOWED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether multiple time sheets are
allowed in a given period.

MIN_MAX_
HOURS_
CALC_TYPE_
CODE

NULLABLE VARCHAR2
(255)

Indicates the setting for calculating the number
of hours when checking for minimum and
maximum requirements. This is controlled by the
time sheet Policy.

TIME_SHEET_
REQUIRED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether a Resourcemust submit a
time sheet for every period.

MAX_HOURS_
PER_DAY

NULLABLE NUMBER Indicates themaximum number of hours per day
a Resourcemay log time for in the time sheet.

MAX_HOURS_
PER_TIME_
SHEET

NULLABLE NUMBER Indicates themaximum number of hours per
time sheet a Resourcemay log.

MIN_HOURS_
PER_TIME_
SHEET

NULLABLE NUMBER Indicates theminimum number of hours per time
sheet a Resourcemust log.

MAX_
PERCENT_
PER_
TIMESHEET

NULLABLE NUMBER Indicates themaximum percentage allowed on
the time sheet.

MIN_
PERCENT_
PER_
TIMESHEET

NULLABLE NUMBER Indicates theminimum percentage required on
the time sheet.
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Column Name Null? Data Type Description

PREVENT_
VIOLATION_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether a Resource is prevented from
submitting a time sheet if there are policy
violations.

REQ_
ACTIVITIES_
REQUIRED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether Activities are required to be
added to Request items on the time sheet.

TSK_
ACTIVITIES_
REQUIRED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether Activities are required to be
added to Task items on the time sheet.

PRJ_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether Activities are required to be
added to Project items on the time sheet.

PKG_
ACTIVITIES_
REQUIRED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether Activities are required to be
added to Package items on the time sheet.

MISC_
ACTIVITIES_
REQUIRED_
FLAG

NULLABLE VARCHAR2
(1)

Indicates whether Activities are required to be
added toMiscellaneous items on the time sheet.

WORKITEM_
REQ_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether Requests can be added as
work item to the time sheet.

WORKITEM_
TSK_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether Tasks can be added as work
item to the time sheet.
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Column Name Null? Data Type Description

WORKITEM_
PRJ_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether Projects can be added as
work item to the time sheet.

WORKITEM_
PKG_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether Packages can be added as
work item to the time sheet.

WORKITEM_
MSC_
ENABLED_
FLAG

NOT NULL VARCHAR2
(4)

Indicates whether Miscellaneous can be added
as work item to the time sheet.

CREATED_BY NOT NULL NUMBER Identifier for the user who created the record

CREATION_
DATE

NOT NULL DATE Date the record was created

LAST_
UPDATED_BY

NOT NULL NUMBER Identifier for the user who last updated the record

LAST_
UPDATE_
DATE

NOT NULL DATE Date record was last updated

ALLOW_
EMPTY_LINE

NOT NULL NUMBER Level how to deal with empty time sheet lines in
this time sheet

ITG_
ACTIVITIES_
REQUIRED_
FLAG

NOT NULL VARCHAR2
(1)

(Added in 9.22) Flag to show whether the activity
is required on Item type External Data for the
specific time sheet

WORKITEM_
INT_
ENABLED_
FLAG

NOT NULL VARCHAR2
(1)

(Added in 9.22) Flag to show whether External
Data is enabled as an work item for the specific
time sheet
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Indexes

Index Name Index Type Sequence Column Name

FKF38627E05BD31FCB_I NONUNIQUE 1 BASE_TRUSTEE_ID

FKF38627E05F1CC5BE_I NONUNIQUE 1 CALENDAR_ID

FKF38627E0A1B1A5A3_I NONUNIQUE 1 RESOURCE_ID

FKF38627E0A7DB71D8_I NONUNIQUE 1 BILLING_
APPROVER_SEC_
GRP_ID

SYS_C005201597 UNIQUE 1 TIME_SHEET_ID

TM_TIME_SHEETS_N1 NONUNIQUE 1 PERIOD_ID

Sequences

Sequence Name Sequence Type

TM_TIME_SHEETS_S TIME_SHEET_ID

Troubleshooting and Limitations
This section includes the following:

l "Limitations" below

l "Troubleshooting Problems" on the next page

Limitations
l When you run the following HP TimeManagement reports, if you set theWork Item Type filter

toExternal Data, and theWork Item Set filter toHP Agile Manager, no values are available
forWork Item:

n Actual Time Summary

n Time Sheet Summary
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n Work Allocation Details

l When you set filters for the following HP TimeManagement portlets, if you setWork Item
TypetoExternal Data, andWork Item SettoHP Agile Manager, no values are available for
Work Item:

n Time Sheet Totals by Work Item

n Time Sheet Totals by Resource Group

n Work Allocation Details

n Work Item Set Actuals vs. Allocations

l External Data is available for the following HP TimeManagement portlets only:

n Time Sheet Totals for Direct Reports

n Approve Time Sheets

n Work Item Set Actuals vs. Allocations

n Time Sheet Totals by Resource Group

n Time Sheet Totals by Resource

n My Time Sheets

External Data is not available for the following portlets:

n Time Sheet Totals by Work Item

n Work Allocation Details

n My Tasks

n My Work Items

Troubleshooting Problems
Problem: Importing the agile effort data for multiple times during the time period range does not
automatically update the effort data in your PPM Center time sheet that you imported previously.
Instead, it adds new time lines into your time sheets. You need tomanually remove the old time
lines of data.
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Solution: Import your agile effort only once for each time period, approaching the end of the current
period, so that the latest andmore accurate effort data can be retrieved and imported.
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Roadmap Entity Added to HP APM in PPM Center
Version 9.22

This section contains the following topics:

l "Overview of the Roadmap Entity" below

l "Upgrading from HP APM for PPM 9.20" on the next page

l "Installing HP APM for PPM 9.22" on the next page

l "Creating Roadmap Entities" on page 79

l "Editing Roadmap Entities" on page 83

Overview of the Roadmap Entity
A new entity Roadmap is introduced to HP APM for PPM 9.22.

A Roadmap entity is a roadmap for an individual application/service, or a group of
applications/services, including lifecycle statuses (roadmap phases) andmilestones. You can
create a roadmap entity for any other existing APM entity.

To use the Roadmap entity, you need to install HP APM for PPM 9.22. See "Installing HP APM for
PPM 9.22" on the next page.

Note: If your organization has no plan to use the Roadmap entity, there is no need to install the
HP APM for PPM 9.22. After upgrading PPMCenter to version 9.22, you can continue to use
the existing functionalities provided by HP APM for PPM 9.20.

You can create, search, or edit a Roadmap entity like any other application entities. For information
about creating and editing Roadmap entities, see "Creating Roadmap Entities" on page 79 and
"Editing Roadmap Entities" on page 83. For more information about using the application entities,
see theApplication Portfolio Management User’s Guide and theApplication Portfolio Management
Analyst’s Guide.

Roadmap Workflow
After you create a roadmap, it must follow a process, that is roadmapworkflow, to reach its
conclusion. Roadmap status is assigned automatically as the roadmapmoves through its
workflow.

The figure below illustrates the default workflow steps for a roadmap.
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As an APM administrator, you can configure the roadmapworkflow to handle any of your business
process.

Upgrading from HP APM for PPM 9.20
If you are on HP APM for PPM version 9.20, follow the steps below to upgrade to HP APM for PPM
version 9.22:

1. Upgrade PPMCenter to version 9.22.

For more information, see the "Installation Notes" on page 3.

2. Install PPM Center Best Practices.

3. Deploy HP APM for PPM version 9.22.

For more information, see "Installing HP APM for PPM 9.22" below.

Installing HP APM for PPM 9.22
Before you install HP APM, PPMCenter version 9.22 and PPMCenter Best Practices must be
installed.

For information about installing PPM Center and PPMCenter Best Practices, see the Installation
and Administration Guide for PPM Center.

Complete the following steps to install HP APM on the PPM Server:
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1. Back up the database and file system for the PPM Server.

2. Verify that the PPM Server is running.

3. Copy the file ppm-922-APM.jar to the <PPM_Home> directory. This is the directory where your
PPM Center instance is installed.

4. Change to the <PPM_Home>/bin directory.

5. Start the installation by typing the following command:

sh ./kDeploy.sh -i APM

6. Follow the on-screen instructions to complete the installation.

7. Stop the PPM Server.

8. Compile the JSP files using the following command:

sh ./kJSPCompiler.sh

9. (Optional) Delete PPM Center’s cache in the following directories:

<PPM_Home>/server/<PPM_Server_Name>/tmp

<PPM_Home>/server/<PPM_Server_Name>/work

10. Start the PPM Server.

11. Verify the installation. Type:

sh ./kDeploy.sh -l

where the last character in the command is the lowercase letter “l”.

The name APM should appear in the list of installedmodules. For example, you should see the
following entry:

Deployment Version Deployed Description

APM 922 <date and time> HP Application Portfolio Management

Note: If you are running PPMCenter in a clustered environment, repeat the installation
procedure for each PPM Server.

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 78 of 310HP Project and Portfolio Management Center (9.22)



Creating Roadmap Entities
You can create, search for, or edit roadmap entities like any other application entities.

To create a Roadmap entity,

1. From themenu bar, select Open > Application Portfolio > Create Entities.

2. Select Roadmap in theEntities section.

The Create New APM-Roadmap page opens.

Note: Formore ways to create a new entity, see theApplication Portfolio Management
User’s Guide.

3. Enter information in the following sections:

n "Identity" below

n "Phases" on the next page

n "Milestones" on page 81

Identity

In the Identity section, enter the fundamental information that identifies the roadmap.

Note: The Identity section is a subsection of the header section.

The table below describes the Identity fields.
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Field
(*Required)

Description

Roadmap
ID

ID of the roadmap

Roadmap
Status

Read-only. Available roadmap statuses include:

n New - The roadmap is created but not submitted.
n Draft - The roadmap is submitted but not finalized.
n Proposed - The roadmap is finalized but not activated.
n Active - The roadmap is activated but not archived.
n Cancelled - The roadmap is cancelled.
n Archived - The roadmap is archived.

Roadmap
Type*

Available roadmap types include:

n Application
n Portfolio

Note: These two types are available by default. Customized roadmap types
can be created in the PPMWorkbench by the APM administrator to meet your
organization's business needs and requirements.

Created On Read-only. The date on which the roadmapwas created

Created By Read-only. The full name of the user who created the roadmap

Entity* The entity for which the roadmap is created

Note: If an entity has a roadmap that is in "Active" status, you are not able to
create another roadmap for this entity.

Phases

In the Phases section, enter the information of the phases the roadmapwould go through.

Release Notes
Chapter 3: New Features in PPM Center 9.22

Page 80 of 310HP Project and Portfolio Management Center (9.22)



The table below describes the Roadmap Phases fields.

Field (*Required) Description

Seq Sequence of the roadmap phase

Name Name of the roadmap phase

Type Type of the roadmap phase. Available values include:

n Evaluation
n Planned
n Operational
n Archived
n Planned Decommissioned

Note: These five types are available by default. APM administrator
can create customized types of roadmap phases in the PPM
Workbench tomeet your organization's business needs and
requirements.

Link URL or any other kind of link of the roadmap phase

Start Date Start date of the roadmap phase

End Date End date of the roadmap phase

Active Indicates whether or not the roadmap phase is active

Milestones

In theMilestones section, enter the information of themilestones you set for the roadmap.
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The table below describes the RoadmapMilestone fields.

Field (*Required) Description

Seq Sequence of the roadmapmilestone

Code Code of the roadmapmilestone

Name Name of the roadmapmilestone

Type Type of the roadmapmilestone. Available values include:

n Major Decision Point
n Minor Decision Point
n Release
n De-Investment
n Business Function/Business Capability
n Technology Capability

Note: These six types are available by default. Customized types
of roadmapmilestones can be created in the PPMWorkbench by
the APM administrator to meet your organization's business needs
and requirements.

Date Date of the roadmapmilestone

Decision Decision that has beenmade in this milestone

URL URL of themilestone information

4. Complete other fields as necessary.

5. Click Submit.
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Editing Roadmap Entities
l "Edit Roadmap Phases" below

l "Edit RoadmapMilestones" below

Edit Roadmap Phases
To edit Roadmap Phases, click Edit. The Roadmap Phases section changes into the Edit view.

Under the Edit view, you can do the followings to edit the phases:

l Edit the existing phases information

l Add a new phase by clickingAdd Row

l Delete a phase by clickingDelete Row after selecting the phase you want to delete

l Create a phase based on an existing phase by selecting the existing phase and then clicking
Copy andPaste

l Adjust the phases sequence by clickingMove Up orMove Down after selecting the desired
phase

Edit Roadmap Milestones
To edit RoadmapMilestones, click Edit. The RoadmapMilestones section changes into the Edit
view.
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Under the Edit view, you can do the followings to edit themilestones:

l Edit the existingmilestones information

l Add a new milestone by clickingAdd Row

l Delete amilestone by clickingDelete Row after selecting themilestone you want to delete

l Create amilestone based on an existingmilestone by selecting the existingmilestone and then
clickingCopy andPaste

l Adjust themilestones sequence by clickingMove Up orMove Down after selecting the desired
milestone

Note: If you want to edit the URL field of amilestone, youmay have to click Edit at the end of
themilestone line to open the Link Properties window.
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Chapter 4: New Features in PPM Center 9.21
The following new features are included in PPM Center version 9.21:

l Integrating PPM Center tasks with HP ALM Releases

The integration between PPMCenter tasks and HP ALM Releases implemented in version 9.21
is an extension of the capability of the integration between PPMCenter projects and HP ALM.
The integration extension enables project managers tomanagemultiple HP ALM releases with
one PPMCenter project by integrating project tasks with HP ALM releases.

For more information, see "Integrating PPM Center Tasks with HP ALM Releases" on page 211

l Associating Waterfall Projects to PPM Center Tasks

Waterfall projects refer to the traditional IT projects that are developed andmanaged with PPM
Center using the waterfall methodology.

Version 9.21 implemented this new feature in the HP Project Management module. The new
feature allows project managers to associate other waterfall projects as subprojects to tasks of
a PPM Center project. This means that project managers canmanagemultiple subprojects from
within amaster project.

For more information, see "AssociatingWaterfall Projects to PPM Center Tasks" below.

Using this feature in combination with the integration between PPMCenter tasks and HP Agile
Manager, project managers canmanage hybrid IT projects comprised of both waterfall
subprojects and agile subprojects centrally from a PPMCenter project. For more information,
see "Viewing andManaging Hybrid Projects " on page 242.

Associating Waterfall Projects to PPM Center
Tasks

This section covers the following topics:

l "New Tabs Introduced " on the next page

l "Mapping Rules" on page 87

l "Associating aWaterfall Project to a PPM Center Task" on page 88
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l "Deleting aMapping from the Task Details Page" on page 91

l "Viewing Details of Waterfall Projects" on page 92

New Tabs Introduced
Starting from version 9.21, the following tabs are available with the HP Project Management
module by default:

l TheHybrid Project tab on the Task Details page

TheHybrid Project tab is available on the Task Details page together with theMapping
Waterfall Project button. Project managers can start to associate a waterfall project to a PPM
Center task from here. For more information, see "Associating aWaterfall Project to a PPM
Center Task" on page 88.

Note:No additional configuration work is required for mapping waterfall projects to tasks.

l The Timeline tab on the Project Overview page

By default, the Timeline tab displays a consolidated timeline view of themaster project as well
as details of all mapped waterfall subprojects.

Before associating waterfall projects or agile projects as subprojects to PPM Center tasks, you
may want to review the "Mapping Rules" on the next page first.

Then, as subproject managers, you can start to associate waterfall projects to PPM Center tasks.
See "Associating aWaterfall Project to a PPM Center Task" on page 88.

As project managers, you can view andmanagemultiple waterfall subprojects centrally from a
master PPM Center project. See "Viewing Details of Waterfall Projects" on page 92.

Release Notes
Chapter 4: New Features in PPM Center 9.21

Page 86 of 310HP Project and Portfolio Management Center (9.22)



Mapping Rules
Whenmapping a task to a waterfall project, make sure that the task meets the following criteria:

l The task is a leaf task.

l The task is neither amilestone nor a summary task.

Note: If a task was changed from amilestone or a summary task to a leaf task, then it is
qualified for mapping to a waterfall project. That is to say, only current status of the task
matters.

l The task has no actuals rolled up from PPMCenter.

For example, if you set a task status to In Process, then it would have actual start date, so it
cannot bemapped to any waterfall project.

l The task is not synchronized from an integrated product.

l The task is not mapped to any waterfall project or agile project.

l Microsoft Project-related tasks

A task under Microsoft Project Controlledmode or Sharedmode is not available for mapping to a
project. If the task is changed fromMicrosoft Project Controlledmode to PPM Controlledmode,
it is available for mapping to a project.

l RFC tasks

If a task is already mapped to an RFC in ServiceManager, it is not available for mapping to a
project.

If a task does not satisfy the above criteria, a warningmessage is displayed on the Hybrid
Project tab, indicating that the task cannot bemapped to a waterfall project as well as the
reasons why it cannot bemapped.
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Important Notes about Mapping
Whenmapping a task to a waterfall project, also consider the following:

l Microsoft Project Controlledmode

For a task that is available for mapping to an agile project or a waterfall project, changing the
IntegrationMode of themaster project results in tasks under the project not available for
mapping.

If you do so, a warningmessagemay display on the Quality tab of the Task Details page,
indicating that themapping is not valid anymore, and that the synchronization will suspend.

Mapped tasks or imported tasks are not editable on the standard user interface.

You can not switch themode of a task if it is already mapped to an agile project or a waterfall
project.

l For imported andmapped tasks, you cannot use time sheet to track their time.

Associating a Waterfall Project to a PPM Center Task
To associate a waterfall project as a subproject to a PPM Center task,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

The Search Projects page opens.

3. Locate and open the desired project.

4. On the Project Summary tab of the Project Overview page, click Edit Work Plan in theWork
Plan portlet.

TheWork Plan for <Project_Name> page displays.

5. Open the Task Details page for the desired task that you want to associate to, and go to the
Hybrid Project tab.
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6. Click Mapping Waterfall Project.

ThePlease choose a target project section displays a list of available waterfall projects that
meet the following criteria:

n Not themaster project itself.

The project status is not Canceled or Completed.

n The project is not mapped to any other task.

n The project timeline falls between the start date and finish date of themaster project that the
task belongs to.

n The project can be viewed or edited by the current user. That is, the current user shall have
one of the following Project Mgmt: access grants:

o Edit All Projects

o Edit Projects

o View Projects

o View All Projects
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7. Select a project from the list and click Confirm.

The one-onemapping relationship is established, with the following information displayed right
away:

n Mapping information, including project name of the waterfall project you just associated and
the last successful synchronization time

n Details of the waterfall project, including the following:

o Project summary information

o TheMilestones portlet
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Deleting a Mapping from the Task Details Page
To delete amapping from the Hybrid Project tab of the Task Details page,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

The Search Projects page opens.

3. Locate and open the desired project.

4. Go to the Task Details page for the desired task that you want to remove themapping you
already established for it, and go to theHybrid Project tab.

5. Click .

A prompt dialog pops up.

6. Click OK.

Themapping is removed, and theHybrid Project tab returns to its initial state.

You can click Mapping Waterfall Project to map the task to another waterfall project as
needed.
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Viewing Details of Waterfall Projects
Once the one-onemapping relationship between a PPMCenter task and a waterfall project is
established, themaster project displays the waterfall project information on the Hybrid Project tab
of the Task Details page immediately.

Project managers and subproject managers, depending on their access grants, can view and
manage their projects from the following tabs:

l The Timeline tab on the Project Overview page

n By default, the Timeline tab displays a consolidated timeline view of themaster project and
the subprojects.

Note: If a milestone is not in the project period (between the planned start date and the
planned finish date) for the project it belongs to, themilestone will not display.
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n Clicking a task in the project navigation tree displays details of themapped waterfall project.

The following details of themapped waterfall project are displayed:

o Project summary

To view more details for the waterfall project, click project name to open the Project
Overview page directly or in a new tab.

o TheMilestone Summary portlet

You can click each of themilestones to drill down to details.

o The Project Cost portlet

Note: The Project Cost portlet is not available until you have enabled the Financial
Management setting on the Cost and Effort policy of themapped waterfall project. For
more information, see "Enable the Project Cost Portlet " on page 95.

o The EV Summary portlet

Note: The EV Summary portlet is not available until you have a) enabled the Financial
Management setting of themapped waterfall project and b) created a baseline for the
mapped waterfall project. For more information, see "Enable the Project Cost Portlet "
on page 95 and "Enable the EV Summary Portlet " on page 96.
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n Placing your mouse over amilestone displays details of themilestone.

n Placing your mouse over a task displays the task's one-onemapping relationship in the
format of <Task_Name>:<Mapped_Project_Name>.

l TheHybrid Project tab on the Task Details page

This tab displays similar information of amapped waterfall project as those displayed on the
Timeline tab.

Project Indicators
Version 9.21 introduced the following icons and colors as project indicators to facilitate your project
management work:

Project Indicator Description

A waterfall project

Timeline for a waterfall project
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Project Indicator Description

A milestone of a waterfall project. Placingmouse over themilestone
displays milestone details.

Enable the Project Cost Portlet
To display the Project Cost portlet on the Timeline tab,

1. On the Timeline tab of the Project Overview page of your master project, click a desired task
that is mapped to a waterfall project in the navigation pane.

The details of the waterfall project display in the right pane.

2. Right click the waterfall project name in the right pane and select Open Link in New Tab.

The Project Overview page of the waterfall project opens in a new tab.

3. Click Settings on the top right corner of the page.

The Project Settings page opens.

4. Click theCost and Effort policy in the navigation pane.

The Cost and Effort policy page opens.

5. Scroll down to the Financial Management section.

6. Select theEnable Financial Management for work plan option and other options as
illustrated below:

7. Click Done.
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8. Return to the Task Details page or the Project Overview page of themaster project.

9. Go to the Timeline tab of the Project Overview page and click the task you just configured.

The Project Cost portlet is now available and displays data.

The same information are also displayed on the Hybrid Project tab of the Task Details page for
the linked task.

Enable the EV Summary Portlet
To display the EV Summary portlet for a waterfall subproject on the Timeline tab,

1. Make sure you have enabled the Financial Management setting for the waterfall project.

For more information, see "Enable the Project Cost Portlet " on the previous page.

2. On the Timeline tab of the Project Overview page of your master project, in the navigation
pane, click the desired task that is mapped to a waterfall project.

The details of the waterfall project display in the right pane.

3. Right click the waterfall project name in the right pane and select Open Link in New Tab.

The Project Overview page of the waterfall project opens in a new tab.

4. On the Project Summary tab of the waterfall project, click Edit Work Plan in theWork Plan
portlet.

TheWork Plan for <Project Name> page displays.

5. Click Actions > Create a Baseline.

The Create Baseline dialog displays.

6. Provide a name and description for the new baseline in theName andDescription fields.
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7. Click Create.

8. Return to the the Project Overview page of themaster project.

9. Go to the Timeline tab of the Project Overview page and click the task you just configured.

The EV Summary portlet is now available in the details pane for the associated waterfall
project.

The EV Summary portlet is also displayed on the Hybrid Project tab of the Task Details page
for the linked task.

View Waterfall Project Details from the Timeline Tab
To view details of amapped waterfall project from the Timeline tab of the Project Overview page,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

3. Provide search criteria in desired fields and click Search.

4. Locate your project and open it.

The Project Overview page displays.

5. Go to the Timeline tab.

n If no tasks aremapped to any waterfall or agile projects, only the timeline for the current
project displays.

n If sub-project managers havemapped their tasks to waterfall projects, the Timeline tab
displays a consolidated timeline view of themaster project and all waterfall subprojects.

6. To view details of amapped waterfall subproject, click the task in the navigation tree.

Tip:You can display name of themapped waterfall project by placing your mouse over a
task.

The details of the waterfall project display.
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For each of the associated waterfall projects, you can see similar details of the project as those
shown on the Hybrid Project tab of the Task Details page.

7. To view details of the waterfall subproject, you can,

n Click the project name to open the project in its own Project Overview page;

n Click amilestone to open themilestone details page;

n Click Cost Details orView Financial Summary in the Project Portlet to open the Cost
Details page or the Financial Summary page for the project.

View Waterfall Project Details from the Hybrid Project
Tab

To do so,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

3. Provide search criteria in desired fields and click Search.

4. Locate your project and open it.

5. On the Project Summary tab, click Edit Work Plan in theWork Plan portlet.

6. Locate your task and open it.
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The Task Details page displays.

7. Go to theHybrid Project tab.

The Hybrid Project tab displays details of themapped waterfall project.
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Chapter 5: Enhancement, Integrations,
Certifications, and Fixes in PPM Center 9.22

l "Enhancements"

l "Integrations"

l "Certifications"

l "Fixes"

Enhancements
The following enhancements are included in PPM Center version 9.22:

Module Enhancements

Administration
Console

l "Enhanced kSupport Tool" on the next page

Deployment
Management

l "Patch Uninstaller" on page 106

Documentation l "Added HelpMenu and Provided PPMCenter Documentation As An
Online Help System" on page 107

l "Tracing PPMCenter Data" on page 110

l "Advice about Using PPMCenter Database DMS and PPMCenter
External Database DMS" on page 120

Integrations l "Enhancements to the Integration of PPM Center Tasks with HP ALM
Releases" on page 157

l "Enhancements to the Integration between PPMCenter and ALM
(Using ALM)" on page 169

PPM Workbench l "Added Buttons in the List ValidationWindow" on page 126

MLU Support l "Improved Behavior of SQLDrop-Down/Auto-Complete Fields in MLU"
on page 129
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Module Enhancements

HP Resource
Management

l "Enhancements to the HP ResourceManagement Module" on page
131

Usability
Enhancements

l "Request Creation Confirmed Page Skippable" on page 148

l "Enhancements to the Project Details Page" on page 149

l "Prompt Added on the Project Overview and Time Sheet Pages" on
page 150

l "Enhanced Data Entry Error Message" on page 150

l "Enhanced Export to Excel Functionality" on page 150

Compliance l "Enhanced Encryption Algorithm for PPM Center" on page 152

Enhanced kSupport Tool
Running kSupport.sh script gathers information helpful to HP Software Support in diagnosing
system problems. The kSupport tool is designed to serve as a troubleshooting knowledge system
for PPM Center. Embedding into the tool the knowledge gathered from supporting PPM Center
customers around the world, HP expects the tool to make PPMCenter self-diagnosable and self-
healable. The flexible interface of the tool makes it easy to absorb new knowledge as PPMCenter
develops and HP Software Support’s knowledge grows.

In PPM Center version 9.22, this tool is enhanced for better retrieving the information by introducing
SuperSupport functionalities.

Instead of gatheringmassive information without categorization, the new SuperSupport
functionalities enable you to:

l "Search Server Logs by TimeRange and Keywords" below

l "Collect Categorized Information Based onModules" on the next page

Search Server Logs by Time Range and Keywords
The new Super support information checkbox section added on theGenerate Support
Information page in the Administration Console allows you to search logs by specifying time range
and keywords.
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If specifying both the time range and the keywords, you can retrieve logs containing the keywords
within the time range. This helps quickly locate the desired information from themassive logs and
avoid getting outdated logs.

Note: If the time zone of PPM Server has been changed, the logs cannot be extracted
correctly by the specified time range.

Collect Categorized Information Based on Modules
The new Super support modules checkbox section added on theGenerate Support Information
page in the Administration Console allows you to gather information based onmodules.
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For example, if you want to gather information for the HP DemandManagement module only, you
can just select theDM checkbox. The retrieved information for the HP DemandManagement
module is stored in the <kSupport_Zip_File>/etc/DM directory.

In addition to traditional PPM Center modules, such as DM, RM, and, PjM, and typical integration
modules, such as DMS, ALM/QC, and uCMDB, the super support modules include six more
modules: Core, Performance, ErrorPageCollector, DBChangeCheck, FileSystemCheck, and
SeedDataCheck. Running the script on theCoremodule, you can gather common information not
related to any specific modules, and on thePerformancemodule, you can gather information about
PPM Center performance.

In order to proactively detect some common configuration errors, datamissing issues, potential
data corruption issues, and so on, the enhanced kSupport tool can perform some sanity checks for
several modules, especially for integrationmodules. The sanity check is designed based on best
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practices of PPM Center Support, so it may help find out the causes for some system issues in
less time.

Note:

l If an integrationmodule is not enabled, you cannot retrieve support information for that
module by selecting the checkbox for the correspondingmodule here.

l The checkboxes for theCore, DBChangeCheck, FilesystemCheck, and
SeedDataCheckmodules are always selected by default, nomatter whichmodules you
select. That means the script is always run for these four modules.

l Specifying the time range in theSuper support information checkbox section also helps
retrieve some database queries within the time range. For example, if you specify the time
range and select theDMS checkbox, only the integration events within the time range will
be retrieved.

Collect Modified Data
Data users havemodified are collected everytime kSupport.sh is run on the following three
mandatorily selectedmodules.

l DBChangeCheck. The script compares the baseline data with user’s database objects, such
as packages, triggers, and indexes. The retrieved comparison report is stored in the <kSupport_
Zip_File>/etc/DBChangeCheck directory.

l FileSystemCheck. The script compares the baseline data with user’s file system, such as
jsp, js, and class files in the <PPM_HOME>/server/<NODE>/deploy/itg.war directory and
<PPM_HOME>/server/<NODE>/deploy/dashboard.war directory. The retrieved comparison
report is stored in the <kSupport_Zip_File>/etc/FileSystemCheck directory, and the
modified files are stored in the <kSupport_Zip_File>/etc/FileSystemCheck/modifiedfiles
directory.

l SeedDataCheck. The script compares the baseline seed data with user’s seed data, such as
request status, workflows, and portlet definitions. The retrieved comparison report is stored in
the <kSupport_Zip_File>/etc/SeedDataCheck directory.

Collect HTML Source Codes for Error Pages
Collecting HTML source codes for JS errors on PPMCenter standard user interface can help
address these errors more quickly.

To collect HTML source codes,
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1. Log on to PPM Center.

2. Navigate to the page you want to trace.

3. From themenu bar, selectMy Links > Trace Html and Upload.

A dialog box pops up.

4. Click OK.

5. Navigate to the Generate Support Information page in the Administration Console.

6. Select ErrorPageCollector in theSuper support modules section.

7. Click Generate.

HTML source codes for error pages are stored in the <kSupport_Zip_
File>/etc/ErrorPageCollector directory.

Note:

l After you generate support information in the Administration Console, the recently traced
error pages will be cleaned.

l Not only error pages but also normal pages can be traced.

l If you are using Internet Explorer 9.0, and open the Developer Tools, youmay not be able to
trace HTML. To address this issue, do one of the following:

n Do not use the Developer Tools when tracing HTML.

n Refresh the page when Developer Tools is opened.
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Patch Uninstaller
Starting from version 9.22, when you deploy the service pack bundle, a basic full backup of your
PPM Center system is performed, including the following system folders: bin, conf, icons,
integration, lib, pdf, rml, scripts, server, sql, utilities, work, security.

The Patch Uninstaller included in version 9.22 allows you to uninstall the 9.22 files and roll back
your PPM Center file system to the status before 9.22 was deployed, using the full backup files.
Note that only the File System changes are rolled back. After rollback of SP2, make sure you
manually restore PPM Center database to the status before SP2was deployed, otherwise the
system will NOT work properly.

To uninstall the 9.22 service pack and roll back the file system to its previous status,

1. Stop PPM Server.

2. Navigate to the <PPM_Home>/bin directory.

3. Run the following command:

sh ./kDeploy.sh -rollback

4. Follow the on-screen instructions when prompted.

5. Restart PPM Server.

Note: The rollback operation does not roll back the kDeploy.sh script itself.
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Added Help Menu and Provided PPM Center
Documentation As An Online Help System

As a part of the continuous effort in improving the PPMCenter documentation accessibility, the
following are available with version 9.22:

l The Help menu is added to the standard PPM Center user interface

Starting from version 9.22, theHelpmenu replaces theOpen > Product Informationmenu in
earlier versions of PPM Center:

n TheHelp > Help Center submenu replaces theOpen > Product Information >
Documentation Library submenu in earlier versions.

n TheHelp > About HP Project and Portfolio Management Center submenu replaces the
Open > Product Information > About HP Project and Portfolio Management Center
submenu in earlier versions.

n The following new menu options are added:

o Troubleshooting & Knowledge Base

o HP Software Support

o HP Software Web Site

o What's New
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l PPM Center documentation is now provided as an online help system

To access the online help system of the PPMCenter documentation,

a. From theHelpmenu, click Help Center.

The Help Center home page for PPM Center documentation opens.

b. To navigate the online help system, expand a folder of your interest in the navigation pane
and click the topic of your interest.

l The PDF version of PPM Center documentation are also included with the product

This enables end users to access the PDF version of PPM Center documentation easily,
especially for users who have no access to the HP Manuals Site.

To access PDF version of PPM Center documentation included with the product,

a. From theHelpmenu, click Help Center.

The Help Center home page for PPM Center documentation opens.

b. In theGetting started section, click Navigate PPM Center Documentation.

The Navigate PPM Center Documentation page opens.
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c. Locate a document of your interest and click thePDF link for the document.

The PDF document opens in a new window.

Note:Most of documents in the PPMCenter documentation set are available in both
online help and PDF format. Only some less used documents are still available in PDF
format only.

Tip: For PPM Center administrators who would like to access all PDF files, go to the
<PPM_Home>/itg/pdf/manual/Content/PDFs directory.

How to Search Help Center
To search Help Center, click theSearch button at the bottom left corner of the Help Center Home
page.

You can search for a single word, multiple words, or a specific combination of words that are
always next to each in the same order. To search for a specific combination of words, enter the
search words within quotationmarks. For example: “out-of-the-box KPIs”.
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Tracing PPM Center Data
This section describes:

l "Calculating Unmet Demand" below

l "Calculating Estimated Remaining Effort" below

l "Configuring Project Health" on the next page

l "Calculating HP Financial Management Data" on page 112

l "Calculating Data in Financial Summary" on page 115

l "Calculating Data in Scenario Comparison" on page 118

Calculating Unmet Demand
For information about calculating unmet demand, see "Analyzing Resource Pools" under Chapter 4
and Appendix B of HP ResourceManagement User’s Guide.

Calculating Estimated Remaining Effort
This section describes how PPMCenter calculates the Estimated Remaining Effort (ERE) of a
task.

ERE is an estimated value derived from actuals, whichmeans that having actuals is key to
reflecting changes in ERE. If there are no actuals, PPM Center resets ERE to zero.

If actuals have been logged against a task, the ERE value gets updated whenever the% Complete
field on the Task Details page is modified. This means that ERE is not reset to zero and stays in
sync with changes in the% Complete field.

If youmanually input ERE, % Complete is calculated as Actual Effort / (Actual Effort + ERE)

If youmanually input % Complete, ERE is calculated as one of the following:

l ERE = Scheduled Effort (SE) - Actual Effort (AE)

l ERE = (Last ERE + Last AE) - AE
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Configuring Project Health
This section includes additional information about configuring schedule health and cost health of a
project. For more information about configuring project health, see "Schedule Health", "Cost and
Earned Value Health", "Project Health", and "Issue Health" under Chapter 3 of HP Project
Management User’s Guide.

Configuring Schedule Health

On the project settings page, the Schedule Health policy controls the project’s schedule health
indicator, as well as determines the active exception rules for a project.

In theHealth section, you can specify the following two rules:

l Percent of tasks that have Exceptions to turn the Schedule Health Red

l Percent of tasks that have Exceptions to turn the Schedule Health Yellow

For example, you set the first rule to 60 and the second to 30. If the percent of tasks that have
exceptions is less than 30%, the schedule health indicator is green. If the percent of tasks that have
exceptions is more than 30% but less than 60%, the indicator is yellow. Otherwise, the indicator is
red. The percent of tasks that have exceptions is calculated as Count of Exceptional Tasks / Count
of Total Tasks.

Note:When calculating the count of total tasks, PPM Center does not include the summary
task or tasks whose status is either “Completed” or “Cancelled”.

Configuring Cost and Earned Value Health

The Cost and Earned Value Health policy controls whether or not to track the cost health for a
project, and if so, whichmetrics will be evaluated to determine health. It is used to indicate the
health of a project in terms of its cost.

If you do not select the For prior months, if actual costs exceed the plan of record by
checkbox when defining the Cost and Earned Value Health policy, the cost health of a project is
that of its root task. If you select the For prior months, if actual costs exceed the plan of
record by checkbox, the cost health of a project represents the factor in the worst condition. The
cost health of a project turns red, when either the cost health of the root task or the indicator for the
For prior months, if actual costs exceed the plan of record by checkbox is red.
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The indicator for the For prior months, if actual costs exceed the plan of record by checkbox
is determined by the value of BudgetOverrun which is calculated as follows:

l If either pastActualTotal past or ForecastTotal is null, BudgetOverrun = 0

l If pastForecastTotal > 0, BudgetOverrun = (pastActualTotal - pastForecastTotal) * 100 /
pastForecastTotal

l If pastForecastTotal = 0 and pastActualTotal > 0, BudgetOverrun = 100

l If both pastForecastTotal and pastActualTotal is zero, BudgetOverrun = 0

Values of pastActualTotal and pastForecastTotal are loaded according to the following queries:

For pastActualTotal,

select sum(s.actual_total_lcl)
from fm_forecast_actual_period_sum s, ppm_fiscal_periods_nls p
where s.PERIOD_ID = p.FISCAL_PERIOD_ID and p.period_type = 4
and s.FORECAST_ACTUAL_ID = {finacial summary.Forecast().Id()}
and p.seq >= {startPeriod.getSequence()} and p.seq < (select p1.seq from ppm_fis
cal_periods_nls p1
where p1.start_date <= sysdate and p1.end_date>= sysdate and p1.period_type = 4)

For pastForecastTotal,

select sum(s.plan_total_lcl)
from fm_forecast_actual_period_sum s, ppm_fiscal_periods_nls p, fm_financial_sum
mary ffs
where ffs.active_fs_id = {finacial summary.Id()} and ffs.plan_of_record_flag = '
Y'
and s.PERIOD_ID = p.FISCAL_PERIOD_ID and p.period_type = 4
and s.FORECAST_ACTUAL_ID = ffs.forecast_actual_id
and p.seq >= {startPeriod.getSequence()} and p.seq < (select p1.seq from ppm_fis
cal_periods_nls p1
where p1.start_date <= sysdate and p1.end_date>= sysdate and p1.period_type = 4)

Calculating HP Financial Management Data
This section describes additional information about calculating HP Financial Management data
items.

For more information about calculating HP Financial Management data, see Chapter 5 of HP
Financial Management User’s Guide.
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Cost Performance Index (CPI)

CPI is calculated as follows:

l If EV is null, CPI is null

l If Actual Cost != 0, CPI = EV / Actual Cost

l If Actual Cost = 0, and

n If EV = 0, CPI = 1

n If EV != 0, CPI = 0

Schedule Performance Index (SPI)

SPI is calculated as follows:

l If EV is null, SPI is null

l If PV != 0, SPI = EV / PV

l If PV = 0, and

n If EV = 0, SPI = 1

n If EV != 0, SPI = 0

Earned Value (EV)

If a task is the summary task, its EV is calculated as Sum (EV of all its child tasks).

If a task is the leaf task, its EV is calculated as follows:

l If there is no task baseline, EV is null

l If the EV_ALLOW_PRORATING server configuration parameter is set to true, EV = Baseline Cost *
% Complete

l If the EV_ALLOW_PRORATING server configuration parameter is set to false, and
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n If % Complete = 100, EV = Baseline Cost

n If % Complete < 100, EV = 0

Planned Value (PV)

Calculating Schedule Start and Schedule Finish Dates

If the PV_USE_ACTIVE_BASELINE_DATES server configuration parameter is set to true and task
baseline exists,

l Schedule start is the schedule start date of the task baseline

l Schedule finish is the schedule finish date of the task baseline

Otherwise,

l Schedule start is the schedule start date of the task

l Schedule finish is the schedule finish date of the task

Calculating PV

For all tasks,

l If there is no task baseline, PV is null.

l If task baseline exists, in one of the following cases, PV = 0:

n The task status is cancelled, or

n The schedule start date of the task is null, or

n Schedule start is later than the current system date

If a task is the summary task, its PV is calculated as Sum (PV of all its child tasks).

For leaf tasks, if task baseline exists and

l If schedule end is earlier than the current system date, PV = Baseline Cost

l Otherwise, PV = Baseline Cost * (passed days / total days)

In this formula, passed days is calculated as follows:
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n If schedule start is the current system date, passed days = 1.

n If the PV_USE_ACTIVE_BASELINE_DATES server configuration parameter is set to true,
passed days = Today's Date - Baseline Start Date]

n Otherwise, passed days = Today’s Date - Start Date

Total days is calculated as follows:

n If the PV_USE_ACTIVE_BASELINE_DATES server configuration parameter is set to true, total
days = Baseline Finish Date - Baseline Start Date

n Otherwise, total days = Finish Date - Start Date

Calculating Data in Financial Summary
This section describes how PPMCenter calculates data in a financial summary.

Calculating Forecasted Labor Costs From Staffing Profile

You can specify whether forecasted labor costs on the financial summary are to be calculated
(rolled up) from the staffing profile. If this option is selected, separate, non-editable forecast lines
are automatically created in the financial summary to reflect the staffing profile estimates, including
the percentage split between capital and operating costs.

The forecast labor cost of a staffing profile equals to the total sum of forecast labor costs of all
positions in this staffing profile. The forecast labor cost of a particular position is calculated as
follows:

Forecast Labor Cost of a Position = Sum (Forecast Labor Cost of Assignment/Promise of the
position) + (Unmet Demand * Cost rate of the position)

where,

Forecast Labor Cost of Assignment = Total committed effort of the assigned resource * Cost rate of
the resource

Forecast Labor Cost of Promise = Total promised effort of the assignment * Cost rate of the
position

The cost rate of a position/resource is determined by the cost rule described in "Best Matching
Strategy" on page 117.
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Note: If there is over allocation on assignments, the unmet demand becomes negative. To
include cost of over allocation, the calculation of forecast labor cost ignores the negative unmet
demand.

The following table describes cost factors used for calculating the forecast labor cost.

Entity Relevant Cost Factors

Forecast labor
cost of a
position

Role:Role of the position.

Region:Region of the staffing profile where the position belongs.

Resource Type:Resource type of the position.

Project: If the parent entity of the staffing profile where the position belongs is
a project, the project is included as a cost factor.

Org Unit: If the default resource pool of the position is defined, the default org
unit of the resource pool is included as a cost factor.

Forecast labor
cost of an
assignment

Role: If the role of the assigned resource is defined, use it. Otherwise, use the
role of the position to which the resource is assigned.

Region: If the region of the assigned resource is defined, use it. Otherwise,
use the region of the staffing profile where the resource belongs.

Resource Type: If the resource type of the assigned resource is defined, use
it. Otherwise, use the resource type of the position to which the resource is
assigned.

Resource: Resource assigned to the position.

Department: If the department of the assigned resource is defined, it is
included as a cost factor.

Project: If the parent entity of the staffing profile where the assigned resource
belongs is a project, the project is included as a cost factor.

Org Unit: If the primary Org Unit of the assigned resource is defined, it is
included as a cost factor.

Table 4-2. Cost factors and entities to which they apply

The forecast labor cost is not updated immediately when you change cost factors described in
"Table 4-2. Cost factors and entities to which they apply" above. Instead, it is recalculated base on
the latest cost factors when the SP-FS sync service is triggered by effort or status change of the
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position or assignment. PPM Center does not keep or consider historic cost rates after you change
cost factors.

Note: If you change the cost rate by clicking the Add New Rate button on the Edit Cost Rule
page and specify a effective start date in the pop-up window, PPM Center keeps and considers
historic cost rates when calculating the forecast and actual labor costs for periods earlier than
the effective start date.

For more information about calculating forecast labor cost, see "Configuring a Lifecycle Entity
Financial Summary for Capitalization and Roll-Ups" under Chapter 4 of HP Financial Management
User’s Guide.

Best Matching Strategy

PPMCenter calculates a score for each cost rule and considers the rule with the highest score as
the best matching one. Cost rate of a position/resource used in the calculation of forecast labor cost
is the one defined in the best matching rule.

Before calculating a score for a cost rule, PPM Center checks whether the cost rule and the
position/resource contain the same cost factor and whether values of the factor are the same. If
yes, the cost factor is consideredmatching. Then, scores of cost rules are calculated as follows:

l If a cost rule contains nomatching cost factors, it is considered not applicable and gets -1 point.

l If a cost rule contains one or morematching cost factors, PPM Center assigns 2n points to each
matching factor according to its priority. Priorities of cost factors are configured on the Change
Cost Factors page (Open > Administration > Financials > Change Cost Factors). In the
Selected Columns field, all cost factors are listed according to their priorities from top to
bottom.

For example, if a cost rule contains four cost factors and they are all matching factors, the factor
of top priority gets 24 = 16 points; the one of second priority gets 23 = 8 points; the one of third
priority gets 22 = 4 points; and the last one gets 21 = 2 points. The score of this cost rule is the
sum of all points its factors get. In this example, it is 16 + 8 + 4 + 2 = 30 points.

l If a cost factor contains no value, it is considered as a wildcard factor. PPM Center assigns one
point to each wildcard factor.

l Besides matching and wildcard factors, all other cost factors get no point.

l If a cost rule is not the default one, add one point to its score. Therefore, if a cost rule contains
the same cost factors with the default cost rule, it gets a higher score than the default one.
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Note: There is at least onematching rule, that is, the default rule which cannot be deleted and
whose cost factors are all wildcard factors.

Actual Labor Cost Period Break Down

The actual efforts you log in time sheets and work plans are in a continuous range. However, when
rolling up the actual labor cost to the financial summary, PPM Center breaks it down into periods.
The cost of eachmonth is calculated as follows:

Actual Labor Cost of month n = Total Actual Cost * Working days in month n / Total working days
during the period when actual efforts are logged

For example, a resource has been working on a task from July 17th to August 20th, 2013 and costs
USD $10000. Data used when calculating the actual labor cost of this resource is as follows:

l Total actual cost is USD $10000.

l Total working days from July 17th to August 20th is 25 days.

l Working days in July is 11 days.

l Working days in August is 14 days.

Note:Working days are calculated according to the calendar of the resource.

Therefore, actual labor cost of this resource in July is USD $10000*11/25 = USD $4400, while that
in August is USD $10000*14/25 = USD $5600.

The calculation of actual labor cost is the same for part time and full time resources.

For more information about calculating forecast labor cost, see "Configuring a Lifecycle Entity
Financial Summary for Capitalization and Roll-Ups" under Chapter 4 of HP Financial Management
User’s Guide.

Net Present Value and Total Nominal Return

For information about net present value and total nominal return, see Appendix A of HP Portfolio
Management User’s Guide.

Calculating Data in Scenario Comparison
Data on theRole Availability tab of the Scenario Details page are calculated as follows:
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l Total FTE Required comes from all the staffing profiles attached to the lifecycle entities
included in the scenario comparison.

Note: Total FTE Required does not reflect the real-time data. Instead, it is aggregated by
the Staffing Profile Period Sum Update Service configured on the Schedule Services page.

l Total FTE Available comes from the resource pool defined in theCalculate Total Available
Resources for comparison from the following Resource Pools field on the Scenario
Comparison page.

l Resource Difference is calculated as Total FTE Available - Total FTE Required.

For more information about calculating data in the scenario comparison, see Chapter 5 of HP
Portfolio Management User’s Guide.
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Advice about Using PPM Center Database DMS and PPM
Center External Database DMS

This section provides advice for DBAs about using PPMCenter Database DMS and PPMCenter
External Database DMS, including:

l "Choosing Between PPMCenter Database DMS and PPMCenter External Database DMS"
below

l "Conducting TablespaceManagement" on the next page

l "PPM Center Database DMS Environments Examples" on page 123

Choosing Between PPM Center Database DMS and PPM
Center External Database DMS

The only difference between the two solutions is that when PPMCenter External Database DMS is
in use, all the documents contents, indexes, and versions metadata are stored in a separate
database schema, not in the PPMCenter schema. Therefore, the only DMS related table that will
always be stored in PPM Center schema is the KNTA_DOCUMENTS table, which contains basic
document information. In this case, you can choose whether to store the separate DMS schema
and the PPMCenter schema on the sameOracle server or not. Both scenarios are supported.

HP advises that you use PPMCenter External Database DMS if you:

l Have large amounts of attachments (more than 50GB), or

l Need to apply different settings or maintenance policies to PPM Center business data and
attachments. For example, you have to apply different schema-level backup or data integrity
policies.

PPM Center External Database DMS allows for a greater flexibility in database settings and
tablespacemanagement, as you can tune them in a way other than from PPMCenter schema. By
using PPMCenter External Database DMS, it is easier to make sure that PPM Center database is
not impacted if a very fast-growing document amount results in the lack of available space on a
tablespace used by DMS tables or indexes, or on the server disk storage.

For more information about configuring PPM Center Database DMS datamodel and PPMCenter
External Database DMS, seeDocument Management Guide and Reference.
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Conducting Tablespace Management
Tablespacemanagement is left to DBAs as it is considered a database administration task. DBAs
are free to store PPM Center DMS data (documents contents, indexes, andmetadata) on
whichever tablespace they deem appropriate. Having dedicated tablespaces for themain elements
of PPM Center Database DMS (content, TEXT indexes) has the following advantages:

l If intense attachments activity leads to using up all available space in a dedicated DMS
tablespace, the rest of PPM Center application will not be impacted (unless it turns out to be a
lack of space on the disk storage, and that PPM Center application tablespaces use the same
disk storage).

l DBAs can choose to compress the tablespace storing DMS documents contents. This can
result in significant space savings if most attachments are in a format that can be efficiently
compressed (such as log files).

l If needed, DBAs can finely tune the performance of tablespaces according to their usage:
tablespace storing documents contents should be optimized for heavy I/O operations
(documents store/retrieve), while tablespace storing TEXT indexes should be optimized for fast
records access.

Default Tablespaces

When using PPMCenter Database DMS, by default, documents contents are stored in the default
USER_CLOB PPMCenter tablespace, while themetadata and the TEXT indexes (when created) are
stored in default USER_DATA PPMCenter tablespace. Indexes on themetadata tables are stored in
the USER_INDEXES PPMCenter tablespace. DBAs can change the tablespaces used by PPM
Center Database DMS, for example, to save DB disk space by compressing documents contents,
or by tuning tablespace-level settings that would provide better performance for their specific usage
pattern.

When using PPMCenter External Database DMS, there is no specific tablespaces instruction
when the tables are created in the external schema. Tables are automatically created if not existing
at the beginning of themigration process, when testing connection to the new DMS system.

Tablespaces customizations are supported for both PPM Center Database DMS and PPMCenter
External Database DMS, but HP advises that you do such customizations before themigration is
started, so that all data is stored in the intended tablespace as migration proceeds.
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Changing the Tablespaces of the Documents Contents

Most of the space consumed by PPMCenter (External) Database DMS in the database is used to
store the documents contents (the actual attachment files). These contents are stored under their
binary form in two BLOB columns:

l KNTA_DOCUMENT_TIP_CONTENTS.DOC_CONTENT, to store the latest version (i.e. tip version) of
each file.

l KNTA_DOCUMENT_HISTORY_CONTENTS.DOC_CONTENT, to store all non-tip versions of each file.

If you want to change the tablespace where these contents are stored, move the DOC_CONTENT LOB
columns to another tablespace (replace “X” below with either "TIP" or "HISTORY"):

ALTER TABLE KNTA_DOCUMENT_X_CONTENTS MOVE LOB(DOC_CONTENT) STORE AS (TABLESPACE
NEW_TABLESPACE_NAME);

When a new version is added to a document, the contents of the old tip version will first be copied to
the HISTORY table before the new tip contents are inserted in the TIP table. As a result, for better
performance, HP advises that you store both TIP and HISTORY contents in the same tablespace.

It is considered a good practice to have a dedicated tablespace to store documents contents,
especially if the size of attachments in PPM Center is very large (more than 50GB of attachments).

Changing the Tablespace of TEXT Indexes

Managing domain indexes (like the Oracle TEXT CONTEXT indexes) is quite different from
managing “standard” Oracle indexes. After all, DOMAIN indexes are just a series of Oracle tables
put together, and as such, the standard Oracle INDEX management does not apply to them.

Depending on the type of your attachments, the size of the TEXT index can represent a significant
part of the size of the file attachments. Themeasurements on HP R&D Sample Dataset show
numbers ranging from 15% to 30% of the size of the attachments contents. However, if you have
documents that aremostly in raw text formats (log, txt, etc.), then the size of your TEXT index
can in theory exceed 100% of the size of the attachments contents. For this reason, it is a good
practice to have a dedicated tablespace to store the TEXT index when using PPMCenter (External)
Database DMS.

The tablespace to be used for storing a TEXT index must be specified upon TEXT index creation.
Here is an example on how to store anOracle TEXT index in the XYZ tablespace. Before creating
the TEXT index, you have to define a STORAGE parameter, and set the tablespace of all domain
tables of the domain index to use the XYZ tablespace:

begin
ctx_ddl.create_preference('MY_XYZ_TEXT_STORE', 'BASIC_STORAGE');
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ctx_ddl.set_attribute('MY_XYZ_TEXT_STORE', 'I_TABLE_CLAUSE', 'tablespace XYZ');
ctx_ddl.set_attribute('MY_XYZ_TEXT_STORE', 'K_TABLE_CLAUSE', 'tablespace XYZ');
ctx_ddl.set_attribute('MY_XYZ_TEXT_STORE', 'R_TABLE_CLAUSE', 'tablespace XYZ');
ctx_ddl.set_attribute('MY_XYZ_TEXT_STORE', 'N_TABLE_CLAUSE', 'tablespace XYZ');
ctx_ddl.set_attribute('MY_XYZ_TEXT_STORE', 'I_INDEX_CLAUSE', 'tablespace XYZ COMPRESS 2');
ctx_ddl.set_attribute('MY_XYZ_TEXT_STORE', 'P_TABLE_CLAUSE', 'tablespace XYZ');

end;
/

Note: The COMPRESS 2 parameter is here only for the sake of the example, it is not mandatory
and can be adjusted depending on your preferences.

You can then create the TEXT index and specify the storage to use as part of the parameters of the
index creation:

EXECUTE IMMEDIATE 'CREATE INDEX DMS_TIP_META_IDX
ON KNTA_DOCUMENT_TIP_CONTENTS(FULL_TEXT_META)
INDEXTYPE IS CTXSYS.CONTEXT
parameters (''LEXER PPM_DMS_LEXER DATASTORE PPM_DMS_TIP_DS STORAGE MY_XYZ_TE

XT_STORE SYNC (every sysdate+1/144)'')';

Formore information about available parameters (including tablespacemanagement) when creating
anOracle TEXT index, see http://docs.oracle.com/cd/E11882_01/text.112/e24436/cdatadic.htm.

PPM Center Database DMS Environments Examples
This section presents the database high-level configuration of two different sample environments,
and explains the rationale behind these choices. These configurations are only provided for
didactical purposes and should not be considered as an official HP recommendation. Your actual
configuration should be adapted according to your environments specificities and Database &
System administration policies.

Example 1: Small Size Deployment

l Documents overview:

n ~ 12K documents

n Total documents size: ~ 2.5 GB

n TEXT index size: ~ 410MB

n Mostly office documents

l Limited volume increase (~ 15% per year)

Release Notes
Chapter 5: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.22

Page 123 of 310HP Project and Portfolio Management Center (9.22)

http://docs.oracle.com/cd/E11882_01/text.112/e24436/cdatadic.htm
http://docs.oracle.com/cd/E11882_01/text.112/e24436/cdatadic.htm


l DMS choice: PPM Center Database DMS

n Limited size of documents and DMS DB overhead do not justify a dedicated DB schema.

n Simple backup procedure: weekly PPM Center DB Dump (PPM Center business data and
attachments).

l Tablespace configuration:

n Using a dedicated PPM_DMS tablespace for DMS documents contents and TEXT indexes,
with default tablespace configuration and a limitedmaximum size to 40GB. This was decided
in order to prevent impact on PPMCenter business data tablespaces in case of sudden and
massive increase of the documents size. (security concern to prevent a Denial of Service
attack by attachingmany large documents to PPM Center).

n Using default tablespace for everything else.

l DMS configuration parameters in PPM Center:

n MAX_WEB_ATTACHMENT_SIZE_IN_MB: Default value (2048, i.e. 2GB)

n DMS_INSECURE_FILE_EXTENSION_CHECK: Default value (false, all extensions are
allowed)

Example 2: Large Size Deployment

l Documents overview:

n ~ 1.1M documents

n Total documents size: ~ 395GB

n TEXT index size: ~ 127GB

n Mostly office documents and log files

n Frequent documents updates and read operations

l Moderate volume increase (~ 35% per year)

l DMS choice:PPM Center External Database DMS, different DB physical server
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n The large number of I/O operations requires dedicated hardware as the PPMCenter
Database is already under heavy load due.

n Dedicated DMS schema allows for differentiated backup strategies:

o Daily backup for PPM Center Business DB

o Weekly backup (Week-end) for PPM Center DMS DB

l Tablespace configuration:

n One compressed tablespace to store documents contents (log files are rarely compressed
when attached, and compressing the tablespace allows saving up to 30% disk space).
Tablespace is optimized for I/O intensive read/write operations.

n One tablespace for TEXT indexes, optimized for transactional operations.

n One tablespace for everything else (DMS tables and indexes), optimized for transactional
operations.

l DMS configuration parameters in PPM Center:

n MAX_WEB_ATTACHMENT_SIZE_IN_MB: 250. (Max allowed file size is 250MB)

n DMS_INSECURE_FILE_EXTENSION_CHECK: true. Preventing executable file extensions
(Values of the DMS_INSECURE_FILE_EXTENDSIONS parameter include exe, com, bat, reg, jar,
cmd, and lnk).
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Added Buttons in the List Validation Window
Previously it is time-consuming to change the sequence of validation codes in the Validation
window, especially when the validation contains a long list of codes. Starting from PPMCenter
version 9.22, for all validations validated by "List", two new buttons were added to the Validation
window in the PPMWorkbench which allows you to reorder validation codes more conveniently.

Button Description

Allows you to sort entries in theValidation Values field alphabetically.

Allows you to specify the sequence of a specific entry in theValidation Values field.

Sorting Validation Codes Alphabetically
To sort entries in theValidation Values field alphabetically according to the Code column, click the

button, then click OK/Save to save the change.

Note: This alphabetical sorting is case-insensitive.

All validation codes are sorted by letter, so "value3" is listed after "value12". To avoid this, HP
recommends that you prefix numbers with some zeros. For example, use "value003" and
"value012" instead.

Specifying the Sequence of a Specific Entry in the
Validation Values Field

To specify the sequence of a specific entry in theValidation Values field,

1. In the PPMWorkbench, open the list validation you want to edit.

2. In theValidation Values field, select the entry whose sequence you want to change.
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3. The button is enabled.

4. Click the button, the input box appears.

5. In the input box, enter the sequence number of the row that you want to move the selected
entry to. In this example, enter 1.
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The selected entry is moved from the fourth row to the first.
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Improved Behavior of SQL Drop-Down/Auto-Complete
Fields in MLU

Starting from PPMCenter version 9.22, custom drop-down fields and auto-complete fields
validated by "List" and "SQL - Custom" behave the same in theMLU, as follows:

If a custom drop-down/auto-complete list has multiple values, then a drop-down/auto-complete field
with an existing value is shown in your current session language, even if your session language is
different than the language in which the value was originally selected from the drop-down/auto-
complete list.

Example. A custom drop-down/auto-complete list with multiple values has been created for
requests. A user logged on to PPM Center in a German language session creates a request, and in
doing so, selects a value for the custom drop-down/auto-complete list. A different user logs on to
PPM Center in a Korean language session and opens the new request, which was defined in
German. The value in the drop-down/auto-complete field is shown in Korean.

Note: PPMCenter does not support auto-complete fields validated by "SQL - User" in the
MLU.

To ensure a SQL drop-down/auto-complete field behaves correctly,

1. In the PPMWorkbench, open the request type which contains the drop-down/auto-complete
field.

2. On the Fields tab, select the drop-down/auto-complete field and click Edit.

The Field: <Field Name> window opens to theAttributes tab.

Note: If the drop-down/auto-complete field is a column of a table component, select and
edit the table component.

3. In theSearch Validation field, specify a list validation which contains:

n All the values potentially returned by the drop-down/auto-complete field

n Potential translations of the returned values. If translations are not provided, the returned
values will be used.
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Note: If a table component contains several SQL drop-down/auto-complete columns, the
list validation should include values potentially returned by all the columns together with
translations of the returned values.

4. Click OK.
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Enhancements to the HP Resource Management Module
The following new features and improved user experiences are provided for the HP Resource
Management module:

l "Enhancements to Staffing Profile" below

l "Special Command for Baseline Staffing Profile" on page 143

l "Adding Security Groups to Staffing Profile/Resource Pool ACL" on page 144

l "Viewing a Position from the Resource Request Portlet" on page 145

l "Searching Resource Pools without View Access Grant" on page 146

Enhancements to Staffing Profile
The following new features and improved user experiences are provided for Staffing Profile:

l "Position Filters" below

l "Total Summary" on page 136

l "Expand/Collapse All Positions" on page 138

l "Resizable Columns and Staffing Profile Table" on page 138

l "Partial Refresh" on page 139

l "Paging Display" on page 140

l "Highlighting and Centering Current Period" on page 141

l "Period Filtering" on page 142

Position Filters

In the staffing profile table of the staffing profile page, positions can be filtered by one or more of the
following entities:

l Position/Resource

l Status
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l Resource pool

Filter Positions by Position/Resource

You can filter positions in the staffing profile table by some basic attributes of the positions, which
means filtering positions by position here.

To filter positions by position (some attributes of position),

1. Move themouse over Position.

The icon displays after Position.

2. Click the icon.

A dialog box displays.

3. Click thePosition or theResource tab.
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Note: By default, thePosition tab is selected. You can click theResource tab to filter by
Resource.

4. Provide information for one or more fields on which you want to filter as listed in the Position
(Position) or the Position (Resource) section of Table 1-1.

Field Name Description

Field Name Description Position (Position)

Filter by Position
Label:

Specify a text string.

This filter displays data for staffing profile positions that contain the
specified text in the position label.

Unmet Demand no
less than _ FTE

The number of FTEs the unmet demand is equal to or greater than.

This filter displays the data for staffing profile positions whose
unmet demand is equal to or greater than the value you specify in
the period (between "From" on the next page and "To" on the next
page).

Over Allocation no
less than _ FTE

The number of FTEs the position’s overallocation is equal to or
greater than.

This filter displays the data for staffing profile positions whose over-
allocation is equal to or greater than the value you specify in the
period (between "From" on the next page and "To" on the next
page).

Table 4-10. Position Filter Fields
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Field Name Description

From The start period that the staffing profile position’s unmet demand or
over allocation is from or after.

This filter displays data for staffing profile positions whose unmet
demand or over allocation is from or after the period you specify.

You can type a value in the box directly, or set the value by the
followingmethod:

a. Click the icon.

The Click a value to select window opens.

b. Search and select a period from the list.

To The finish period that the staffing profile position’s unmet demand or
over allocation is before or to.

This filter displays data for staffing profile positions whose unmet
demand or over allocation is before or to the period you specify.

You can type a value in the box directly, or set the value by the
followingmethod:

a. Click the icon.

The Click a value to select window opens.

b. Search and select a period from the list.

Position (Resource)

Resource Name The name of the resource.

This filter displays data for staffing profile positions that contain the
selected resource(s).

You can type a value in the box directly, or search and select a

value by clicking the icon.

Table 4-10. Position Filter Fields, continued
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Field Name Description

Promise Promised resources or allocations.

This filter displays data for staffing profile positions that contain
promised resources or allocations.

This filter is visible only when the ENABLE_ PROMISE_RESOURCE_
ALLOCATION parameter in the server.conf file is set to true. For
more information about editing the server.conf file, see the
Installation and Administration Guide.

Status

(Select All) Select all of the below statuses.

This filter displays the positions without the Status filter criteria.

New The status of the staffing profile position is “New”.

This filter displays all staffing profile positions whose status is
“New”.

Requested The status of the staffing profile position is “Requested”.

This filter displays all staffing profile positions whose status is
“Requested”.

Partially Assigned The status of the staffing profile position is “Partially Assigned”.

This filter displays all staffing profile positions whose status is
“Partially Assigned”.

Soft Booked The status of the staffing profile position is “Soft Booked”.

This filter displays all staffing profile positions whose status is “Soft
Booked”.

Fulfilled The status of the staffing profile position is “Fulfilled”.

This filter displays all staffing profile positions whose status is
“Fulfilled”.

Table 4-10. Position Filter Fields, continued

Release Notes
Chapter 5: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.22

Page 135 of 310HP Project and Portfolio Management Center (9.22)



Field Name Description

Rejected The status of the staffing profile position is “Rejected”.

This filter displays all staffing profile positions whose status is
“Rejected”.

Resource Pool

(Select All) This filter displays the positions without the Resource Pool filter
criteria.

<Resource Pool> Name of the resource pool. This filter display the positions which
belong to this resource pool.

(Blank) This filter display the positions which do not belong to any resource
pool.

Table 4-10. Position Filter Fields, continued

5. Click Apply.

The data in the staffing profile table is updated, and the positions whichmeet your filter criteria
are displayed.

Filter Positions by Status or Resource Pool

If you want to filter the staffing profile positions by status or resource pool, do similar steps as those
when filtering positions by position/resource. For details, see "Filter Positions by
Position/Resource" on page 132.Youmust provide information for one or more fields on which you
want to

Youmust provide information for one or more fields on which you want to filter as listed in the
"Status" on the previous page or the "Resource Pool" above section of "Table 4-10. Position Filter
Fields" on page 133.

Total Summary

The Total Summary section displays the total values for Average FTE and each period’s allocations
(at the right section of the staffing profile table). See "Total Summary Section" on the next page

This section includes the following three rows (see "Rows in Total Summary" on the next page for
details about the three rows):
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l Forecast Total

l Assignment Total

l Unmet Total

Total Summary Section

Row Description

Forecast Total The total value of the forecast

Assignment Total The total value of the assignments in the specific period

Unmet Demand
Total

The total value of the unmet demands (over-allocations) in the specific
period

Rows in Total Summary

The total values in this sections are calculated based on the following criteria:

l All the positions and assignments belong to the current staffing profile, and they are displayed on
the current staffing profile page. The values are recalculated when you switch to another page or
filter the positions by other criteria.

l The total forecast is re-calculated when any forecast change to positions aremade.
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Expand/Collapse All Positions

On the staffing profile page, the positions and their assignments are displayed hierarchically (in a
tree table). By default, when you open a staffing profile page, only the positions are displayed, all
the assignments are hidden. You can click the arrow button before each position to view or hide its
assignments.

To view the detailed assignments of the all the positions, click Expand All to expand all positions.
To hide all the assignments of the positions, click Collapse All.

Resizable Columns and Staffing Profile Table

Some datamight be hidden if their columns are too narrow. On the Staffing Profile page, each
column at left side of the staffing profile table is resizable. So, you can view the full data by dragging
the columns to resize the columns.

These columns include:

l Position

l Status

l Resource Pool

l Average FTE
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Besides, the staffing profile table in the Allocation Details section is resizable. You can drag the
vertical bar in themiddle of the staffing profile table to view the data you want.

Partial Refresh

If there is a large number of data on the staffing profile page, updating the data on the whole page
may take long time and cause performance issue. The partial refresh feature enables you to
asynchronously load staffing profile page and update only part of the data on the staffing profile
page. This improves the system performance.

You can use this feature in the following scenarios:

l Click Refresh at the bottom of the Staffing Profile page.

Only the data in the staffing profile table is updated. The data in the header section remains
unchanged.

l Add a new position or edit an existing position.

Only the position you add or edit is updated.

l Assign resources to a position.

Only the relevant attributes of the position are updated.
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Paging Display

You can display staffing profile positions by page. The following table describes the configuration
options and fields on the pagination bar (on the right top of the staffing profile table) for you to
display staffing profile positions by page.

Item Name Description

5 Per Page/10 Per page/25 Per
Page/50 Per page/100 Per
page/Show All

Allows you to choose to display 5, 10, 25, 50 or 100
positions per page, or to display all positions on the current
page.

Allows you to go to the first page.

Allows you to go to the previous page.

Page <Number1> of <Number2> <Number1> represents the current page number.

<Number2> represents the total page number.

Allows you to provide a valid page number in <Number1>
to go to that specific page.

Allows you to go to the next page.

Allows you to go to the last page.

Table 1-1. Staffing profile configuration options and fields in the Allocation Detail section
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Highlighting and Centering Current Period

If there is a large number of allocation data, youmust drag the scroll bars to view data. Whatever
period type (years, quarters, months, or weeks) the staffing profile uses, the current period of the
allocation data is highlighted and centered. To view data in other periods, drag the horizontal scroll
bar. This makes it easier for you to find the current allocation data.

By default, on the Staffing Profile page, the following allocation data are displayed from left to right
on the right side of the staffing profile table:

l The allocations in the previous three periods (years/quarters/months/ weeks)

l The allocations in the current period (year/quarter/month/week)

l The allocations in the future periods (years/quarters/months/weeks)

For example, there is a staffing profile lasting for 3 years, from January 2012 (start period) to
December 2014 (end period). Now it is October 2013. You can see the following on the staffing
profile page when opening this staffing profile:

The allocation data in the current month (October 2013) and in futuremonths are shown in the grid
table. Besides, the column for the current month is highlighted. See the below figure.
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The scroll bar’s position is remembered. As a Result,

l When you change the effort type (FTE/Hours/Personal Days), you can view the allocation data
in the same periods as before.

l When you change the period type (Years/Quarters/Months/Weeks), the earliest period remains
the same.

Period Filtering

The allocation table on the Staffing Profile page can contain a large amount of data, especially when
you selectWeeks in theView Allocation in field. Starting from this version, to improve usability
by saving the loading time, when you selectWeeks in theView Allocation in field,

l Only data of three weeks earlier than and several weeks later than the current week are loaded
and displayed on the right side of the table. The number of displayed weeks later than the current
week depends on your screen resolution and window size.

For example, if the current date is October 1, 2013, and you selectWeeks in theView
Allocation in field, only data from September 9, 2013 to November 10, 2013 are loaded and
displayed.

l To view more data, drag the horizontal scroll bar at the bottom of the table, and the data in other
weeks are loaded and displayed.

Note:When you selectMonths, Quarters, orYears in theView Allocation in field, all the
data are loaded and displayed.
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Special Command for Baseline Staffing Profile
A system special command ksc_create_baseline_staffing_profile is introduced for staffing
profiles associated with projects.

Below are the default parameters of this special command:

l STAFFING_PROFILE_ID

l SP_BASELINE_NAME

Using This Special Command

You can configure this special command in the following entities:

l Object types

l Request types

l Report types

l Validations

l Workflow step sources

To use this special command, youmust have the edit special command access grant.
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For details about how to use special commands, seeCommands, Tokens, and Validations Guide
and Reference.

Exceptions

In the following scenarios, functions may fail and error logs will return if you run this special
command:

l You do not have permission to create baseline in the project.

l You create a baseline for a staffing profile which is not associated with any project.

Adding Security Groups to Staffing Profile/Resource Pool
ACL

In previous versions, you were allowed to add a single user to the staffing profile/resource pool
access control list (ACL). Now you can add a security group to the staffing profile/resource pool
ACL:

l "Adding a Security Group to a Staffing Profile ACL" below

l "Adding a Security Group to a Resource Pool ACL" on the next page

Adding a Security Group to a Staffing Profile ACL

If you have Edit Security access grant for the Staffing Profile Configure Access page, you can add
security groups to the staffing profile access control list (ACL). All members in the security groups
that are listed on the Configure Access pageminimally have viewing access.

To add a security group to a staffing profile ACL,

1. Open a Staffing Profile page.

If you have permission tomodify the staffing profile, theConfigure Access button will be
enabled.

2. Click More > Configure Access.

The Configure Access for Staffing Profile page opens.

3. Add a security group to the list by clickingAdd Security Group and selecting the desired
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security group from the list.

You cannot add a duplicate security group.

4. Configure the security group's access by selecting the checkboxes under each category.

The View access is automatically granted to the security group.

5. Click Done.

For more information about staffing profile security, seeHP ResourceManagement User’s Guide.

Adding a Security Group to a Resource Pool ACL

If you have Edit Security access grant for the Resource Pool Configure Access page, you can add
a security group to or remove one from the resource pool ACL. All members in the security groups
that are listed on the Configure Access pageminimally have viewing access.

To add a security group to a staffing profile ACL,

1. Open a Resource Pool page.

If you have permission tomodify the resource pool, theConfigure Access button will be
enabled.

2. Click More > Configure Access.

The Configure Access for Resource Pool page opens.

3. Add a security group to the list by clickingAdd Security Group and selecting the desired
security group from the list.

4. Configure the security group's access by selecting the checkboxes under each category.

The View access is automatically granted to the security group.

5. Click Done.

For more information about resource pool security, seeHP ResourceManagement User’s Guide.

Viewing a Position from the Resource Request Portlet
In this version, you can open and view a specific position from the Resource Request portlet, rather
than all the positions that belong to the staffing profile.
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In the Resource Request portlet:

l To view a specific staffing profile, click a staffing profile link from the Staffing Profile column.

The Staffing Profile page with all of its positions opens.

l To view a specific position, click a position link from the Position column.

The Staffing Profile page with the specific position opens.

Searching Resource Pools without View Access Grant
In previous versions, you can click Search to search resource pools for theResource Pool field in
a position dialog box. However, the search result only lists resource pools that you have the access
grant to view.

In this version, all the resource pools in the system can be listed in the search result even you do
not have view access grant to all of them.

To search resource pools with search criteria in a position dialog box,

1. Add a new position or open an existing position.

2. Click Search on the right of theResource Pool field.
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The Search Resource Pools dialog box opens.

3. Provide search criteria in the appropriate fields.

4. Click Search.

All the resource pools that fit the search criteria are shown in the research results list.
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Usability Enhancements
Version 9.22 implemented the following usability enhancements:

l "Request Creation Confirmed Page Skippable" below

l "Enhancements to the Project Details Page" on the next page

l "Prompt Added on the Project Overview and Time Sheet Pages" on page 150

l "Enhanced Data Entry Error Message" on page 150

l "Enhanced Export to Excel Functionality" on page 150

Request Creation Confirmed Page Skippable
In previous versions, the Request Creation Confirmed page opens after you click Submit on the
Create New <Request Type> page.

On version 9.22, you can skip this page by manually adding the following line into the server.conf
file:

com.kintana.core.server.SKIP_REQUEST_CREATE_CONFIRMATION_PAGE=true

Then, you are brought to the Request Details page for a submitted request after clickingSubmit.

Information Box Added on Request Details page

When you come to the Request Details page after clickingSubmit on the Create New <Request
Type> page, you would find an information box is added above the Status section on the Request
Details page, informing you that your request is created.

Clicking the Delete icon closes the box.

Release Notes
Chapter 5: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.22

Page 148 of 310HP Project and Portfolio Management Center (9.22)



Enhancements to the Project Details Page
In version 9.22, the following enhancements are implemented to the Project Details page:

l "Toolbar Pinned to the Top of the Page" below

l ""Jump To" Navigation Panel Added to the Page" below

Toolbar Pinned to the Top of the Page

In previous versions, the toolbar that collects all action buttons and displays available workflow
step actions is not pinned to the top of the Project Details page, so youmay have to scroll up to the
top when you want to use it.

In version 9.22, the toolbar is pinned to the top of the page regardless of you scrolling up and down
it. This saves your efforts especially when the project details pages are long.

"Jump To" Navigation Panel Added to the Page

In previous versions, you have to scroll up or down the Project Details page to locate a specific
section that you want to work on.

In version 9.22, the Jump To navigation panel is introduced to the page. To jump to a particular
section of this page, click the section name from the Jump To navigation panel.

By default, the navigation panel is expanded. To collapse it, click the arrow button in the upper-right
corner of the panel.
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Prompt Added on the Project Overview and Time Sheet
Pages

PPMCenter version 9.22 introduces a prompt on the Project Overview and Time Sheet pages. It
pops up if you edit some fields under one tab of the pages and go to another tab without saving the
changes.

ClickingOK in the prompt brings you to the desired tab with the changes unsaved. Clicking
Cancel, you stay on the current page.

Enhanced Data Entry Error Message
Previously, when you enable Portfolio Management for a program with multiple
proposals/projects/assets on the Program Settings page, youmay receive the following error
message "Portfolio Management cannot be enabled for this program because some of its content is
already included in a portfolio or in another program that has Portfolio Management enabled". The
message is not specific, it can be time-consuming for users to identify what content is causing the
error.

Starting from PPMCenter version 9.22, the data entry error message lists all the conflicting
entities, together with the name of the program/portfolio they belong to, in the following format:

Asset/Project/Proposal "X" is included in the portolio/portfolio-enabled program
"Y".

Enhanced Export to Excel Functionality
The “Export to Excel” functionality is enhanced on the following pages:

l Staffing Profile page

l Search Resource page

This enhanced functionality is also available on the following pages:

l Resource Finder page

l Search Resource Availability page

l Resource AllocationManagement page

l Forecast Planning page

With this enhanced functionality, you can:
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l Export data to aMicrosoft Excel file, not HTML page. In this way, you can process your data by
usingmore Excel functions, such as format and calculation.

l Export more data attributes to the Excel file.

Caution: HP recommends that you useMicrosoft Excel 2007 or higher for this functionality.
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Enhanced Encryption Algorithm for PPM Center
To conform to FIPS 140-2 (Federal Information Progressing Standards 140-2), PPM Center
enhanced the encryption algorithm in some cases in version 9.22. Not all cases that use encryption
algorithm are FIPS 140-2 compliant in this version.

The cases that apply the encryption algorithm compliant with FIPS 140-2 include:

l Logging on to PPM Center with Oracle database authentication

l Creating user

l Editing user profile

l Configuring PPM Center database

l Logging on to PPM Center with LDAP authentication

l Importing LDAP users

To apply the enhanced encryption algorithm,

1. Stop the PPM Server.

2. Unzip the fs_home.jar file located in the <PPM_Home>/deploy/922/SP2 directory.

3. Copy the following three .jar files from the <fs_home>/utilities/fips directory to the
<JAVA_Home>/jre/lib/ext directory:

n cryptojce.jar

n cryptojcommon.jar

n jcmFIPS.jar

4. Edit the java.security file located in the <JAVA_Home>/jre/lib/security directory:

a. Add the following before the existing security providers:

security.provider.1=com.rsa.jsafe.provider.JsafeJCE

b. Change the sequence numbers of the providers tomake sure that the numbers start with 1,
followed by 2, 3, 4, and so on.
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c. Add the following two lines after the security provider list:

o com.rsa.cryptoj.fips140initialmode=FIPS140_MODE

o com.rsa.crypto.default.random=ECDRBG

d. Comment out the line securerandom.source=file:/dev:/urandom by adding a number
sign # before it.

5. Run the ppm_fips_security_extension.sql script located in the PPM_Home/bin/db
directory.

Note: Back up the following DB tables before running this script:

n KNTA_USERS

n KNTA_PASSWORD_CHANGES

n KNTA_USERS_INT

6. Run the sh ./kFIPSMigrate.sh script located in the PPM_Home/bin directory.

Note:

n As an administrator, you should have the execution privilege to run this script.

n When running this script, you are required to enter the start user id and the end user id to
decide how much data would be processed in a batch. You can get the user ids from the
KNTA_USERS table.

7. Run the sh ./kFIPSEncrypt.sh script located in the PPM_Home/bin directory to get the
encrypted values for the passwords you set for DB and LDAP.

Note:

n As an administrator, you should have the execution privilege to run this script.

n If your system is not integrated with LDAP, you do not need to run the script for the
encrypted value of the LDAP password.
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8. Configure the following three parameters in the server.conf file from the PPM_Home directory.

n Set the com.kintana.core.server.FIPS_ENABLE parameter to true to enable the new
encryption algorithm

n Set the com.kintana.core.server.DB_PASSWORD parameter to the encrypted value you
get in Step 7 to reset the DB password

n Set the com.kintana.core.server.LDAP_PASSWORD parameter to the encrypted value you
get in Step 7 to reset the LDAP password

Note:

n Youmay have tomodify these parameter values directly in the server.conf file. HP
recommends that you do not run ppm_config.exe (onWindows) or kConfig.sh (on
Unix) to modify these parameters.

n If your system is not integrated with LDAP, you do not need to reset the LDAP
password.

9. Run sh ./kUpdateHtml.sh script located in the PPM_Home/bin directory to apply your
changes on the three parameters.

10. Start the PPM Server.

11. (Optional) If your system is integrated with LDAP, and you want to import data from LDAP and
set default password for the Import Users report or the Run PPMOrganization Unit Interface
report, you need to add an additional command for either of the reports.

To do so,

a. Log on to PPM Center.

b. From themenu bar, select Open > Administration > Open Workbench.

The PPMWorkbench opens.

c. From the shortcut bar, select Configuration > Report Types.

The Report TypeWorkbench opens.

d. Click List, and then select the desired report type.

Release Notes
Chapter 5: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.22

Page 154 of 310HP Project and Portfolio Management Center (9.22)



e. Open the report type either by double-clicking it or clicking Open.

The Report Type: <Report> window opens.

f. Click New Cmd under theCommands tab.

The New Commandwindow opens.

g. Name the new command as you want.

h. Type the following in the Steps field:
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ksc_run_java com.kintana.core.server.tools.FIPSPasswordInterfaceTable "[T
EMP_GROUP_ID]"

Note: TEMP_GROUP_ID is the name for the temp token by default. If you have
changed the token name, replace TEMP_GROUP_ID with the name you used for the
token.

i. Click Add.

You are back to the Report Type: <Report> window.

j. Adjust the sequence of the added command by using the up or down button, making sure
that the added command is under the Encrypt Password command.

k. Click OK.
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Integrations
The following integrations are included in PPM Center version 9.22:

l "Enhancements to the Integration of PPM Center Tasks with HP ALM Releases" below

l "Disabling Status Synchronization and Enabling Status Field Mapping for the Integration
between PPMCenter and ALM (Using ALM)" on page 170

Enhancements to the Integration of PPM Center Tasks
with HP ALM Releases

This section includes the following:

l "Enhancements Implemented to the Integration of PPM Center Tasks with HP ALM Releases"
below

l "Configuring the Integration of PPM Center Tasks with HP ALM Releases" on page 165

Enhancements Implemented to the Integration of PPM
Center Tasks with HP ALM Releases

Version 9.22 implemented the following enhancements to the integration between PPMCenter
tasks and HP ALM releases:

l "Options for Specifying AdvancedMapping Criteria" below, allowing you to filter and control
what specific data to retrieve from HP ALM for amapped HP ALM release.

l "A Centralized Preferences Editor" on page 161, gathering all editable preferences options for
the quality charts into one place, including newly introduced preferences options.

l "Switching Views to Display Data in Days, Weeks, Months, or Quarters" on page 164

Options for Specifying Advanced Mapping Criteria

In some cases, an ALM release would cover the quality information for multiple sub projects in PPM
Center. For example, theremight be several teams focusing on different tracks of a release. The
project manager would need to see the quality KPIs for each of these teams.
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In version 9.22, whenmapping a task to an HP ALM release on theQuality tab of the Task Details
page, project managers can see the advancedmapping criteria section in step 3 as illustrated in the
screenshot below .

These advancedmapping criteria allow project managers to specify some filters or conditions to
map the task to a sub set of the ALM release. This enhancement enables project managers to
monitor the quality KPIs of part of the linked ALM release.

This advancedmapping criteria section contains the following two options:

l Add criteria to filter the defect data from ALM

l Add Criteria to filter the requirement data from ALM

When adding a filter for defect or requirement, the following HP ALM REST API is called to retrieve
available values for a specified ALM Criteria value:

http://{ALM_URL}/qcbin/rest/domains/{domain}/projects/{project}/customization/us
ed-lists

To add a new entry of mapping criteria,

1. Click a desired option.

For example, click Add criteria to filter the defect data from ALM.

TheSet Defect Filter section appears on top of theAdd criteria to filter the defect data
from ALM link.
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2. From theALM Criteria drop-down list, select a desired value from the available values, and
then click the selector icon for theCriteria Value.

A window pops up and displays available values retrieved by the HP ALM REST API from
defect fields of Lookup List field type in HP ALM.

Note: If you are setting a requirement filter, clicking the selector icon for theCriteria
Value calls the HP ALM REST API to retrieve available values from the requirement fields
of Lookup List field type in HP ALM.

3. Select values as needed.

4. Click OK.

5. Repeat step 1 through step 4 to add as many advancedmapping criteria entries as you need.

For example, the following screenshot shows that three entries of mapping criteria are added.
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6. To remove amapping criteria, simply click the Delete icon for themapping criteria.

7. Click Confirmed.

The Confirmation page displays all mapping criteria you have specified so far.

8. In theSave Mapping Criteria as field, type a name for your mapping criteria.

This allows you to provide a customized name for themapping criteria you just specified.
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If you leave the field as is, themapping criteria name is saved in the format of <Project_
Name>+<Release_Name> by default . In this example, themapping criteria is to be saved as
PROJECT01 Release01.

9. Click Done.

Themapping configuration is completed. The integration service runs and theQuality tab page
displays quality charts.

A Centralized Preferences Editor

The centralized preferences editor is accessible by clicking theEdit Preferences link in the top
right corner of theQuality tab page (as illustrated in the screenshot above). TheEdit Preferences
link is available on the page after you have linked the task to an ALM release.

The Preferences Editor allows project managers to set general settings and preferences options for
each quality chart easily and centrally from one place, enabling them to further fine tune the display
of data retrieved from HP ALM.

This enhancement offers additional flexibility for project managers in monitoring quality data while
ensuring quality compliance. Each organizationmay have their own quality terms and standards,
and these terms may have been customized in their ALM. Project managers can use the
Preferences Editor to specify their own quality settings based on the quality terms synchronized
from ALM to comply with the company standards.
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After changing the chart preferences, the changes take effect starting from the current day. That is
to say, starting from the current day, the new quality data imported from ALM is customized and
displayed based on the new chart preferences. For the data before the current day but within the
display time frame, it is still displayed using the original settings.

The preferences options you set in the Preferences Editor take precedence over the default settings
included in the <PPM_Home>\conf\hpALMKPI.conf file. For more information about the
hpALMKPI.conf file, see "Changes Made to the hpALMKPI.conf File" on page 168

There are four tabs in the Preferences Editor:

l General Settings

On theGeneral Settings tab, you can,

n Specify data display range in days, weeks, months, or quarters.

n Configure scorecard link by following the on-screen instructions.

Note: In version 9.21, you configure scorecard link on the Quality tab of the Task Details
page for a task.

l Open Defects Trend
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On theOpen Defects Trend tab, you can select values you want to display as part of theOpen
Defects bar in theOpen Defects Trend chart.

The values that are not selected will be displayed as a part of theClosed Defects bar.

l Priority Defects Trend

On thePriority Defects Trend tab, you can select severity values you want to display as part of
theHigh Priority Defects bar in the Priority Defects Trend chart.

The severity values that are not selected will be displayed as a part of the Low Priority Defects
bar in thePriority Defects Trend chart.
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l Requirements Trend

On theRequirements Trend tab, you can set values for covered requirements, passed
requirements, and reviewed requirements.

Switching Views to Display Data in Days, Weeks, Months, or
Quarters

Starting from version 9.22, you can switch views to display data in days, weeks, months, and
quarters by clicking the corresponding option available in the top right corner of theQuality tab of
the Project Overview page (as illustrated below).
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Configuring the Integration of PPM Center Tasks with HP
ALM Releases

This section includes the following:

l "Overview of the HP ALM Integration Plug-in for PPM Version 1.1 " below

l "Support Matrix" on the next page

l "Supported Upgrade Paths" on the next page

l "Downloading and Installing the HP ALM Integration Plug-in for PPM Version 1.1" on page 167

l "Changes Made to the hpALMKPI.conf File" on page 168

Overview of the HP ALM Integration Plug-in for PPM Version 1.1

The HP ALM Integration Plug-in for PPM version 1.1 is required before you start to use the
enhanced integration solution.
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For existing users of the integration solution who are on PPMCenter version 9.21, after upgrading
PPMCenter to version, 9.22, they can download and install HP PPM Plug-in for ALM Integration
version 1.1 directly.

Version 1.1 of the plug-in contains all content of version 1.0, therefore, for fresh users of the
integration solution who performed fresh installation of PPM Center version 9.22 or upgraded from
PPMCenter version 9.20 or 9.21, they can download and install the HP ALM Integration Plug-in for
PPM version 1.1 directly to have all the features available. There is no need to install version 1.0
plug-in.

For more information about the supported upgrade paths, see "Supported Upgrade Paths" below.

Support Matrix

The following table describes support matrix of the HP ALM Integration Plug-in for PPM:

HP ALM Integration Plug-in for PPM
version

PPM Center version

1.0 9.21

1.1 9.21, 9.22

Supported Upgrade Paths

The following upgrade paths are supported for the HP ALM Integration Plug-in for PPM:

l For fresh users of the plug-in,

n If you are on PPMCenter version 9.22, simply download and install version 1.1 plug-in
directly.

For detailed instructions, see "Downloading and Installing the HP ALM Integration Plug-in for
PPM Version 1.1" on the next page.

n If you are on PPMCenter version 9.20 or 9.21, and you wish to use this integration solution,

i. Upgrade PPMCenter from version 9.20 or 9.21 to version 9.22 directly.

For detailed instructions, see "Installation Notes" on page 3.

ii. Download and install the HP ALM Integration Plug-in for PPM version 1.1.
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For detailed instructions, see "Downloading and Installing the HP ALM Integration Plug-
in for PPM Version 1.1" below.

l For existing users who are on PPMCenter version 9.21 with version 1.0 of the plug-in, follow
one of the following upgrade paths:

n If you wish to upgrade the plug-in only, you can just upgrade it from version 1.0 to version 1.1.

For detailed instructions, see "Downloading and Installing the HP ALM Integration Plug-in for
PPM Version 1.1" below.

n If you plan to upgrade both PPM Center and the plug-in, you can follow either of the following,

o Upgrade the plug-in to version 1.1, then upgrade PPMCenter to version 9.22.

Caution: Make sure you clear the following folders before you start the upgraded
PPMCenter instance:

o <PPM_Home>/tmp

o <PPM_Home>/work

o Upgrade PPMCenter to version 9.22, then upgrade the plug-in to version 1.1.

If deploy VPQ1.1 bundle before deploy ppm SP2 bundle, it shall be clean tmp/ & work/ before
start instance.

Downloading and Installing the HP ALM Integration Plug-in for PPM
Version 1.1

To download and install the HP ALM Integration Plug-in for PPM version 1.1:

1. Obtain the plug-in bundles from the HP Live Network.

a. Go to the PPMCommunity on HP Live Network.

b. On the PPMCommunity home page, click Content Catalog.

c. Click HP ALM Integration Plug-in for PPM (where HP is the provider).

d. Click Downloads.
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The HP ALM Integration Plug-in for PPM - Downloads page opens.

e. Click theALM Integration Plug-in for PPM 1.1 folder.

f. Click ppm-921-ALMPlugin.zip to download the package.

This package contains the following two bundles:

Bundle name Description

ppm-921-
PluginQuality.jar

Contains the plug-in basic structure for integrating PPM
Center with ALM releasemanagement tools.

ppm-921-
PluginQualityVPQ.jar

Contains the plug-in files specifically for integrating PPM
tasks with the ALM Releases module.

2. Stop PPM Server.

3. Unzip the package and copy the two bundles to the <PPM_Home> directory.

4. Deploy the bundles by running the following commands from the <PPM_Home>/bin directory.

sh ./kDeploy.sh -i PluginQuality

sh ./kDeploy.sh -i PluginQualityVPQ

5. Repeat step 3 and step 4 for each of the server nodes in your cluster.

6. Restart PPM Server.

Note:HP recommends you restart the PPM Server to make sure that the integration
bundles are properly deployed before you continue to deploy bundles for another
integration solution.

Changes Made to the hpALMKPI.conf File

When you deploy the HP ALM Integration Plug-in for PPM version 1.1 as a fresh user of the
integration solution, the new hpALMKPI.conf file replaces the existing one on your instance.

When you upgrade the HP ALM Integration Plug-in for PPM to version 1.1,

Release Notes
Chapter 5: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.22

Page 168 of 310HP Project and Portfolio Management Center (9.22)



l If the existing hpALMKPI.conf on your instance has been changed, no changes will bemade and
the file will be left untouched.

l If existing hpALMKPI.conf has not been changed by users, it will be upgraded to the latest
version.

The upgrade process will update the project_json field of the PPM_INT_QUALITY_TASK_
MAPPING, to append the default chart preference set.

In version 9.22, the following change is made to the hpALMKPI.conf file:

The line "requirement.notCovered=Not Covered" is changed to "requirement.Covered=XXX"

This means that in the old hpALMKPI.conf, "Not Covered" is defined, and in the new
hpALMKPI.conf, "Covered" is defined.

If the total statuses of the old "Not Covered" and the new "Covered" are less than the available
statuses in HP ALM, it might result in wrong data display in charts.

Tip:You can log in to HP ALM and find valid values for [Status] of requirement, then
configure them in requirement.Covered=XXX.

If there aremore than 5 default statuses (Blocked, Failed, No Run, Not Completed, Passed) in
your ALM, make sure you back up the existing version of the hpALMKPI.conf file and update the
definition of "Covered" in the file manually by replacing XXXwith your values, with comma (,) as the
delimiter.

For example, if the covered statuses of requirement include Not Completed and Passed, then,

requirement.Covered=Not Completed,Passed

Enhancements to the Integration between PPM Center
and ALM (Using ALM)

The following enhancements are implemented to the integration between PPMCenter and ALM
(using ALM):

l "Disabling Status Synchronization and Enabling Status Field Mapping for the Integration
between PPMCenter and ALM (Using ALM)" on the next page

l "SynchronizingMemo Fields from HP ALM Defects or Requirements as HTMLReference
Attachments to PPM Requests" on page 172
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Disabling Status Synchronization and Enabling Status
Field Mapping for the Integration between PPM Center
and ALM (Using ALM)

Starting from version 9.22, you can disable the PPMCenter defect workflow driven synchronization
between PPM request status and ALM entity status by setting the new server configuration
parameter REQUEST_LINK_ALM_ENTITY_STATUS to false from the Administration Console. As a
result, theStatus field is available in theQC/ALM Entity Fields list in PPM Center for defect
status mapping purpose, allowing you to view the real time status of an ALM entity in PPM Center.

This enhancement applies to PPM Center integration with HP ALM version 11.00 or later.

However, note that disabling the PPMCenter defect workflow driven status synchronizationmeans
that PPM defect request status is no longer synchronized to ALM. Therefore, the status field
mapping is controlled by PPM by default.

Parameter Name Description, Usage Default and
Valid Values

REQUEST_LINK_ALM_
ENTITY_STATUS

Setting the parameter value to false disables
the PPMCenter defect workflow driven
synchronization between PPMCenter request
status and ALM entity status. The default value
is true.

Default value:
true

Valid values:
true, false

Newly introduced server configuration parameter

To disable status synchronization and configure theStatus field mapping for a selected integration
configuration,

1. Set the REQUEST_LINK_ALM_ENTITY_STATUS to false from the Administration Console.

a. Log on to PPM Center.

b. From theOpenmenu, click Administration > Open Administration Console.

c. In the navigation pane, expandAdministration Task > Application Configuration.

d. In the Edit PPM Application Parameters pane, search for the REQUEST_LINK_ALM_ENTITY_
STATUS parameter.

e. Edit theValue for the parameter to false and click Save.
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2. Configure theStatus field mapping for a selected integration configuration.

a. From theOpenmenu, click Administration > Integrations.

b. On theManage Application Change page, from the Integration Configurations list, select
an entry that you want to configure theStatus field mapping for which.

c. In the Server Configuration Details section, move toStep 2: Map PPM-QC/ALM Fields
tab page.

TheStatus field is now available in the drop-down list of QC/ALM Entity Fields in the
Field Mapping section.

d. Select Status from theQC/ALM Entity Fields, and then select Request Status from the
PPM Request Fields list, and then click Map Fields.

The field mapping is added to the Current Field Mappings table.
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e. Save the change to this integration configuration.

Synchronizing Memo Fields from HP ALM Defects or
Requirements as HTML Reference Attachments to PPM
Requests

Starting from version 9.22, for any new defect or requirement that is created in HP ALM version
11.00 (or later), each of thememo fields (that aremapped to PPM request text fields on theManage
Application Change integration landing page in PPM Center) in the defect or requirement will be
saved as an html reference attachment to the PPM request after you perform ALM to PPM
synchronization. You can find all html attachments in the References section of a PPM request.

The HTML file name follows this format: <ALM_Entity_Field_Name>.html, and in the description
of the html file, a label in the format of "The content of memo field '<Lable Name>' in ALM/QC
entity". For example, description.html.
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If a memo field is changed or updated in HP ALM, the html attachment file to PPM request is
updated after next synchronization.

This enhancement ensures that a full version of the content from each of the ALM defect or
requirement memo fields is available for users to view when the corresponding PPM request text
fields contain confusing html tags after synchronization. This is especially helpful when ALM defect
or requirement memo fields contain 4000+ bytes, because no text will be truncated in the html
attachment files after synchronization. All content of memo fields will be synchronized as HTML
attachments, and any update from ALM entities will also update the PPM request attachment files
after next synchronization.

For existing PPM requests that contain 4000+ bytes in any of themapped text fields, after you
upgrade PPMCenter to version 9.22, when you perform ALM to PPM synchronization, the system
compares the content contained in the PPM request text field against the first 4000 bytes of the
content in the ALMmemo field (stored in ALM database) to see if any update has beenmade. If
yes, an html reference attachment file will be generated for each of the ALM defect or requirement
memo fields and synchronized to the PPM request; otherwise no html attachment file will be
generated.

Note that the content in mapped PPM request text fields remain the same after you ugrade PPM
Center to version 9.22.
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Certifications
The following certifications are included in PPM Center version 9.22:

l Support for CA SiteMinder 12

For instructions about integrating PPM Center with CA SiteMinder, see the Installation and
Administration Guide. However, note the following differences for CA SiteMinder 12:

n In the "Requirements for Integrating with SiteMinder" section (page 243),

o CA SiteMinder version 6.0 or 12.0 (for both SSO andmixedmodes) is installed and
functioning correctly

n In the "Configuring PPM Center for Integration with SiteMinder" section,

o Step b of Step 2, add "(Mixedmode only)" as well as the following note (page 244):

Note:SiteMinder native dll files are available in both 32-bit and 64-bit versions. PPM
Center requires that the version of SiteMinder native dll files be consistent with the
version of JDK software installed on PPMCenter, otherwise PPMCenter may fail
loading these local native code. For example, if you use 32-bit JDK software, make
sure you use 32-bit version of SiteMinder native dll files as well.

l PPMCenter version 9.22 is certified on HP Cloud Services for the CentOS 6 Server (64-bit)
operating system.

This is the only operating system PPMCenter version 9.22 is certified for when running a PPM
server in the HP Cloud Services environment.

l Support for Microsoft® Windows® 8 Enterprise Edition (both 32- and 64-bit) as PPM Center
client platform

l Support for Internet Explorer 10 (compatible modeONLY) on the following PPMCenter client
platforms:

n Microsoft® Windows® 7 Enterprise Edition (both 32-bit and 64-bit)

n Microsoft® Windows® 8 Enterprise Edition (both 32-bit and 64-bit)

l Support for HP ElitePad as PPMCenter client device
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l ServiceManager version 9.32 support for PPM Center integrations with ServiceManager

l Universal CMDB version 10.x support for PPM Center integrations with Universal CMDB

l HP Application Lifecycle Management version 11.52 support for PPM Center integrations with
HP Application Lifecycle Management

l Included Swedish in MLU support

For details about deploying the Swedish language pack, see the updated Language Pack
Release Notes for PPM Center 9.22 (dated January 2014).

For details, see theSystem Requirements and Compatibility Matrix.
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Fixes
The following fixes are included in PPM Center version 9.22:

Accelerators

Tracking Number Problem Description

4644124871 Error when trying to open theOracle Apps Environments in PPM
Workbench after upgrading PPMCenter to version 9.14.0005.
(QCCR1L51214)

Costing

Tracking Number Problem Description

4639559022 In Financial Summary one of the user data fields is configured to be
a drop-down list and some of the values contain an "&" sign. When
creating a new line and selecting such a value, it shows "&amp;"
instead of "&" . (QCCR1L46819)

4644806198 Unable to execute JDBC batch update when running
kGenFiscalPeriods.sh. (QCCR1L 51307)

4644893295 Error when usingWeb Services to update benefit line user data field
that has amulti-select validation. (QCCR1L51612)

Dashboard

Tracking Number Problem Description

4642117882 Some elements in the header are still displayed in French after the
French language pack is disabled. (QCCR1L51236)

4645629745

4645284386

Unknown error when trying to export a portlet to Excel.
(QCCR1L51919)

4645396654 Error when opening the dashboard with many modules present.
(QCCR1L52457)
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Documentation

Tracking Number Problem Description

4644297403 The parameter WEB_CACHE_DIRwas not documented.
(QCCR1L50667)

Solution: Add the description of the parameter WEB_CACHE_DIR in
Installation and Administration Guide.

For detailed information of this parameter, see "TheWEB_CACHE_
DIR parameter was not documented" on page 272.

4644430992 Performance issue whenOracle DB parameter optimizer_mode is
not set to ALL_ROWS. (QCCR1L50935)

Solution: Add the description of the Oracle database parameter
optimizer_mode in Installation and Administration Guide.

For detailed description of this parameter, see "Oracle database
parameter optimizer_mode not documented" on page 274.

4644611067 Question on cost rule precedence for "task planned cost".
(QCCR1L51266)

Solution: Add the description about the cost factor "role" that
applies to the entity "task planned cost" inHP Financial
Management User’s Guide.

For detailed information, see "Insufficient description about the cost
factor "role" that applies to the entity "task planned cost"" on page
269.

4645226336 Issue with the token REQUEST_SUB_TYPE_ID. (QCCR1L51901)

Solution: Correct the name of the token REQUEST_SUB_TYPE_ID
into REQUEST_SUBTYPE_ID inCommands, Tokens, and Validations
Guide and Reference.

For more information, see "Incorrect name of the REQUEST_SUB_
TYPE_ID token" on page 267.
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Tracking Number Problem Description

N/A Password issue when using Private Key Authentication with Secure
Shell with RSA keys. (QCCR1L52093)

Solution: Clarify the confusing requirement about password when
using Private Key Authentication with Secure Shell with RSA key in
Installation and Administration Guide.

For detailed explanation of password requirement, see "Confusing
requirement about password when using Private Key Authentication
with Secure Shell with RSA keys" on page 272.

4645635516 Legend of work plan Gantt view is not documented.
(QCCR1L52266)

Solution: Add the description about the Gantt legend of a work plan
inHP Project Management User’s Guide.

For detailed information, see "Legend of work plan Gantt view not
documented" on page 279.

N/A Improper Oracle database settings are recommended.
(QCCR1L52311)

Solution: Correct the improper settings for Oracle database
properties in Language Pack Release Notes.

For information about the proper settings, see "Improper Oracle
database settings recommended" on page 276.

4645866300 The description for the parameter WF_DISABLE_DELEGATE_
DECISION_STEP is not documented. (QCCR1L52549)

Solution: Add the description for the parameter WF_DISABLE_
DELEGATE_DECISION_STEP in Installation and Administration Guide.

For detailed information of this parameter, see "Missing description
for theWF_DISABLE_DELEGATE_DECISION_STEP parameter"
on page 275.
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Tracking Number Problem Description

N/A "Task 17: Prepare a Back Out Plan" should be amandatory task.
(QCCR1L52588)

Solution: Modify the content for this task inUpgradeGuide.

For themodified content of this task, see "Task 17 (Prepare a Back
Out Plan) shall be amandatory task" on page 283.

N/A Insufficient information about <Op_Reports_Home> folder.
(QCCR1L52739)

Solution: Add the description of this folder inOperational Reporting
Administrator’s Guide.

For detailed description, see "Insufficient information about <Op_
Reports_Home> folder" on page 278.

4646255335 The parameter MAX_STATEMENT_CACHE_SIZE is out of date.
(QCCR1L52900).

Solution: Remove the description about this parameter from the
Installation and Administration Guide, because this parameter is not
used any more since PPMCenter version 6.0.

N/A The value suggested for the parameter SS_INDEX_LOCATION is
incorrect.

Solution: Correct the suggested value for the parameter in
Operational Reporting Administrator’s Guide.

For the correct value, see "Incorrect Value Suggested for SS_
INDEX_LOCATION" on page 278

4646005111 OOTB workflow ALM - Request For Change (RFC) cannot be
integrated with ALM 11.x directly, it should be changed before
integration. (QCCR1L52883)

Solution:Create a documentation to describe detailed steps for
integrating this workflow with ALM 11.x. For detailed
documentation, see "Setting Up Integration Between PPMCenter
9.2x and HP ALM 11.52 from Scratch" on page 291.
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Tracking Number Problem Description

4645413698 Users request to add documentation on ksc_get commands related
to QC/ALM. (QCCR1L52112)

Solution: Add documentation on ksc_get special commands. See
"Missing documentation on ksc_get commands related to QC/ALM"
on page 283.

HP Demand Management

Tracking Number Problem Description

4642926781 Table Component issue after upgrading PPMCenter to 9.14.0003.
(QCCR1L49389)

4644575713 Unable to create a project from a proposal that has multiple project
managers in the Project Manager field. (QCCR1L51323)

4644421341 Error on the details page of a request type that is in a particular
request status. (QCCR1L51406)

4645179718 Request Type rules do not work if a non-editable drop-down field is
set to blank. (QCCR1L51759)

4645148015 Security Groups that do not have Submit Reports access are still
displayed in Allowed Security Groups when the option "Always
restrict new Security Groups" is checked. (QCCR1L51986)

4645534132 Issue with Export to Excel of a Text Area field when exporting
results of Request Advanced Search. (QCCR1L52155)

4645885318 Error when using a drop-down list validation for a customized field
on Project Details page. (QCCR1L52576)

4645660755 Web Services error when anOn Page Load is used.
(QCCR1L52658)

4645549751 Sorting issue with Sub-workflows inWorkflow Step Sources menu
in PPMWorkbench. (QCCR1L52676)
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HP Deployment Management

Tracking Number Problem Description

4639164795 Error sometimes appears in the logs whenmigrating request types.
(QCCR1L46572)

Integrations

Tracking Number Problem Description

N/A String format error duringMSP upload. (QCCR1L51603)

4645684084 Recompiling JSP files fails with an error. (QCCR1L52396)

Platform

Tracking Number Problem Description

4638721774

4643892194

Accessing users or security groups in PPMWorkbench is slow in
PPMWorkbench. (QCCR1L50227)

4643508536 User data are displayed differently depending on user location.
(QCCR1L50700)

4643941091 Issue with clustered environment after upgrading PPMCenter to
version 9.14. (QCCR1L50809)

4644570538 PPMCenter outages several times a day with error after migration
to version 9.20. (QCCR1L51097)

4644648592 Decimal values are not allowed when setting cookies expiration
date. (QCCR1L51392)

4644249880 Error when creating requests fromWeb Services. (QCCR1L51489)

4645010165 Password is displayed in the URLwhen login fails after upgrading
PPMCenter to version 9.14. (QCCR1L51505)

4644881633 Issue with cross-site scripting. (QCCR1L51605)
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Tracking Number Problem Description

4644875112 After upgrading PPMCenter from version 9.14 to version 9.20, the
environment check for Telnet fails when connecting to aMicrosoft
telnet server. (QCCR1L51668)

4644495796 Scheduled Start Date and Scheduled Finish Date are not displayed
as per locale setting in Project Cost Details report. (QCCR1L51810)

4644953804 Heap dumps caused by Out of Memory. (QCCR1L51863)

4644249880 Error when trying to create requests viaWeb Services.
(QCCR1L52429)

4644986531 Performance issue with the Project Overview page and the
dashboard. (QCCR1L52637)

4645829888 Changes in the KNTA_I18N_Resources table and the resources
files are not reflected on User Interface. (QCCR1L52660)

HP Program Management

Tracking Number Problem Description

4644592933 When you export the Program Overview page to Excel, the Excel
files do not display the Approved Budget field. (QCCR1L51007)

HP Project Management

Tracking Number Problem Description

4638771066 My Task portlet is not sorting tasks by start or finish date correctly.
(QCCR1L46151)

4643110419 Error when clickingApprove on a Project Details page.
(QCCR1L49612)

3605375245 Themessage “Percent Complete Cannot be 0 when actual
Effort>0" is displayed when actual effort or scheduled effort is less
than 1%. (QCCR1L50257)

4644220980 The Search Projects page is blank after closing the project search
warningmessage. (QCCR1L50828)
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Tracking Number Problem Description

4644926509 Task user data is not populated with default value in version
9.14.0006. (QCCR1L51446)

4645101749 Project Details page does not fit to the window and does not show
horizontal scroll bar on IE browser. (QCCR1L51682)

4644977648 Inconsistent behavior of the project progress bar in PPM Center
version 9.20. (QCCR1L51723)

4644900789 Error when clicking workflow action buttons on Project Details
page. (QCCR1L51817)

4645118049 Creating projects from proposals by using special command ksc_
create_project fails. (QCCR1L51833)

4643764019 When a task in workplan is updated by clickingEdit > Set Status, it
is impossible to perform any action on workplan unless the status
update is completed. (QCCR1L51969)

4645646064 TheSave orDone button do not work when a Summary Task owner
saves an edited task. (QCCR1L52501)

HP Resource Management

Tracking Number Problem Description

4643228970 Actual Effort and Scheduled Effort are displayed in Analyze
Assignment Load portlet after you customize the portlet preference
to show Actual Effort only. (QCCR1L49484)

4643663763 Total assignments is calculated incorrectly when project's work
load is set to be calculated from workplan. (QCCR1L50193)

4644076391 Notification Cleanup Service does not cover the ppm_notification_
details table (QCCR1L51407)

4645130272 When a project is set to calculate workload from work plan tasks,
the allocation load of the project's staffing profile is incorrectly
calculated. (QCCR1L51777)

4644448634 When clickingSave after changing the region for an Org Unit, the
change is not saved. (QCCR1L52038)
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Tracking Number Problem Description

4644592768 Analyze Assignment Load portlet is not working correctly.
(QCCR1L52065)

4645549893 Unable to cancel a staffing profile when it is linked to a proposal that
is in "Cancelled" status. (QCCR1L52233)

4644823293 The value of the user data field that uses "Date" validation is
displayed incorrectly when the value is input manually instead of
using the date selector. (QCCR1L52301)

HP Time Management

Tracking Number Problem Description

4643624774 Blockingmessage pops up when exporting time sheets to Excel via
HTTPS after upgrading PPMCenter to version 9.14.0002.
(QCCR1L50117)

4645017651 Delegate's delegate could see the time sheets to approve, however,
error occurs when trying to approve the time sheets.
(QCCR1L51550)

4644769490 Unable to enter 95% in the%Complete field of a time sheet.
(QCCR1L52097)
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Chapter 6: Enhancement, Integrations,
Certifications, and Fixes in PPM Center 9.21

l "Enhancements"

l "Integrations"

l "Certifications"

l "Fixes"

Enhancements
The following enhancements are included in PPM Center version 9.21:

HP Project Management

l "TwoNew Checkboxes Added on the Project Settings Page" on the next page

Dashboard

l "Expand and Collapse Buttons Added back to Portlets on Private Dashboard Pages" on page
189

MLU Support

l "Improved Behavior of List Auto-Complete Fields in MLU" on page 190

HP Time Management

l "New Option for Copying Time Sheet: Include Charge Codes" on page 190

l "RESTful Web Services Available with the HP TimeManagement Module" on page 192

Integrations

l "Enhanced Agile Manager Integration Plug-in for PPM" on page 235
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Two New Checkboxes Added on the Project Settings
Page

The following checkboxes are added to the Financial Management section under the Cost and
Effort tab on the Project Settings page:

l TheAllow manual adjustment on the actual labor cost checkbox is added under the
Calculate the actual labor costs from the work plan and time sheets. (Note: Financial
Management for the work plan must be enabled.) checkbox.

l TheAllow manual adjustment on the actual non-labor cost checkbox is added under the
Calculate the actual non-labor costs from the work plan. (Note: Financial Management
for the work plan must be enabled.) checkbox.

Selecting theEnable Financial Management for work plan checkbox enables the two newly
added checkboxes and their parent ones.

Selecting the parent checkboxes of the two newly added ones enables the child checkboxes.

If you create new projects after upgraded to PPM Center version 9.21, refer to the following
scenarios to decide when you need to select these checkboxes:

l If you have the following checkboxes unselected,

Actual labor cost cannot be calculated from the work plan and time sheets, but you can edit the
actual labor cost in the cost lines you have added.

Release Notes
Chapter 6: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.21

Page 186 of 310HP Project and Portfolio Management Center (9.22)



l If you have the following checkbox selected,

Actual labor cost can be calculated from the work plan and time sheets, but you cannot edit the
actual labor cost in the cost lines you have added.

l If you have the following checkboxes selected,

Actual labor cost can be calculated from the work plan and time sheets, and you can edit the
actual labor cost in the cost lines you have added.

l If you have the following checkboxes unselected,

Actual non-labor cost cannot be calculated from the work plan, but you can edit the actual non-
labor cost in the cost lines you have added.

l If you have the following checkboxes selected,

Actual non-labor cost can be calculated from the work plan, but you cannot edit the actual non-
labor cost in the cost lines you have added.

In this case, neither actual labor cost nor actual non-labor cost in the cost lines you have added
can be edited.

Note: Error message window would pop up if you select the checkbox Calculate the
actual non-labor costs from the work plan. (Note: Financial Management for the
work plan must be enabled.)without selecting the checkbox Calculate the actual labor
costs from the work plan and time sheets. (Note: Financial Management for the
work plan must be enabled.).
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l If you have the following checkboxes selected,

Actual non-labor cost can be calculated from the work plan, and you can edit the actual non-labor
cost in the cost lines you have added.

In this case, you cannot edit the actual labor cost in the cost lines you have added.

l If you have the following checkboxes selected,

Actual labor cost can be calculated from the work plan and time sheets, actual non-labor cost
can be calculated from the work plan, and you can edit both actual labor cost and actual non-
labor cost in the cost lines you have added.

By default, the two new checkboxes and their parent checkboxes are not enabled. In this case,
actual labor cost and actual non-labor cost can only bemanually entered.

If you upgrade PPMCenter to version 9.21 from versions earlier than 9.14.0005 (including
9.14.0005), you should run an additional upgrade script batch_update_cost_edit.sql located in
the <PPM_Home>/bin directory, so that you can have the same behavior in project financial
summaries as you had before the upgrade. After running the script, the settings of these
checkboxes would be changed automatically as follows:

l If the parent checkboxes of the added checkboxes were not selected before the upgrade, the
two added checkboxes would not be selected neither after the upgrade.

l If the parent checkboxes of the added checkboxes were selected before the upgrade, the two
added checkboxes would also be selected after the upgrade.

l If only one of the parent checkboxes was selected before the upgrade, only its corresponding
child checkbox would be selected after the upgrade.

If you upgrade PPMCenter to version 9.21 from versions later than 9.14.0005, to avoid overriding
your previous settings, DONOT run the additional script batch_update_cost_edit.sql.
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Expand and Collapse Buttons Added back to Portlets on
Private Dashboard Pages

The expand and collapse buttons (+ and -) were removed from portlets by design in version 9.20. To
improve usability and user experience, the expand and collapse buttons are added back to portlets
on private Dashboard pages.

Note the following differences:

l When loading a private Dashboard page asynchronously, the portlet buttons (Help, Edit, and
Maximize) are displayed when the portlet is expanded:

They are not displayed when a portlet is collapsed:

l When loading a private Dashboard page synchronously, the portlet buttons are always
displayed, regardless of a portlet being expanded or collapsed.

Note:Starting from PPMCenter version 9.20, by default, dashboard pages are loaded
asynchronously. To change the loadingmode of dashboard pages, go to the Administration
Console and set the dashboard.Asynchronous-Loading-Enabled parameter value to false.
For details, see the Installation and Administration Guide for PPM Center version 9.20.
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Improved Behavior of List Auto-Complete Fields in MLU
Starting from PPMCenter version 9.21, custom drop-down fields and list auto-complete fields
behave the same in theMLU, as follows:

If a custom drop-down/auto-complete list has multiple values, then a drop-down/list auto-complete
field with an existing value is shown in your current session language, even if your session
language is different than the language in which the value was originally selected from the drop-
down/auto-complete list.

Example. A custom drop-down/auto-complete list with multiple values has been created for
requests. A user logged on to PPM Center in a German language session creates a request, and in
doing so, selects a value for the custom drop-down/auto-complete list. A different user logs on to
PPM Center in a Korean language session and opens the new request, which was defined in
German. The value in the drop-down/list auto-complete field is shown in Korean.

New Option for Copying Time Sheet: Include Charge
Codes

A new option Include Charge Codes is available on the Copying Time Sheet page.

Note: By default, this option is not selected.

In previous versions, when you create a time sheet by copying an existing time sheet, the charge
codes of the existing time sheet are not copied. In version 9.21, selecting this option enables you to
copy the charge codes of an existing time sheet into a new time sheet.

If you check this option to copy charge codes from an existing time sheet, they take precedence
over charge codes that are set in work allocations, time sheet policies, and override rules.
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If the charge codes of the existing time sheet are disabled, they are still copied into the new time
sheet.

The names of the charge codes in the newly copied time sheet will be automatically updated when
the names are changed.

Limitation
There are no validations required when charge codes are copied from existing time sheets. If, as an
administrator, you want to change access grants on the charge codes that have been used in the
existing time sheets, youmay have to inform users that they should not check this option when
they copy those time sheets.
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RESTful Web Services Available with the HP Time
Management Module

The following enhancements are included in HP TimeManagement RESTful Web services in
version 9.21:

l "Enhanced TimePeriod Data Type" below

l "Enhanced TimeSheetLine Data Type" on the next page

Enhanced TimePeriod Data Type
The TimePeriod data type is enhanced in version 9.21 by adding the following properties:

l perId

l nexId

The TimePeriod data type is enhanced as follows:

Property Type Description Required? Default
Value

id Long Time period ID (system-
generated unique identifier)

Yes N/A

preId Long Previous time period ID Yes N/A

nexId Long Next time period ID Yes N/A

type Int ID of the time period type:

1: Weekly
2: Bi-Weekly
3: Semi-Monthly
4: Monthly

Yes N/A

startDate XML
Gregorian
Calendar

Start date of the time period Yes N/A

endDate XML
Gregorian
Calendar

End date of the time period Yes N/A

Release Notes
Chapter 6: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.21

Page 192 of 310HP Project and Portfolio Management Center (9.22)



Updated XML Messages

As the TimePeriod data type is updated, the followings are updated accordingly:

l "Response body of the operation to get a time period" below

l "Response body of the operation to get time periods" below

Response body of the operation to get a time period

<ns2:period xmlns:ns2="http://www.hp.com/ppm/tm/">
<id>100096</id>
<preId>100095</preId>
<nexId>100097</nexId>
<sequence>16</sequence>
<type>3</type>
<startDate>2013-03-16T00:00:00.000-07:00</startDate>
<endDate>2013-03-31T23:59:59.000-07:00</endDate>

</ns2:period>

Response body of the operation to get time periods

<ns2:periods xmlns:ns2="http://www.hp.com/ppm/tm/">
<period>

<id>100096</id>
<preId>100095</preId>
<nexId>100097</nexId>
<sequence>16</sequence>
<type>3</type>
<startDate>2013-03-16T00:00:00.000-07:00</startDate>
<endDate>2013-03-31T23:59:59.000-07:00</endDate>

</period>
</ns2:periods>

Enhanced TimeSheetLine Data Type
The TimeSheetLine data type is enhanced by introducing the following two data types into the
TimeManagement module in version 9.21:

l "ChargeCodes ": This data type represents the detailed information about all the charge codes
of a time sheet line.

l "tslChargeCodes ": This data type represents the detailed information about a charge code of a
time sheet line.
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ChargeCodes

Property Type Description Required? Default
Value

updateChargeCodeFlag Boolean Indicate whether
or not charge
codes of a time
sheet need to be
updated.

No false

requireChargeCodeFlag Boolean Indicate whether
or not charge
codes of a time
sheet are required.

No false

tslChargeCodes TSLChargeCode Charge code
information of a
time sheet line

No N/A

tslChargeCodes

Property Type Description Required? Default
Value

chargePercent float The charge code value Yes 0

id String The charge code ID Yes N/A

name String The charge code name No N/A

description String The charge code
description

No N/A

enabled Boolean Indicate whether or not
the charge code is
enabled.

No N/A

chargeCodeCategory String The charge code
category

No N/A

departmentCode String The charge code
department

No N/A
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clientCode String The client code of the
charge code

No N/A

As a result, the TimeSheetLine data type is enhanced as follows:

Property Type Description Required? Default
Value

id Long ID of the time
sheet line

Yes N/A

workItemId String ID of the work
item

Yes N/A

workItemType String Type of the
work item

Yes N/A

workItemName String Name of the
work item

No N/A

workItemDescription String Description of
the work item

No N/A

status Int Status of the
time sheet line

No N/A

approver List<Approver> Approvers of
the time sheet
line

No N/A

actuals List<Actual> Actuals of time
sheet lines

No N/A

workUnit WorkUnit Work unit of the
time sheet

No N/A

chargeCodes ChargeCodes Charge codes
of the time
sheet line

No N/A

workItemSetId String SetId of the
work item

Yes N/A

notes List<Note> Notes of time
sheet lines

No N/A
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Updated XML Messages

The followings are updated accordingly by the enhanced TimeSheetLine data type:

l "Request body of the operation to create a time sheet " below

l "Request body of the operation to update a time sheet " on page 200

l "Response body of the operation to get a time sheet line " on page 203

l "Response body of the operation to get time sheet lines " on page 206

Request body of the operation to create a time sheet

<TimeSheet>
<periodId>100099</periodId>
<resourceId>1</resourceId>
<sequence>1</sequence>
<status>1</status>
<description>User, Admin - 13-5-1 - 13-5-15 - sample for document
</description>
<policies>

<policy>
<name>AllowMultipleTimeSheets</name>
<value>true</value>

</policy>
<policy>

<name>MaximumHoursPerDay</name>
<value />

</policy>
<policy>

<name>BucketShowLevel</name>
<value>DAY</value>

</policy>
<policy>

<name>BucketReportMethod</name>
<value>HOURS</value>

</policy>
<policy>

<name>HoursInPeriodType</name>
<value>WORKDAY</value>

</policy>
<policy>

<name>HoursInPeriod</name>
<value>0.0</value>

</policy>
<policy>

<name>NotifyDelinquentTimeSheet</name>
<value>false</value>
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</policy>
<policy>

<name>MaximumHoursPerDay</name>
<value />

</policy>
<policy>

<name>MaximumHoursPerTimeSheet</name>
<value />

</policy>
<policy>

<name>MinimumHoursPerTimeSheet</name>
<value />

</policy>
<policy>

<name>MaximumPercentPerTimeSheet</name>
<value />

</policy>
<policy>

<name>MinimumPercentPerTimeSheet</name>
<value />

</policy>
<policy>

<name>EnforcementLevelError</name>
<value>false</value>

</policy>
<policy>

<name>PeriodHoursCalcTypeCode</name>
<value />

</policy>
<policy>

<name>WorkdayHours</name>
<value />

</policy>
<policy>

<name>ReqActivitiesRequiredFlag</name>
<value>false</value>

</policy>
<policy>

<name>TskActivitiesRequiredFlag</name>
<value>false</value>

</policy>
<policy>

<name>PrjActivitiesRequiredFlag</name>
<value>false</value>

</policy>
<policy>

<name>PkgActivitiesRequiredFlag</name>
<value>false</value>

</policy>
<policy>

<name>MiscActivitiesRequiredFlag</name>
<value>false</value>
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</policy>
<policy>

<name>ReqWorkItemEnabledFlag</name>
<value>true</value>

</policy>
<policy>

<name>TskWorkItemEnabledFlag</name>
<value>true</value>

</policy>
<policy>

<name>PrjWorkItemEnabledFlag</name>
<value>true</value>

</policy>
<policy>

<name>PkgWorkItemEnabledFlag</name>
<value>true</value>

</policy>
<policy>

<name>MscWorkItemEnabledFlag</name>
<value>true</value>

</policy>
<policy>

<name>AllowEmptyLineFlag</name>
<value>1</value>

</policy>
</policies>
<notes>

<note>
<id>159842</id>
<description>document sample - time sheet notes sample for the document
</description>
<type>TS</type>

</note>
</notes>
<timeSheetLines>

<workItemId>3282935</workItemId>
<workItemType>PROJECT</workItemType>
<actuals>

<actual>
<activityId>30067</activityId>
<efforts>

<dayNum>10</dayNum>
<effort>4.0</effort>

</efforts>
<efforts>

<dayNum>15</dayNum>
<effort>6.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30076</activityId>
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<efforts>
<dayNum>7</dayNum>
<effort>10.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30131</activityId>
<activityType>added</activityType>

</actual>
<actualsType>activity</actualsType>

</actuals>
<chargeCodes>

<updateChargeCodeFlag>true</updateChargeCodeFlag>
<requireChargeCodeFlag>false</requireChargeCodeFlag>
<tslChargeCodes>
<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100002</id>
</chargeCode>

</tslChargeCodes>
<tslChargeCodes>

<chargePercent>10.0</chargePercent>
<chargeCode>

<id>100003</id>
</chargeCode>

</tslChargeCodes>
<tslChargeCodes>

<chargePercent>90.0</chargePercent>
<chargeCode>

<id>100001</id>
</chargeCode>

</tslChargeCodes>
</chargeCodes>
<workItemSetId>60000</workItemSetId>
<notes>

<note>
<id>159841</id>
<description>time sheet restful notes sample. it is used for sample only

- update12334</description>
<type>TSL</type>

</note>
</notes>

</timeSheetLines>
<timeSheetLines>

<workItemId>217037</workItemId>
<workItemType>TASK</workItemType>
<status>1</status>
<actuals>

<actual>
<efforts>

<dayNum>7</dayNum>

Release Notes
Chapter 6: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.21

Page 199 of 310HP Project and Portfolio Management Center (9.22)



<effort>9.0</effort>
</efforts>
<efforts>

<dayNum>10</dayNum>
<effort>7.0</effort>

</efforts>
<efforts>

<dayNum>15</dayNum>
<effort>8.0</effort>

</efforts>
</actual>
<actualsType>common</actualsType>

</actuals>
<workUnit>

<percentComplete>80</percentComplete>
</workUnit>
<chargeCodes>

<updateChargeCodeFlag>true</updateChargeCodeFlag>
<requireChargeCodeFlag>false</requireChargeCodeFlag>
<tslChargeCodes>

<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100002</id>
</chargeCode>

</tslChargeCodes>
<tslChargeCodes>

<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100003</id>
</chargeCode>

</tslChargeCodes>
<tslChargeCodes>

<chargePercent>100.0</chargePercent>
<chargeCode>

<id>100001</id>
</chargeCode>

</tslChargeCodes>
</chargeCodes>
<workItemSetId>31600</workItemSetId>
<notes />

</timeSheetLines>
</TimeSheet>

Request body of the operation to update a time sheet

<TimeSheet>
<id>447943</id>
<periodId>100099</periodId>
<resourceId>1</resourceId>
<sequence>1</sequence>
<status>1</status>
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<description>User, Admin - 13-5-1 - 13-5-15</description>
<notes>

<note>
<id>159842</id>
<description>updated time sheet note</description>
<type>TS</type>

</note>
<note>

<id>159842</id>
<description>add time sheet note</description>
<type>TS</type>

</note>
</notes>
<timeSheetLines>

<id>1467788</id>
<workItemId>3282935</workItemId>
<workItemType>PROJECT</workItemType>
<actuals>

<actual>
<activityId>30067</activityId>
<efforts>

<dayNum>10</dayNum>
<effort>20.0</effort>

</efforts>
<efforts>

<dayNum>15</dayNum>
<effort>6.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30076</activityId>
<efforts>

<dayNum>7</dayNum>
<effort>10.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30131</activityId>
<activityType>added</activityType>

</actual>
<actualsType>activity</actualsType>

</actuals>
<workUnit>

<id>171904</id>
<percentComplete>50.0</percentComplete>

</workUnit>
<chargeCodes>
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<updateChargeCodeFlag>true</updateChargeCodeFlag>
<requireChargeCodeFlag>false</requireChargeCodeFlag>
<tslChargeCodes>

<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100002</id>
</chargeCode>

</tslChargeCodes>
<tslChargeCodes>

<chargePercent>90.0</chargePercent>
<chargeCode>

<id>100003</id>
</chargeCode>

</tslChargeCodes>
</chargeCodes>
<workItemSetId>60000</workItemSetId>
<notes>

<note>
<id>159841</id>
<description>updated tsl notes</description>
<type>TSL</type>

</note>
<note>

<id>159841</id>
<description>add tsl notes</description>
<type>TSL</type>

</note>
</notes>

</timeSheetLines>
<timeSheetLines>

<id>1467791</id>
<workItemId>217037</workItemId>
<workItemType>TASK</workItemType>
<status>1</status>
<actuals>

<actual>
<efforts>

<dayNum>7</dayNum>
<effort>9.0</effort>

</efforts>
<efforts>

<dayNum>10</dayNum>
<effort>7.0</effort>

</efforts>
<efforts>

<dayNum>15</dayNum>
<effort>8.0</effort>

</efforts>
</actual>
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<actualsType>common</actualsType>
</actuals>
<workUnit>

<percentComplete>60</percentComplete>
</workUnit>
<chargeCodes>

<updateChargeCodeFlag>true</updateChargeCodeFlag>
<requireChargeCodeFlag>false</requireChargeCodeFlag>
<tslChargeCodes>

<chargePercent>80.0</chargePercent>
<chargeCode>

<id>100002</id>
</chargeCode>

</tslChargeCodes>
<tslChargeCodes>

<chargePercent>20.0</chargePercent>
<chargeCode>

<id>100001</id>
</chargeCode>

</tslChargeCodes>
</chargeCodes>
<workItemSetId>31600</workItemSetId>
<notes />

</timeSheetLines>
</TimeSheet>

Note: Updating a time sheet does not update its notes and the notes of the time sheet lines.

Response body of the operation to get a time sheet line

<ns2:timeSheetLine xmlns:ns2="http://www.hp.com/ppm/tm/">
<id>1468301</id>
<workItemId>3282935</workItemId>
<workItemType>PROJECT</workItemType>
<workItemName>MS Mail Strategy</workItemName>
<workItemDescription>MS Mail Strategy</workItemDescription>
<status>1</status>
<approver>

<id>33877</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31448</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31476</id>
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<type>UsersTimeApprover</type>
</approver>
<approver>

<id>31446</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31702</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>103632</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31777</id>
<type>UsersTimeApprover</type>

</approver>
<actuals>

<actual>
<activityId>30067</activityId>
<activityName>Execute - Benefits Realisation</activityName>
<efforts>

<dayNum>10</dayNum>
<effort>4.0</effort>

</efforts>
<efforts>

<dayNum>15</dayNum>
<effort>6.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30076</activityId>
<activityName>Execute - Performance Management</activityName>
<efforts>

<dayNum>7</dayNum>
<effort>10.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30131</activityId>
<activityName>914 upgrade act1</activityName>
<activityType>added</activityType>

</actual>
<actualsType>activity</actualsType>

</actuals>
<workUnit>
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<id>171904</id>
<actualStart>1368514800000</actualStart>
<actualFinish>0</actualFinish>
<actualEffort>2508.0</actualEffort>
<percentComplete>50.0</percentComplete>
<estimatedFinish>0</estimatedFinish>
<effortModified>true</effortModified>

</workUnit>
<chargeCodes>

<updateChargeCodeFlag>true</updateChargeCodeFlag>
<requireChargeCodeFlag>false</requireChargeCodeFlag>
<tslChargeCodes>

<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100002</id>
<name>Fixed Price</name>
<description>Time for activities billed at Fixed Rate</description>
<enabled>true</enabled>
<chargeCodeCategory>BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>
<tslChargeCodes>

<chargePercent>10.0</chargePercent>
<chargeCode>

<id>100003</id>
<name>Non Billable</name>
<description>Non Billable Activity</description>
<enabled>true</enabled>
<chargeCodeCategory>NON_BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>
<tslChargeCodes>

<chargePercent>90.0</chargePercent>
<chargeCode>

<id>100001</id>
<name>Billable T&M</name>
<description>Time billed at T&M daily rate</description>
<enabled>true</enabled>
<chargeCodeCategory>BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>

</chargeCodes>
<workItemSetId>60000</workItemSetId>
<notes>

<note>
<id>159986</id>
<description>time sheet restful notes sample. it is used for sample only -

update12334</description>
<type>TSL</type>
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<createdBy>1</createdBy>
<createdDate>2013-04-25T00:09:26.000-07:00</createdDate>
<lastUpdatedBy>1</lastUpdatedBy>
<lastUpdatedDate>2013-04-25T00:09:26.000-07:00</lastUpdatedDate>

</note>
</notes>

</ns2:timeSheetLine>

Response body of the operation to get time sheet lines

<ns2:timeSheetLines xmlns:ns2="http://www.hp.com/ppm/tm/">
<timeSheetLine>
<id>1468301</id>
<workItemId>3282935</workItemId>
<workItemType>PROJECT</workItemType>
<workItemName>MS Mail Strategy</workItemName>
<workItemDescription>MS Mail Strategy</workItemDescription>
<status>1</status>
<approver>

<id>33877</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31448</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31476</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31446</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31702</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>103632</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31777</id>
<type>UsersTimeApprover</type>

</approver>
<actuals>

<actual>
<activityId>30067</activityId>
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<activityName>Execute - Benefits Realisation</activityName>
<efforts>

<dayNum>10</dayNum>
<effort>4.0</effort>

</efforts>
<efforts>

<dayNum>15</dayNum>
<effort>6.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30076</activityId>
<activityName>Execute - Performance Management</activityName>
<efforts>

<dayNum>7</dayNum>
<effort>10.0</effort>

</efforts>
<activityType>added</activityType>

</actual>
<actual>

<activityId>30131</activityId>
<activityName>914 upgrade act1</activityName>
<activityType>added</activityType>

</actual>
<actualsType>activity</actualsType>

</actuals>
<workUnit>

<id>171904</id>
<actualStart>1368514800000</actualStart>
<actualFinish>0</actualFinish>
<actualEffort>2508.0</actualEffort>
<percentComplete>50.0</percentComplete>
<estimatedFinish>0</estimatedFinish>
<effortModified>true</effortModified>

</workUnit>
<chargeCodes>

<updateChargeCodeFlag>true</updateChargeCodeFlag>
<requireChargeCodeFlag>false</requireChargeCodeFlag>
<tslChargeCodes>

<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100002</id>
<name>Fixed Price</name>
<description>Time for activities billed at Fixed Rate</description>
<enabled>true</enabled>
<chargeCodeCategory>BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>
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<tslChargeCodes>
<chargePercent>10.0</chargePercent>
<chargeCode>

<id>100003</id>
<name>Non Billable</name>
<description>Non Billable Activity</description>
<enabled>true</enabled>
<chargeCodeCategory>NON_BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>
<tslChargeCodes>

<chargePercent>90.0</chargePercent>
<chargeCode>

<id>100001</id>
<name>Billable T&M</name>
<description>Time billed at T&M daily rate</description>
<enabled>true</enabled>
<chargeCodeCategory>BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>

</chargeCodes>
<workItemSetId>60000</workItemSetId>
<notes>

<note>
<id>159986</id>
<description>time sheet restful notes sample. it is used for sample only -

update12334
</description>
<type>TSL</type>
<createdBy>1</createdBy>
<createdDate>2013-04-25T00:09:26.000-07:00</createdDate>
<lastUpdatedBy>1</lastUpdatedBy>
<lastUpdatedDate>2013-04-25T00:09:26.000-07:00</lastUpdatedDate>

</note>
</notes>

</timeSheetLine>
<timeSheetLine>
<id>1468302</id>
<workItemId>217037</workItemId>
<workItemType>TASK</workItemType>
<workItemName>IPS - Interest Rate Risk Management Processing System (R20)(D791)
</workItemName>
<workItemDescription>ESO PBS GMGI BB-Flexi Loan R20 > IPS - Interest Rate Risk Management P

rocessing System (R20) (D791)
</workItemDescription>
<status>1</status>
<approver>

<id>30772</id>
<type>UsersTimeApprover</type>
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</approver>
<approver>

<id>30968</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31791</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31476</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>31446</id>
<type>UsersTimeApprover</type>

</approver>
<approver>

<id>30897</id>
<type>UsersTimeApprover</type>

</approver>
<actuals>

<actual>
<efforts>

<dayNum>7</dayNum>
<effort>9.0</effort>

</efforts>
<efforts>

<dayNum>10</dayNum>
<effort>7.0</effort>

</efforts>
<efforts>

<dayNum>15</dayNum>
<effort>8.0</effort>

</efforts>
</actual>
<actualsType>common</actualsType>

</actuals>
<workUnit>

<id>172244</id>
<actualStart>1368514800000</actualStart>
<actualFinish>0</actualFinish>
<actualEffort>2482.8</actualEffort>
<percentComplete>80.0</percentComplete>
<estimatedFinish>0</estimatedFinish>
<effortModified>true</effortModified>

</workUnit>
<chargeCodes>

<updateChargeCodeFlag>true</updateChargeCodeFlag>
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<requireChargeCodeFlag>false</requireChargeCodeFlag>
<tslChargeCodes>

<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100002</id>
<name>Fixed Price</name>
<description>Time for activities billed at Fixed Rate</description>
<enabled>true</enabled>
<chargeCodeCategory>BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>
<tslChargeCodes>

<chargePercent>0.0</chargePercent>
<chargeCode>

<id>100003</id>
<name>Non Billable</name>
<description>Non Billable Activity</description>
<enabled>true</enabled>
<chargeCodeCategory>NON_BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>
<tslChargeCodes>

<chargePercent>100.0</chargePercent>
<chargeCode>

<id>100001</id>
<name>Billable T&M</name>
<description>Time billed at T&M daily rate</description>
<enabled>true</enabled>
<chargeCodeCategory>BILLABLE</chargeCodeCategory>

</chargeCode>
</tslChargeCodes>

</chargeCodes>
<workItemSetId>31600</workItemSetId>
<notes />

</timeSheetLine>
</ns2:timeSheetLines>
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Integrations
The following integration is included in PPM Center version 9.21:

l "Integrating PPM Center Tasks with HP ALM Releases"

l "Enhanced Agile Manager Integration Plug-in for PPM" on page 235

Integrating PPM Center Tasks with HP ALM Releases
"Introduction to Integrating PPM Center Tasks with HP ALM Releases" below

"Configuring the Integration of PPM Center Tasks with HP ALM Releases" on page 215

"Using the Integration of PPM Center Tasks with HP ALM Releases" on page 224

Introduction to Integrating PPM Center Tasks with
HP ALM Releases

The integration between PPMCenter tasks and HP ALM Releases implemented in version 9.21 is
an extension of the capability of the View Project Quality integration solution (integration between
PPMCenter projects and HP ALM). The integration extension enables project managers tomanage
multiple HP ALM releases with one PPMCenter project by integrating project tasks with HP ALM
releases.

The integration of PPM Center tasks with the Releases module of the HP Application Lifecycle
Management ( HP ALM) product allows project management officers, project
managers,development managers, andQA managers to have visibility into quality KPIs and ALM
scorecards of multiple ALM releases from PPMCenter projects by integrating PPM Center tasks
with HP ALM releases, and allows them to optimize themanagement of project quality by:

l Introducing and enforcing consistent workflows for all major application delivery processes.

l Initiating andmanaging both application and testing projects and ALM releases.

The integration allows project managers to link a task under a project to a specific releasemanaged
in HP ALM. Each PPMCenter task is associated with a single release in HP ALM throughout the
task life cycle. This is a one-way one-to-onemapping relationship. This association begins when a
project manager maps one task to a specific ALM release.

After themapping relationship is established, the project managers are able to view quality KPIs
and ALM scorecard report for a release retrieved from HP ALM. In addition, project managers can
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also view the overall release hierarchy information of a specific work package from within PPM
Center.

The following table describes data tables used in this integration solution:

Data table Description

PPM_INT_SOLUTIONS_NLS Stores the integration solution information

PPM_INT_CONFIGURATIONS Stores all ALM server information related to the integration
configurations

PPM_INT_QUALITY_TASK_
MAPPING

Stores mapping information about PPM Center tasks and
ALM releases

PPM_INT_QUALITY_
STATISTICS

Stores ALM quality statistics information

PPM_INT_EVENTS Stores error logs

When configuring the integration solution, consider the following:

l The integration solution supports one-onemapping between a PPM task to an ALM release only.

l This integration supports OOTB quality metrics only. Customizable reports andmetrics are not
supported yet.

l There is no cleanup service to clean all the outdated data in the KPIs table.

l You can not delete any existing ALM server configuration entries.

The table below summarizes some of the similarities that this integration solution shares with the
View Project Quality solution introduced in PPM Center version 9.20:

Similarities Differences

View Project Quality solution
(available with 9.20)

Integration of PPM Tasks with
ALM Releases (available with
9.21)

Both integrate with HP ALM
Releases module

Integrates at PPM Center project
level

Integrates at PPM Center
task level

Both support one-one
mapping relationship

Between a PPM project and an
HP ALM release

Between a PPM task and an
HP ALM release
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Similarities Differences

View Project Quality solution
(available with 9.20)

Integration of PPM Tasks with
ALM Releases (available with
9.21)

Both retrieve similar KPI
data and scorecard
information from ALM,
including:

l Priority Defects Trend

l OpenDefects Trend

l Requirements Trend

l Project Quality
Scorecard

l Displays data retrieved from
ALM in four portlets on the
Project Summary tab of the
Project Overview page

l Stores data retrieved from ALM
in the PPM_INT_QC_KPI table

l Displays data retrieved
from ALM in graphs on:
n TheQuality tab of

Project Overview
page;

n TheQuality tab of the
Task Details page

l Stores data retrieved from
ALM in the PPM_INT_
QUALITY_STATISTICS
table

Both uses background
synchronization services

Uses the QC Integration Sync KPI
Service

Uses the Project Quality
Sync Service

Both share the same View
Project Quality integration
configuration landing page

TheEnable User Access
Control option is removed
after deploying the
integration bundles.

These two integration solutions are independent of each other. You can still use the View Project
Quality solution after upgrading PPMCenter to version 9.21. However, HP recommends you use
the integration of PPM tasks with ALM Releases.

For information about the HP ALM versions supported for integration, see theSystem
Requirements and Compatibility Matrix.

Note: No software needs to be installed on the ALM server to integrate PPM Center and ALM.
However, see theSystem Requirements and Compatibility Matrix.

For more information about ALM, see its product documentation at the following website:

h20230.www2.hp.com/selfsolve/manuals

User Flow

The typical flow of this integration is as follows:
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Step 1: A PPM Center administrator configures the integration solution

Before project managers can use the integration, PPM Center administrator needs to configure the
integration solution, including:

l Identifying whether there is business needs for integrating PPM Center tasks with ALM releases

l Registering ALM instances

l Enabling and scheduling the Project Quality Sync Service

Step 2: A project manager initiates a project in PPM Center, and provides deliverables to
all the assigned teams.

Step 3:Based on the deliverables, business analysts, development managers, andQA managers
build milestones using Project Planning and Tracking (PPT) in ALM.

Step 4:A releasemanager creates a corresponding release in ALM and defines key performance
indicators (KPIs) for milestones and releases.

Step 5: The project manager updates the PPM Center project by linking its tasks to
corresponding ALM releases from the Task Details page.

For details about linking to an ALM release, see "Linking a PPM Task to an ALM Release" on page
224.

Step 6:ALM tracks release progress against specific milestones, with KPI matrices retrieved and
sent to PPM Center to be included in the overall project health status.

Step 7: Project managers and project participants view and monitor quality matrices on the
Quality tab of Project Overview page.

Formore information, see "Using the Integration of PPM Center Tasks with HP ALM Releases" on
page 224.
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Configuring the Integration of PPM Center Tasks with
HP ALM Releases

"Downloading and Installing the HP PPM Plug-in for ALM Integration" below

"Adding an ALM Integration Configuration" on page 218

"Enabling and Scheduling the Project Quality Sync Service" on page 220

"Configuring PPM Server for MLU Support" on page 220

"KPI Data Retrieved from ALM" on page 223

Downloading and Installing the HP PPM Plug-in for ALM Integration

To integrate PPM Center tasks with HP ALM releases, administrators must download and install
the free HP ALM Integration Plug-in for PPM. This is a one-time action.

Installation Instructions

To download and install the HP ALM Integration Plug-in for PPM:

1. Obtain the plug-in bundles from the HP Live Network.

a. Go to the PPMCommunity on HP Live Network.

b. On the PPMCommunity home page, click Content Catalog.

c. Click HP ALM Integration Plug-in for PPM (where HP is the provider).

d. Click Downloads.

The HP ALM Integration Plug-in for PPM - Downloads page opens.

e. Click theALM Integration Plug-in for PPM 1.0 folder.
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f. Click ppm-921-ALMPlugin.zip to download the package.

This package contains the following two bundles:

Bundle name Description

ppm-921-
PluginQuality.jar

Contains the plug-in basic structure for integrating PPM
Center with ALM releasemanagement tools.

ppm-921-
PluginQualityALM.jar

Contains the plug-in files specifically for integrating PPM
tasks with the ALM Releases module.

2. Stop PPM Server.

3. Unzip the package and copy the two bundles to the <PPM_Home> directory.

4. Deploy the bundles by running the following commands from the <PPM_Home>/bin directory.

sh ./kDeploy.sh -i PluginQuality

sh ./kDeploy.sh -i PluginQualityALM

5. Repeat step 3 and step 4 for each of the server nodes in your cluster.

6. Restart PPM Server.

Note:HP recommends you restart the PPM Server to make sure that the integration
bundles are properly deployed before you continue to deploy bundles for another
integration solution.

Entities Installed by the HP PPM Plug-in for ALM Release Integration

The following entities are installed:

l Quality tab added to the Task Details page

TheQuality tab on the Task Details page allows project managers to link the task to a specific
ALM release.

After themapping relationship is established, the tab displays the following quality graphs and
scorecard report retrieved from ALM for the linked release:
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n Priority Defects Trend:Displays trend of defects of higher severity in the last 10 days. The
higher severity defects include defects of priority S1 and S2.

n Open Defects Trend:Displays open defects trend in the last 10 days. The open defects
include open defects number and total defects number.

n Requirements Trend:Displays requirement status trend in the last 10 days. The
requirement status includes requirement coverage.

n Scorecard Report:Displays scorecard report for the linked ALM release.

Note: The scorecard report is displayed only when the ALM scorecard information is
configured in the project request field of the Project Planning and Tracking (PPT)module
in ALM.

l Quality tab added to the Project Overview page

TheQuality tab on the Project Overview page offers a centralized view of the following quality
graphs for each of the ALM releases linked to tasks of the current project:

n Priority Defects Trend:Displays trend of defects of higher severity in the last 10 days. The
higher severity defects include defects of priority S1 and S2.

n Open Defects Trend:Displays open defects trend in the last 10 days. The open defects
include open defects number and total defects number.

n Requirements Trend:Displays requirement status trend in the last 10 days. The
requirement status includes requirement coverage.

Clicking a specific release in the navigation tree brings users to the Task Details page of the
linked task.

l Project Quality Sync Service

The Project Quality Sync Service synchronizes quality KPI data from ALM to PPMCenter. The
default synchronization interval is 24 hours. You can set the synchronization interval on the
Schedule Services page.

The Project Quality Sync Service gets all valid ALM server configurations and loops through all
configurations to retrieve KPI information from ALM and stores the data in PPM Center
database.
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If the service found that the quality KPI for current day already exists, it skips the task and
continues to process the next task.

Synchronization rules are as follows:

n When a project or task is deleted, themapping and records are removed from the database.
This means that users will lose all the data related to the correspondingmapping.

n When a task is canceled or completed, synchronization stops.

n When a project is canceled or closed, synchronization stops.

n If an ALM release is deleted on ALM end or cannot be found when the service tries to
synchronize data, the status is logged in the PPM_INT_QUALITY_TASK_MAPPING table.

n If the end date of an ALM release is ahead of the user's current date, for example, ALM
release R1 is scheduled to end on 11/11/2012 and today is 05/01/2013, then the service stops
synchronization next time.

For details about KPI data to be retrieved from ALM, see "KPI Data Retrieved from ALM" on
page 223.

Adding an ALM Integration Configuration

Administrators need to add integration configurations with HP ALM server on the View Project
Quality configuration page before project managers can link their project tasks to releases managed
in the ALM Releasemodule..

To add an integration configuration,

1. Log on to PPM Center.

2. From themenu bar, select Open > Administration > Integrations.

The integration configuration landing page opens.

3. Click View Project Quality in the navigation pane.

The View Project Quality integration configurations page opens.
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4. In the Server Configuration Details section, click Add Integration Configuration.

The Server Configuration Details section displays.

5. Complete the fields described in the following table.

Field (*Required) Description

*QC/ALM Server Name Specify a unique name for the target ALM server.

Note: The server name shall not contain pound sign (#) or
space.

*QC/ALM Version Select ALM server version from the dropdown list of supported
versions. Valid values include ALM 11.00, ALM 11.20, and ALM
11.50.
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Field (*Required) Description

*QC/ALM Server URL URL of the ALM server you want to integrate with. For
example,
http://ALM11.company.net:8080/qcbin/

*QC/ALM Username ALM account username that you use to log on to the ALM
server.

*QC/ALM Password Password of your ALM account.

Description Provide a description for the ALM server.

6. Click Save.

The ALM server you just configured is added to the Integration Configurations summary list.

Enabling and Scheduling the Project Quality Sync Service

To enable and schedule the Project Quality Sync Service:

1. From the PPMCenter menu bar, select Open >Administration > Schedule Services.

The Schedule Services page opens.

2. Click the table row that displays the Project Quality Sync Service.

The editable fields for that service are enabled.

3. To enable the service, from theStatus list, select Enabled.

4. Leave the type of expression in theSchedule Type list toSimple.

5. In theSchedule column, leave the default value (24 hours).

6. Click Save.

Your changes take effect immediately after you save them. There is no need to restart the PPM
Server.

Configuring PPM Server for MLU Support

If both your PPM Server and ALM server use a language other than English, you need to perform
some extra configuration tasks to enable proper display of project quality related information in PPM
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Center.

To do so,

1. Make sure that the IntegrationResources_<Language_Code>.properties file is present in
the <PPM_Home>\WEB-INF\resources\web\ directory.

The IntegrationResources_<Language_Code>.properties file is a localized version of the
IntegrationResources.properties file, for example, IntegrationResources_
fr.properties. It is present in the <PPM_Home>\WEB-INF\resources\web\ directory if you
have applied the PPMCenter language pack for the desired language.

For a list of supported languages and the corresponding language codes, see theSystem
Requirements and Compatibility Matrix.

2. Modify the <PPM_Home>\conf\hpALMKPI.conf file. The hpALMKPI.conf file is added into the
<PPM_Home>\conf\ directory automatically after you deploy the
ppm-920-PluginQualityALM.jar bundle.

To do so,

a. Stop the PPM Server.

b. Open the <PPM_Home>\conf\hpALMKPI.conf file in a text editor.

c. Copy and paste the following content to the end of the file:

#Test
test.passed=Passed

#Requirement
requirement.notCovered=Not Covered
requirement.na=N/A
requirement.passed=Passed
requirement.reviewed=Reviewed

#Defect
defect.priority=4-Very High,5-Urgent
defect.new=New
defect.open=Open
defect.closed=Closed

d. Modify the content you just pasted by doing the follows:

i. Add the ALM server name you specified in "Adding an ALM Integration Configuration"
on page 218 as prefix to each parameter, and
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ii. Change each parameter value to the target language, as follows:

#Test
QC/ALM Server Name>.test.passed=<Translation of “Passed”>

#Requirement
<QC/ALM Server Name>.requirement.notCovered=<Translation of “Not
Covered”>
<QC/ALM Server Name>.requirement.na=N/A
<QC/ALM Server Name>.requirement.passed=<Translation of “Passed”>
<QC/ALM Server Name>.requirement.reviewed=<Translation of “Reviewed”>

#Defect
<QC/ALM Server Name>.defect.priority=<Translation of “4-Very High,5-Urgent”>
<QC/ALM Server Name>.defect.new=<Translation of “New”>
<QC/ALM Server Name>.defect.open=<Translation of “Open”>
<QC/ALM Server Name>.defect.closed=<Translation of “Closed”>

For example, if you want to configure Simplified Chinese language support, and the ALM
server name you specified in "Adding an ALM Integration Configuration" on page 218 is
ALMServer4PPM, modify the newly pasted section to the following:

e. Save the file in Unicode format.

Caution: Make sure you save the file in Unicode format. Otherwise youmay
encounter errors.

f. Restart the PPM Server.
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KPI Data Retrieved from ALM

All KPI data retrieved from ALM are stored in the PPM_INT_QUALITY_STATISTICS table.

The table below describes three types of KPI data that are retrieved from ALM as well as the REST
APIs that are used to retrieve KPI data.

KPI Data Description REST APIs used to retrieve KPI data

Requirements

# of Total
Requirements

Total number of requirements
within a specific release

http://<URL>:<Port>/qcbin/rest/
domains/<Domain>/projects/
<Project>/
requirements?fields=status,req-
reviewed& query={type- # of Covered
id[<>1];release.id[<Release_ID>]}

# of Covered
Requirements

Number of the requirements
within a specific release,
excluding status "Not
Covered" or "N/A"

# of Reviewed
Requirements

Number of requirements with
status “Reviewed” within a
specific release

# of Passed
Requirements

Number of requirements with
status of Passed

Defects

# of Total Defects Total number of defects of
release level

http://<URL>:<Port>/qcbin/rest/
domains/<Domain>/projects/
<Project>/defects/groups/
severity,status?query={target-rel
[<Release_ID>]}

# of Priority
Defects

Number of defects with
priority level at “4-Very High”
or “5-Urgent”

# of Closed
Defects

Number of defects with
status of Closed
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Using the Integration of PPM Center Tasks with HP ALM
Releases

Project managers can start using the integration after PPM Center administrators have completed
the configuration tasks described in "Configuring the Integration of PPM Center Tasks with
HP ALM Releases" on page 215.

After a project manager initiates a project in PPM Center, and adds tasks and assigns them to sub-
project managers, with the ALM release information available, you can do the follows:

l As a sub-project manager, you can link your task to a corresponding ALM release on the Task
Details page for your task. See "Linking a PPM Task to an ALM Release" below.

Note:If a task is already mapped to an ALM release, you cannot map it to another ALM
release; If a task has progress information that is synchronized from Agile Manager, you
cannot map it to an ALM release as well.

Then, after one-onemapping relationship between a PPM task and an ALM release is established:

l As a sub-project manager, you can view andmonitor the quality related KPI data retrieved from
ALM for your task on theQuality tab of your Task Details page.

l As a project manager, you can view andmonitor the project quality related KPI data retrieved
from ALM for all releases that are linked to your project tasks on theQuality tab of the Project
Overview page, and drill down to details for each task.

Linking a PPM Task to an ALM Release

To link a PPM task to an ALM release,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

The Search Projects page opens.

3. Locate and open the desired project.

4. On the Project Summary tab of the Project Overview page, click Edit Work Plan in theWork
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Plan portlet.

TheWork Plan for <Project_Name> page displays.

5. Open the Task Details page for the desired task that you want to link to an HP ALM release,
and go to theQuality tab.

6. Click Start Mapping.

The Link to an HP ALM release section displays Step 1: General.

7. From theServer drop-down list, select a target ALM server that you want to link to.

8. Click Next.

Themapping process move to Step 2: Authentication.
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9. In theUsername andPassword fields, enter the user name and password that you use to log
on to the target server.

10. Click Next.

Themapping process moves to Step 3: Project Server and loads domain, project, and release
information based on the account information you provided.

11. Select a value from the drop-down list for each of theDomain, Project, andRelease fields.

12. Click Confirm.

Themapping process moves to Step 4: Confirmation.

13. Verify the information and click Done.
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14. Themapping is established and starts retrieving data from the linked ALM release.

When the synchronization completes, the following graphs display on theQuality tab:

n Priority Defects Trend

n OpenDefects Trend

n Requirements Trend

Release Notes
Chapter 6: Enhancement, Integrations, Certifications, and Fixes in PPM Center 9.21

Page 227 of 310HP Project and Portfolio Management Center (9.22)



Note: The Scorecard Report is not yet available. For instructions about configuring the
Scorecard Report, see "Configuring Scorecard Report " below.

Configuring Scorecard Report

To do so,

1. Get Scorecard URL for the Scorecard Report.

a. Log on to the target ALM server and click Dashboard > Analysis View.

b. Right click on the desired scorecard analysis item and select Share Analysis Item.

c. Select Copy Analysis Item Public URL from the popup dialog and click OK.
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Note:Make sure that the scorecard analysis item you configured is related to the ALM
release you linked, otherwise it may mess up the display of quality related data on the
Quality tab.

2. Click Edit Link on theQuality tab of the Task Details page.

3. Paste the URL to the field and click Save.

TheQuality tab page refreshes to retrieve scorecard information.

4. Scroll down the view the scorecard report.

An example of the scorecard report:

Deleting a Mapping from the Task Details Page

To delete amapping from theQuality tab of the Task Details page,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

The Search Projects page opens.

3. Locate and open the desired project.

4. Go to the Task Details page for the desired task that you want to remove themapping you
already established for it, and go to theQuality tab.
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5. Click .

A prompt dialog pops up.

6. Click OK.

Themapping is removed and theQuality tab page returns to its original state.

You can click Start Mapping to link the task to another ALM release as needed.

Viewing and Monitoring Project Quality KPIs and Scorecard Report

Once the one-onemapping relationship between a PPM task and an ALM release is established,
the Quality tab of the Task Details displays the following quality information retrieved from ALM:

l Priority Defects Trend

l OpenDefects Trend

l Requirements Trend

l Scorecard Report (if you provided scorecard URL)

You can do the follows:
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l As a sub-project manager, you can view andmonitor the quality related KPI data retrieved from
ALM for your task on theQuality tab of the Task Details page. See "View Quality Data from the
Task Details page " below.

l As a project manager, you can view andmonitor the project quality related KPI data retrieved
from ALM for all releases linked to your project tasks on theQuality tab of the Project Overview
page, and drill down to details for each task. See "View Quality Data from the Project Overview
Page " on the next page.

View Quality Data from the Task Details page

To do so,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

3. Provide search criteria in desired fields and click Search.

4. Locate your project and open it.

5. On the Project Summary tab page, click Edit Work Plan in theWork Plan portlet.

6. Locate your task and open it.

The Task Details page displays.

7. Go to theQuality tab.

TheQuality tab displays quality KPI data graphs as well as scorecard report.
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Note: If the Scorecard Report is not available, you need to configure the Scorecard Report
link first. For instructions, see "Linking a PPM Task to an ALM Release" on page 224.

View Quality Data from the Project Overview Page

To view quality related KPI data from the Project Overview page,

1. Log on to PPM Center.

2. From themenu bar, select Search > Projects.

3. Provide search criteria in desired fields and click Search.
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4. Locate your project and open it.

The Project Overview page displays.

5. Go to theQuality tab.

n If no tasks are linked to any ALM releases, a promotion picture displays.

n If sub-project managers have linked their tasks to ALM releases, theQuality tab displays
quality KPI data aggregated for themaster project by default.

6. Click or to cycle the display of the quality graphs.
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7. To browse quality KPI data for a linked ALM release, click the desired release in the left
navigation tree.

8. To view scorecard report for the release, click theGo to <Release_Name> link at the top right
corner.

The Task Details page for the task lined to the release displays.

9. Go to theQuality tab and scroll down to view the scorecard report.
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Enhanced Agile Manager Integration Plug-in for PPM
Enhancements are implemented to the Agile Manager Integration Plug-in for PPM for integrating
PPM Center tasks with HP Agile Manager, including the following:

l The enhanced Agile Manager Integration Plug-in for PPM (version 1.1) is compatible with the
hybrid project feature ("AssociatingWaterfall Projects to PPM Center Tasks" on page 85)
implemented in PPM Center version 9.21.

For new users of the integration between PPMCenter tasks and HP Agile Manager, version 1.1
plug-in can be deployed on both versions 9.20 and 9.21 PPMCenter instance. See
"Downloading and Installing the Agile Manager Integration Plug-in for PPM Version 1.1" on page
240

For existing users of the integration between PPMCenter tasks and HP Agile Manager,
upgrading PPMCenter to version 9.22 automatically upgrades the plug-in to version 1.1. See
"Upgrading Agile Manager Integration Plug-in for PPM to Version 1.1" on page 242.

l OnPPMCenter version 9.21, two new charts are available for linked agile projects on the
Timeline tab of the Project Overview page:

n The Theme Status report
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n The Feature Status report

l Data security enhancement

The following sections describe the enhanced Agile Manager Integration Plug-in for PPM inmore
details:

l "Agile Manager Integration Plug-in for PPM Compatibility" on the next page

l "System Behavioral Differences with the Enhanced Agile Manager Integration Plug-in for PPM "
on page 238

l "Downloading and Installing the Agile Manager Integration Plug-in for PPM Version 1.1" on page
240

l "Upgrading Agile Manager Integration Plug-in for PPM to Version 1.1" on page 242
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Agile Manager Integration Plug-in for PPM Compatibility
The table below describes compatibility of the Agile Manager Integration Plug-in for PPM with PPM
Center.

Agile Manager Integration
Plug-in for PPM version

PPM Center 9.20 PPM Center 9.21

1.0 Yes No

1.1a Yes Yes

a. Though version 1.1 plug-in can be deployed on both versions (9.20 and 9.21) of PPM Center,
system behaves differently due to the new feature available with PPM Center 9.21 ("Associating
Waterfall Projects to PPM Center Tasks" on page 85):

l When deployed on PPMCenter version 9.20, users see the sameAgile Project tab on the
Task Details page andAgile Project Timeline tab on the Project Overview page; When
deployed on PPMCenter version 9.21, the Agile Project tab is merged into the new Hybrid
Project tab on the Task Details page, and the Agile Project Timeline tab is merged into the
Timeline tab on the Project Overview page. For more information, see "System Behavioral
Differences with the Enhanced Agile Manager Integration Plug-in for PPM " on the next page

l OnPPMCenter version 9.21, two new charts are available for linked agile projects on the
Timeline tab of the Project Overview page.
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System Behavioral Differences with the Enhanced Agile
Manager Integration Plug-in for PPM

This section describes system behavioral differences of PPM Center versions 9.20 and 9.21 with
Agile Manager Integration Plug-in for PPM versions 1.1 deployed.

Due to the new feature available with PPM Center 9.21 ("AssociatingWaterfall Projects to PPM
Center Tasks" on page 85), the system behaves differently:

l When deployed on PPMCenter version 9.20, users see the sameAgile Project tab on the Task
Details page andAgile Project Timeline tab on the Project Overview page. For more
information, seeHP Solution Integrations Guide for PPM Center version 9.20.

l When deployed on PPMCenter version 9.21, the Agile Project tab is merged into the new
Hybrid Project tab on the Task Details page, and the Agile Project Timeline tab is merged into
the Timeline tab on the Project Overview page.

n Version 1.1 plug-in does not install theAgile Project tab anymore

Starting from version 9.21, a new tabHybrid Project is available on the Task Details page by
default. This tab is introduced to accommodate both the agile project integration capability
and the new feature implemented to the HP Project Management module. It replaces the
Agile Project tab that is available with the installation of the Agile Manager Integration Plug-
in for PPM version 1.0.

TheMapping Waterfall Project button is available on theHybrid Project tab by default
after PPM administrators upgrade PPMCenter to version 9.21.

For new users of the integration between PPMCenter projects and ALM releases, the
Mapping Agile Project button is not available until PPM Center administrators have
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downloaded and installed the plug-in. For more information, see "Downloading and Installing
the Agile Manager Integration Plug-in for PPM Version 1.1" on the next page.

For existing users of the integration between PPMCenter projects and ALM releases, they
can upgrade PPMCenter to version 9.21 directly, or simply upgrade the plug-in to version 1.1.
For more information, see "Upgrading Agile Manager Integration Plug-in for PPM to Version
1.1" on page 242.

Note: For information about registering an HP Agile Manager server and associating
agile project to a PPM Center task, see theHP Solution Integrations Guide for PPM
Center version 9.20.

n Version 1.1 plug-in does not install theAgile Project Timeline tab on the Project Overview
page anymore

Starting from version 9.21, a new tab Timeline is available on the Project Overview page by
default. This tab is introduced to display information of both agile subprojects and waterfall
subprojects associated to tasks under themaster PPM Center project. It replaces theAgile
Project Timeline tab that is available only after installation of the Agile Manager Integration
Plug-in for PPM version 1.0.
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Downloading and Installing the Agile Manager Integration
Plug-in for PPM Version 1.1

To integrate PPM Center with HP Agile Manager, administrators must download and install the free
Agile Manager Integration Plug-in for PPM. This is a one-time action.

Installation Instructions

To download and install the Agile Manager Integration Plug-in for PPM:

1. Obtain the plug-in bundles from the HP Live Network.

a. Go to the PPMCommunity on HP Live Network.

b. On the PPMCommunity home page, click Content Catalog.

c. Click Agile Manager Integration Plug-in for PPM (where HP is the provider).

d. Click Downloads.

The Agile Manager Integration Plug-In for PPM - Downloads page opens.

e. Click theAgile Manager Integration Plug-In for PPM 1.1 folder.

f. Click ppm-920-AgilePlugin.zip to download the package.

This package contains the following two bundles:

Bundle name Description

ppm-920-PluginAgile.jar Contains basic structure of version 1.1 plug-
in for integrating PPM Center with agile
project management tools.

ppm-920-PluginAgileManagement.jar Contains version 1.1 plug-in files specifically
for integrating PPM tasks with HP Agile
Manager product.

Note: Installation bundles for version 1.1 plug-in still use the same names as those for
version 1.0 plug-in. Therefore, make sure you selected theAgile Manager
Integration Plug-In for PPM 1.1 folder in step e.
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2. Stop PPM Server.

3. Unzip the package and copy the two bundles to the <PPM_Home> directory.

4. Deploy the bundles by running the following commands from the <PPM_Home>/bin directory:

sh ./kDeploy.sh -i PluginAgile

sh ./kDeploy.sh -i PluginAgileManagement

5. Repeat step 3 and step 4 for each of the server nodes in a cluster.

6. Restart PPM Server.

Entities Installed by the Agile Manager Integration Plug-in for PPM
Version 1.1

The following entities are installed:

l The Agile Integration Solution configuration page

The Agile Integration Solution option is now available on the integration configuration landing
page. Administrators can register HP Agile Manager servers on the Agile Integration Solution
configuration page.

l Agile Solution Sync Service

The Agile Solution Sync Service synchronize status and progress charts of agile projects from
HP Agile Manager to PPM Center. The default synchronization interval is 24 hours. You can set
the synchronization interval on the Schedule Services page.

l The "Associate Agile Project to this Task" section and theMapping Agile Project button on
theHybrid Project tab of the Task Details page

l Support for displaying Gantt charts of associated agile projects on the Timeline tab of the
Project Overview page
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Upgrading Agile Manager Integration Plug-in for PPM to
Version 1.1

For existing users of the integration between PPMCenter tasks and HP Agile Manager, you have
the following upgrade options:

Scenario Your Actions

You are on PPMCenter 9.20
with version 1.0 plug-in. You
want to upgrade the plug-in to
version 1.1.

Follow the installation instructions to deploy the version 1.1
plug-in on your PPM Center 9.20 instance. See "Downloading
and Installing the Agile Manager Integration Plug-in for PPM
Version 1.1" on page 240.

You are on PPMCenter 9.20
with version 1.0 plug-in. You
want to upgrade PPMCenter
to version 9.21.

Upgrade PPMCenter to version 9.21.

Upgrading PPMCenter to version 9.21 automatically upgrades
the plug-in to version 1.1. You do not need tomanually
download and install the version 1.1 bundle.

Viewing and Managing Hybrid Projects
With the integration between PPMCenter tasks and HP Agile Manager as well as the new waterfall
subprojects management capability available with PPM Center version 9.21, project managers can
view andmanage hybrid IT projects comprised of both waterfall subprojects and agile subprojects
centrally from a PPMCenter project.

They can view andmanage their projects from the following tabs:

l TheHybrid Project tab on the Task Details page

This tab displays the following information of amapped waterfall project:

n Project summary

n TheMilestone Summary portlet

n The Project Cost portlet

n The EV Summary portlet

l The Timeline tab on the Project Overview page
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n This tab displays a consolidated timeline view of themaster project and all waterfall and agile
subprojects.

n For each of themapped waterfall subprojects, you can see the following project details:

o Project Summary

o TheMilestone Summary portlet

o The Project Cost portlet

o The EV Summary portlet

For more information, see "Viewing Details of Waterfall Projects" on page 92.

n For each of themapped agile projects, you can see the following charts:
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o The Release Burnup chart

o The Sprint Burndown chart

o The Theme Status report (new in 9.21)

o The Feature Status report (new in 9.21)

Click or , or the thumbnails at the bottom of the page to cycle the display of the charts.

For more details about viewing agile project information, seeHP Solution Integrations Guide
for PPM Center version 9.20.

Project Indicators

Version 9.21 introduced the following icons and colors as project indicators to facilitate your project
management work:

Project Indicator Description

A hybrid project, comprised of both waterfall subprojects and agile
subprojects

A waterfall project

An agile project
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Project Indicator Description

Timeline for an agile project

Timeline for a waterfall project

A milestone of a waterfall project. Placingmouse over themilestone
displays milestone details.
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Certifications
The following certifications are included in PPM Center version 9.21:

l Support for Microsoft Office Excel 2013

l Support for the following versions of iPad as PPMCenter client:

n iPad 2 with iOS 5 or later

n iPad 3 with iOS 5.1 or later

n iPad 4 with iOS 6 or later

Note: For information about limitations of iPad certification, see "iPad Certification" on page
264

For details, see theSystem Requirements and Compatibility Matrix.
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Fixes
The following fixes are included in PPM Center version 9.21:

Costing

Tracking Number Problem Description

4643787466 Slowness in opening Program, Budget, and Email Services.
(QCCR1L50417)

Dashboard

Tracking Number Problem Description

4638724602,
4641677546

Error whenmigrating a new module. (QCCR1L48014)

4644220980 Regression: When logging in to PPM using logon_id, error appears:
"Your session has timed out because of inactivity.
Please login again (KNTA-10674)" (QCCR1L50632)

4642343476 Export to Excel on the Request List portlet loses formatting of Text
Area fields. (QCCR1L48884)

4644220980 Portlet expand "+" and collapse "-" buttons missing in PPM Center
Management for Quality Center 9.20. (QCCR1L50899)

The two buttons are added back in version 9.22. For details, see
"Expand and Collapse Buttons Added back to Portlets on Private
Dashboard Pages" on page 189.

Documentation

Tracking Number Problem Description

4643924413 Need to emphasize that users' customized ldapAttribute.conf
will be overwritten after upgrading to PPM Center version 9.14.
(QCCR1L50349)

4644045844 Receive error message "You do not have access to this
page... (KNTA-11013)" after changing request type of requests.
(QCCR1L50552)
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HP Demand Management

Tracking Number Problem Description

4638342363 The Serverlog on certification is filled by the "Returning null for
Date" error. (QCCR1L46386)

4643979114 After you apply the workaround for QCCR1L47225/QCCR1L49374
(use legacy table component instead), the page looks different
because some sections disappear. (QCCR1L50439)

4644136701 Values of auto-complete fields are not translated into the session
language of the current user.

For details of the solution, see "Improved Behavior of List Auto-
Complete Fields in MLU" on page 190. (QCCR1L50445)

4644220980 The setFieldVisible(false) rule causes the whole request page
invisible if the request is opened in a pop-up window.
(QCCR1L50949)

4644220980 Cannot save request if there is an UI rule setFieldRequired
(false) in the request type. (QCCR1L50796)

4637790215 Timeout functionality does not work in workflows. (QCCR1L47224)

4643323344 If the field security of a Request Header Type field is set to non-
editable for the current user, value dropped after the user clicks the
Save button or a workflow step. (QCCR1L50343)

4643153337 ksc_copy_request spawns wrong 'created by'. (QCCR1L50386)

4644422321 After upgrading to version 9.20, any change to a request type or
request header type (copied from seed request header type) causes
the trigger error. (QCCR1L50754)

Installer

Tracking Number Problem Description

4643321131 Upgrade to PPM 9.10 fails due toMLU issue. (QCCR1L50101)
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Integrations

Tracking Number Problem Description

4644054593 NTLM SSO issue with PPM. (QCCR1L50402)

4643918188 Error when updating a work plan in a project that is in PPM-MSP
sharedmode. (QCCR1L50608)

4643901788 java.sql.SQLException: ORA-12899: value too large for
column "PPM"."KNTA_DOCUMENT_HISTORY_
CONTENTS"."EXTENSION". (QCCR1L50502)

4644140745 (Regression) Unable to add a second version to an attachment
when selecting a French language session (QCCR1L50542)

Platform

Tracking Number Problem Description

4642586659 The Server Logon Report does not remove the session information
created by special command. (QCCR1L49711)

4643101640 Error with ksc_copy_requestwhen there are apostrophes in project
titles. (QCCR1L49735)

4643454560 The Import Users Report fails with "Numeric or value error:
character string buffer too small" error. (QCCR1L49798)

4644220980 Performance with rsc_position_forecast_914_1.sql.
(QCCR1L50646)

4644103257 After upgrading to version 9.14, even if WORKBENCH_PLUGIN_
VERSION is specified, the Server Configuration Report shows the
JAVA_PLUGIN_XPI_PATH parameter as [blank] but the
Administration Console shows the default value for version 9.14.
(QCCR1L50665)

4644291541 PPM upgrades to 9.20 fails with error. (QCCR1L50735)
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HP Project Management

Tracking Number Problem Description

4643176824 Problem with ProgramManagement Web services after users
enablemandatory user data. (QCCR1L49536)

4640959544 The Project Timelines portlet shows a date exception, which is not
true and the work plan does not show any exception.
(QCCR1L49615)

4639871764 Work plan summary task scheduler not honoring Actual dates.
(QCCR1L50994)

HP Resource Management

Tracking Number Problem Description

4644069657 Holidays missing from Calendars after upgrading PPMCenter from
version 8.04 to 9.14.0004. (QCCR1L50348)

4644272489 SQL grammar exception thrown on theManage Forecast page.
(QCCR1L50580)

HP Time Management

Tracking Number Problem Description

4643446509 Performance issue when logging in PPM Centerto enter time.
(QCCR1L49676)

4636791224 DisabledMISC items can be added to time sheets.
(QCCR1L50055)

N/A PPMCenter does not copy charge codes when a time sheet is
copied. (QCCR1L49512)
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Chapter 7: Known Problems and Limitations
in PPM Center 9.22

The following problems and limitations are known to exist in PPM Center version 9.22 (or other
software, as indicated). The problems are categorized by the affected product area. If a problem
has an assigned internal tracking number, that tracking number is provided (in parentheses) at the
end of the problem description.

l "Accelerators - Best Practices" below

l "HP DemandManagement" below

l "Integrations" on page 254

l "PPMWorkbench" on page 258

l "HP TimeManagement" on page 259

Accelerators - Best Practices

Problem: (PPM Center version 9.20 or later) After deploying the best practices, when clicking
Search > Project Risk, the following error occurs: "Request type business key, _PROJECT_
RISK not found". (QCCR1L51372)

Workaround: After upgrading your PPM Center instance to version 9.22, if the problem exists, run
the following command to re-deploy the updated best practices bundle available with version 9.22:

sh ./kDeploy.sh -best-practices

HP Demand Management

Limitation: If a user only has the access grant of a workflow step, when searching requests, the
user cannot select the request type that uses this workflow. (QCCR1L44594)

Workaround: None.

Limitation: On the Request Search Results page, when you select several requests and click the
Edit > Quick Edit button, you receive the following error message:

An unknown error has occurred. For more information, please contact your PPM
administrator and provide the following GUID number...
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(QCCR1L50677)

Workaround: To resolve this issue, do one of the following:

l Select fewer requests and then click theEdit > Quick Edit button.

l Configure as follows:

a. Stop PPM Server.

b. Open the <PPM_Home>/server/<PPM_Server_Name>/deploy/jbossweb-
tomcat55.sar/server.xml file, and add maxPostSize="0" right after maxThreads="150".

c. Click Save to save your changes.

d. Clean up the <PPM_Home>/server/<PPM_Server_Name>/tmp and the<PPM_
Home>/server/<PPM_Server_Name>/work directories.

e. Restart PPM Server.

Limitation: (PPM Center versions 9.20 and 9.21 only) On theProject Details tab of the Project
Overview page, the Jump To quick navigation panel is not supported, and the ribbon style toolbar
is not pinned at the top of the page. (QCCR1L51341)

Workaround: None.

Limitation: PPMCenter fails to send notifications for a workflow step, when there aremany
recipients and you configure as follows:

1. In the Add New Recipient window of PPMWorkbench, select Enter a User Defined Token.

2. In theUser Defined Token field, enter the token name of a text field.

3. In theRecipient Type field, select Email Address. (QCCR1L51955)

Workaround: The root cause is that for text fields, the database column used to store email
addresses of recipients has a character limitation of 80 (including separators).

To resolve the issue, stop PPM Server and run the following SQL:

alter table knta_notif_txn_recipients modify email_address varchar(1000 CHAR);

If you encounter errors related with the KNTA_NOTIFICATION package after running the SQL,
recompile all packages.
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Limitation:When using the Request Browser to search requests (Open > Demand Management
> Request Browser > Browse Requests), a user can select amaximum of 8 values for the
Column Values field in theChoose Additional Column to Display in Request Browser Tree
section. (QCCR1L51965)

Workaround: Starting from PPMCenter version 9.22, a user can select amaximum of 12 values
for theColumn Values field.

Problem:When sending notifications of a workflow step or request field change, PPM Center
behaves as follows:

l For recipients who are PPMCenter users and have already logged on to PPM Center at least
once, PPM Center groups them together according to their user locales (user locale includes
regional settings and display language).

l For recipients who are not PPM Center users and who have PPMCenter user accounts but
have never logged on to PPM Center, PPM Center groups them together.

As a result, recipients in different groups receive different notification emails. (QCCR1L52110,
QCCR1L52245)

Workaround: This is because only PPM Center users who have already logged on to PPM Center
at least once have locales. To resolve this issue, do the following to define a default locale for all
non-PPM Center users and PPMCenter users who have never logged on to PPM Center:

1. Set a value for the SERVER_LOCALE_COUNTRY_CODE server configuration parameter. The default
value is null. Valid values are any two-letter abbreviation of a country in uppercase.

For example, if you want to set the default regional settings to United States, set the SERVER_
LOCALE_COUNTRY_CODE server configuration parameter to US.

2. Set a value for the SERVER_LOCALE_LANGUAGE_CODE server configuration parameter.The
default value is null. Valid values are any two-letter abbreviation of a language in lowercase.

For example, if you want to set the default display language to English, set the SERVER_
LOCALE_LANGUAGE_CODE server configuration parameter to en.

This ensures that PPM Center groups all PPM Center users and non-PPM Center users together
when sending notifications.

Limitation:When there are several groups of workflow steps on the Request Details page and the
browser cannot display all workflow steps, theMore Actions buttons appear. However, one or
more groups of workflow steps may disappear when you resize or restore down your browser
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window. This is because the resized browser window is not wide enough to display theMore
Actions buttons. (QCCR1L52165)

Workaround: To resolve this issue, do one of the following:

l Maximize your browser.

l From the Control Panel, select a higher screen resolution.

l Press ctrl and - to zoom out your browser.

Integrations

Integrations - Quality Center (ALM)

Limitation: (HP ALM version 11.00 or later) On an HP ALM-integrated Request Type, there is a
fieldQC/ALM Defect Attachment URL. If and when an attachment is added to an ALM defect that
is synchronized to a PPM request, the attachment shows an active link to this document on the
PPM request page. When clicking the link, the HP ALM login page appears, prompting the user for
the ALM login credentials.

This issue exists in PPM Center integration with HP ALM version 11.00 or later due to removal of a
servlet class (CTdAttachmentsServlet) from ALM 11.00 (and later). (QCCR1L52005)

Workaround: After upgrading PPMCenter to version 9.22, when an ALM entity is synchronized to
PPM Center, the download links to the ALM-entity attachments are collected to a new page, where
users can see all attachment files and choose to download.

Problem: (HP ALM versions 11.50 and 11.52 only) The PPMCenter-ALM Integration Tool support
for HP ALM versions 11.50 and 11.52 is not stable. Error may happen when you enable a project
using the tool. (QCCR1L52353)

Workaround: For new users who plan to integrate PPM Center with HP ALM version 11.50 or
11.52, do either of the following:

l If the PPM Center-ALM Integration Tool is not working well, download and install the
TDConnect.exe tool from HP ALM's logon page before you enable an HP ALM project using the
tool.

Note: This works well for HP ALM version 11.50, but not always well for version 11.52.
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l Do not use the PPMCenter-ALM Integration Tool at all. Instead, do the following:

To enable the hidden fields in HP ALM for the integration and to deploy the workflow scripts in
HP ALM,

a. Add scripts to perform the operation on HP ALM server side.

i. Log on to HP ALM as administrator.

ii. From themenu bar, click Tools > Customize > Workflow > Script Edit.

The Script Editor opens.

iii. From the navigation pane, select Requirement module script, then go to the last
script of this category, copy and append the content of add requirement script.txt
to the end of the script in the editing pane.

Note: To obtain the add requirement script.txt, go to KM00630244 and click
workflow scripts to download the zip package.

iv. Click Save.

The new script is added to theRequirement module script.

v. From the navigation pane, select Defect module script, then go to the last script of
this category, copy and append the content of add_defect_script.txt to the end of
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the scrip in the editing pane.

Note: To obtain the add defect script.txt, go to KM00630244 and click
workflow scripts to download the zip package.

vi. Click Save.

The new script is added to theDefect module script.

vii. Exit and log off.

b. Run the SQL scripts provided by HP Software Support manually:

o For instructions on how to enable PPM* fields in HP ALM project, go to KM1352699.

o For instructions on how to activate workflow script in HP ALM project, go to KM1352700.

Problem: (HP ALM version 11.00 or later)When synchronizing content of HP ALM text fields that
contain 4000+ bytes to PPM Center text fields, the content in PPM Center text fields show html
encapsulation tags, which is confusing to end users. (QCCR1L52080)

Workaround: None, if you are on PPMCenter version 9.21 or earlier.

After upgrading PPMCenter to version 9.22, for each newly created ALM defect (or requirement),
an html file is generated for each of themapped text fields in the ALM defect (or requirement) as a
reference attachment to the PPM request. For any existing ALM defect (or requirement), if it is
updated, an html file is generated for each of themapped text fields as a reference attachment to
the PPM request.

For more information, see "SynchronizingMemo Fields from HP ALM Defects or Requirements as
HTMLReference Attachments to PPM Requests" on page 172.

Integrations - View Project Quality
Limitation:Whenmapping a PPM task to an HP ALM release, if the values in the target HP ALM
server are in German or Korean, after you added a filter and specified anALM Criteria, and then
clicked the selector icon forCriteria Value, the available values retrieved by HP ALM REST API
from HP ALMmay display as garbled characters in the popup window, for example, "???".

Workaround: None.
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Limitation:Whenmapping a PPM task to an HP ALM release and adding filters, some invisible
fields in HP ALM are also retrieved by the HP ALM REST API and are displayed in theALM
Criteria column on theQuality tab of the Task Details page. Such invisible fields include:

l For Defect: To Mail

l For Requirement: Some fields that start withRBQM.

Workaround: None.

Problem:Whenmapping a PPM task to an HP ALM release and adding filters, though theSubject
field value is empty in the Criteria Value column on theQuality tab of the Task Details page, the HP
ALM REST APIs get test plan folder name as available values for this field from HP ALM.

Workaround: None.

Integrations - Universal CMDB

Problem: (PPM Center version 9.20 and later)When you integrate PPM Center with Universal
CMDB for impact analysis, the ";" character is not supported. If a UCMDB CI name contains a ";"
character, it would be treated as a separator and two entries would show up in the Impacted
Configuration Items section of the PPMCenter request after you loaded selected CIs into the
request. (QCCR1L52964)

Workaround: None.

Integrations - HP Agile Manager

Problem: (PPM Center version 9.21 only) Display error with the Theme Status and Feature Status
charts on the Timeline tab of the Project Overview page. This is caused by changes with the HP
Agile Manager APIs. (QCCR1L52963)

Workaround: Upgrade PPMCenter to version 9.22, then download and deploy version 1.2 of the
Agile Manager Integration Plug-in for PPM.
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PPM Workbench

Problem: PPMWorkbench cannot open after installing JRE7u25. This is caused by change in
Java applet made by Oracle with the latest Java plug-in. For more details, see
http://www.oracle.com/technetwork/java/javase/7u25-relnotes-1955741.html. (QCCR1L52313)

Workaround 1: Uninstall JRE7u25, then reinstall and use JRE7u11.

The latest Java plug-in causes the issue with the PPMWorkbench, therefore it is recommended to
use JRE7u11.

Workaround 2: Clear Java cache settings and disable certificate revocation checking. To do so,

1. Go toStart > Control Panel > Java.

The Java Control Panel window opens.

2. Clear Java cache settings.

a. On theGeneral tab, click Settings in the Temporary Internet Files section. The Temporary
Files Settings dialog opens.

b. Click Delete Files.The Delete Files and Applications dialog opens.

c. Select Cached Applications and Applets and click OK.

3. Disable certificate revocation checking.

a. Go to theAdvanced tab of the Java Control Panel window.

b. ExpandSecurity > General, uncheck theCheck certificates for revocation using
Certificate Revocation Lists (CRLs) option, and click OK.

4. Open the PPMWorkbench again.

Caution:Disabling on line revocation checking should only be considered inmanaged
environments as it decreases security protections.
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HP Time Management

PROBLEM: (Internet Explorer 9 only) Blockingmessage pops up when exporting time sheets to
Excel via HTTPS after upgrading PPMCenter to version 9.14.0002. (QCCR1L50117)

Workarounds: There are two workarounds available.

Note: Try Workaround 2 only whenWorkaround 1 is not allowed by your organization's IT
policies.

Workaround 1:Uncheck theDo not save encrypted pages to disk option in your advanced
Internet Explorer settings.

To do so, on the Tools menu in Internet Explorer 9, click Internet Options, click theAdvanced tab,
click to clear the check mark from theDo not save encrypted pages to disk check box in the
Security area, and then click OK. (This is the default Internet Explorer setting.)

Workaround 2:Edit registry key. To do so,

1. Start Registry Editor.

2. Locate the desired registry key.

n For a per-user setting, locate the following registry key:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Internet Setti
ngs

n For a per-computer setting, locate the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Internet Sett
ings
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3. On theEditmenu bar, click New > DWORD (32-bit) Value, and then add the following value
name: BypassSSLNoCacheCheck.

4. Right click on BypassSSLNoCacheCheck and click Modify.

5. In theValue data field, enter 00000001 and click OK.

6. Exit Registry Editor.
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Chapter 8: Known Problems and Limitations
in PPM Center 9.21

The following problems and limitations are known to exist in PPM Center version 9.21 (or other
software, as indicated). The problems are categorized by the affected product area. If a problem
has an assigned internal tracking number, that tracking number is provided (in parentheses) at the
end of the problem description.

l "HP DemandManagement" below

l "Integrations" on page 263

l "iPad Certification" on page 264

l "Platform" on page 265

l "HP Project Management" on page 266

HP Demand Management

PROBLEM: You use a SQL rule to get a project name and display it on the Request Details page.
When the project name contains an ampersand, the ampersand is not displayed and the name gets
truncated on the Request Details page. (QCCR1L46993)

Workaround: PPMCenter uses #@# as a separator. Make sure that:

l Values used in SQL rules do not contain &amp; or #@#

l SQL rules do not contain #@#

You can use # and @ separately.

PROBLEM: On the Timeout tab of theWorkflow Step window in the PPMWorkbench, you set a
timeout for a workflow step tomake PPMCenter send notifications when the step gets timed out.
However, it does not work. (QCCR1L47224)

Workaround: The root cause is that the p_step_txn_group_IN_list variable used to store step_
transaction_id has a character limitation, which can contain around 4000 transaction ids.

To solve the issue, use the following query to check if there are toomany transactions pending
notification:
select step_transaction_id FROM KWFL_PENDING_STEP_TIMEOUTS_V

Release Notes
Chapter 8: Known Problems and Limitations in PPM Center 9.21

Page 261 of 310HP Project and Portfolio Management Center (9.22)



If the number of returned rows exceeds 4000, update the timeout_date column of the KWFL_Step_
Transactions table. For example, youmay run the following SQL:

update KWFL_STEP_TRANSACTIONS
set TIMEOUT_DATE = sysdate +floor(rownum / 3000)
where STEP_TRANSACTION_ID in
(select STEP_TrANSACTION_ID from KWFL_PENDING_STEP_TIMEOUTS_V)

After you run the SQL, the timeout dates of every 3000 rows are updated in batches. The date of the
first batch is set to the current date and is one day later every time the batch number increases. As
a result, PPM Center will send notifications of 3000 transactions per day, thus avoid exceeding the
character limitation.

LIMITATION: You have a request type whose Request Header Type (RHT) contains an
attachment field. You submit a request using this request type and attach a file in the field. On the
request details page, you change the request type to the one using a different RHT and save the
change. If attachment fields in both target and original RHTs use the same parameter, you receive
the following error message when clicking the link of the attached file: You do no have access to
this page…(KNTA-11013)

If you change the request type back to the original one, you can access the attached file again.
(QCCR1L50552)

Workaround: None.

LIMITATION: If you are usingMicrosoft Internet Explorer 7.0, when you create a request whose
request type contains table components, you cannot open the Create New <Request Type> page
and receive the error message "Internet Explorer cannot open the Internet site..." in a pop-up
window.

If you are usingMicrosoft Internet Explorer 8.0, when you create a request whose request type
contains table components, you can open the Create New <Request Type> page but the page does
not work properly. (QCCR1L51062)

Workaround: This is aMicrosoft Internet Explorer limitation. To fix the problem, do one of the
following:

l Download and install Microsoft patch "KB2416400" according to your operational system and
browser version. You can download the patch from the following link:
http://www.microsoft.com/en-us/download/search.aspx?q=KB2416400

l Upgrade your browser to Microsoft Internet Explorer 9.0.
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Note: To achieve optimal viewing and application performance, HP recommends you use
Internet Explorer 9.0.

LIMITATION: PPMCenter does not support using UI rule setFieldEditable() to set table
component validations as editable or read-only. (QCCR1L51073)

Workaround: None.

Integrations

PROBLEM: (IE 9 only)When your screen resolution is lower than 1024 pixels, the Timeline tab of
the Project Overview page does not display percentage for progress bars for waterfall projects.

Workaround: Use FireFox browser instead.

PROBLEM: (IE 9 only) In Quirks mode of the browser, the Timeline tab of the Project Overview
page has the following display issues:

l On themaster project timeline view, the tasks in the left navigation tree are not in alignment with
the timeline bars in the right pane;

l The last month in the Gantt chart view may not display.

Workaround: Use other modes of the browser instead.

PROBLEM: (IE only)When adding an integration configuration on the View Project Quality
integration landing page, entering a long name in theQC/ALM Server Name field may cause
display alignment issue with the list of View Project Quality integration configurations.

Workaround: Enter a shorter name instead.

PROBLEM: If you are on the Timeline tab of the Project Overview page, theMore drop-downmenu
does not display completely, the Delete option is missing. (QCCR1L51088)

Workaround: To display the Delete option, switch to another tab of the Project Overview page.

PROBLEM: On the Timeline tab of the Project Overview page, if there aremore than 5milestones
in one day, only the first 5 milestones will display. No way to see other milestones.

Workaround: None.
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PROBLEM: The Date label for agile project charts may not display completely.

Workaround: None.

PROBLEM: Error occurs when deleting a waterfall project if it is mapped to a task.
(QCCR1L51101)

Workaround: Remove themapping first, then delete the waterfall project.

iPad Certification

PROBLEM: In theMy Tasks portlet on the PPMDashboard page, after you click Edit Effort
Breakdown, input fields in the pop-up window are too narrow to display the inputted data.

Workaround: None.

PROBLEM: You cannot click the column headings to change the sort order of the table on the
following pages:

l TheSubportfolios, Programs, andProposal/Project/Asset tabs of the View Portfolio page

l TheScenario Content section of the Scenario Comparison page.

Workaround: None.

LIMITATION: After you add a reference in theReferences section of the Program Overview page
or on theReferences tab of the Task Details page, the newly added reference is not displayed in
theReferences to be added on Save field. (QCCR1L49441)

Workaround: None.

PROBLEM: The View Work Plan page and the Project Settings pagemay not work properly. For
example, when you click theName or thePredecessors column on the View Work Plan page, the
work plan gets truncated.

Workaround: HP recommends that you perform such actions on your computer.

PROBLEM: You cannot perform any action on the Administration Console page.

Workaround: None.
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PROBLEM: You cannot use features related to right-clicking on PPMCenter pages. This is
because iPad does not support right-clicking.

Workaround: None.

PROBLEM: Youmay encounter style problems when using PPMCenter. For example, table on
theManage Resource Pool page exceeds the right boarder of the page.

Workaround: None.

PROBLEM: You cannot export PPM Center pages to PDF/EXCEL files.

Workaround: None.

LIMITATION: You cannot see tooltips on PPMCenter pages. This is because Apple Safari in
mobile devices does not support Alt/Title attribute.

Workaround: None.

LIMITATION: (Apple IOS 5.0 only) You cannot upload files on PPMCenter pages, this is because
Apple IOS 5.0 does not support uploading files.

Workaround: None.

LIMITATION: Due to iPad limitations, you cannot use features utilizingMicrosoft Silverlight, or
download/upload EXCEL files in Application Portfolio Management.

Workaround: None.

Platform

PROBLEM: Upgrade to 9.20 fails with the error below:

java.sql.SQLIntegrityConstraintViolationException: ORA-02299: cannot validate (P
PMSDUSER.SYS_C00262694) - duplicate keys found

(QCCR1L50735, QCIM1L50587)

Workaround: Follow the steps below to fix the problem:

1. Locate the /apps/ppmadmin/ppm/sandbox/upgrade_920/920/ddl/fm/pfm_lifecycle_
parent_entity_920_1.sql file.
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2. Comment out the following lines from the pfm_lifecycle_parent_entity_920_1.sql file:

/*

ppm_db_utils.drop_index('pfm_lifecycle_project_req_idx');

ppm_db_utils.drop_index('pfm_lifecycle_asset_req_idx');

ppm_db_utils.drop_index('pfm_lifecycle_proposal_req_idx');

ppm_db_utils.create_unique('pfm_lifecycle_parent_entity', 'proposal_req_id');

ppm_db_utils.create_unique('pfm_lifecycle_parent_entity', 'project_req_id');

ppm_db_utils.create_unique('pfm_lifecycle_parent_entity', 'asset_req_id');

*/

3. Save the file.

4. Perform the upgrade again.

HP Project Management

PROBLEM:When you click Save on the Project Details tab of the Project Overview page, you
receive the following error message:

An Error has Occurred. The parameter (portletNoPreview) is invalid or missing.
(QCCR1L42882)

Workaround: None.
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Chapter 9: Documentation Errata
The following documentation items are incorrect.

Commands, Tokens, and Validations Guide and
Reference

Incorrect name of the REQUEST_SUB_TYPE_ID token

Location: Commands, Tokens, and Validations Guide and Reference, version 9.20, page 192

Error: The name of the REQUEST_SUB_TYPE_ID token in Table A-29 is incorrect.

Correction: The correct name of the REQUEST_SUB_TYPE_ID token is REQUEST_SUBTYPE_ID.

Customizing the Standard Interface

Insufficient information about files used in the PPM Center standard
interface

Location: Customizing the Standard Interface, version 9.20, pages 16, 74 and 75

Error: The information about files used in the PPMCenter standard interface is insufficient.

Correction:Add the following two entries to the “Corporate logo files used in the PPMCenter
standard interface” table on page 16:

Image File Location Size (in pixels)

Stored on the PPM Server File System

<PPM_Home>/server/<PPM_Server_
Name>/deploy/itg.war/web/new/img/HP_Blue_64x64.png

64 x 64

<PPM_Home>/server/<PPM_Server_
Name>/deploy/itg.war/web/new/img/ppm_logo.png

400 x 400

On page 74, change the bullet GIF files (in English) into image files (in English), and add the
following location:

<PPM_Home>/server/<PPM_Server_Name>/deploy/itg.war/web/new/img/

On page 75, under the bullet CSS files, add the following location:

<PPM_Home>/server/<PPM_Server_Name>/deploy/itg.war/web/new/css/
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Data Model Guide

Incorrect definition for the PPM_SERVICE_RECORDS table

Location:DataModel Guide, version 9.20, page 1097

Error: The document specifies that the PPM_SERVICE_RECORDS table is populated with the
last 50 runs of each background service. However, this table contains no rows.

Correction: The following text shall be added to the table definition for the PPM_SERVICE_
RECORDS table:

To see the data populated in the PPM_SERVICE_RECORDS table, PPM Server administrators
need to set the server configuration parameter com.kintana.core.server.LOG_EXCEPTIONS_TO_
DB to true.

Incorrect data table name: RSC_TRACE_DETAILS

Location: DataModel Guide, version 9.20, pages 124 and 1285

Error: The data table name of RSC_TRACE_DETAILS described on pages 124 and 1285 is
incorrect.

Correction: The correct table name shall be RPT_TRACE_DETAILS.

HP Demand Management Configuration Guide

Limitation of special characters on configuring SQL rules not documented

Location: HP DemandManagement Configuration Guide, version 9.20, page 198

Error: Limitation of special characters on configuring SQL rules is not documented.

Correction: The following information about configuring SQL rules shall be added to the HP
DemandManagement Configuration Guide:

PPM Center uses #@# as a separator. Make sure that:

l Values used in SQL rules do not contain &amp; or #@#

l SQL rules do not contain #@#

You can use # and @ separately.
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Insufficient information about rule event behavior on the look-ahead page

Location:HP DemandManagement Configuration Guide, versions 9.20, page 194

Error: The information about rule event behavior on the look-ahead page is insufficient.

Correction:Add a note as follows on page 194 of this guide:

When a user clicks eitherSave Progress orContinue Workflow Action on the look-ahead page,
only "Apply before save" rules are triggered. This is because when the user clicks the workflow
"action" button on the Request Details page before going to the look-ahead page, PPM Center has
executed "Apply before transition" rules.

Deployment Best Practices Guide

HP Diagnostics Probe mentioned as supported in the Deployment Best
Practices Guide

Location: Deployment Best Practices Guide, version 9.20, page 32

Error: The document says that HP Diagnostics Probe "Ships with PPM Center and helps monitor
transient data", which is not true.

Correction:Remove the line from the document.

HP Center Management for Quality Center Guide

Outdated limitation for CMQC solution

Location:HP Center Management for Quality Center Guide, version 9.10, page 24

Error: The limitation note on page 24 that says “CMQC is not supported with Oracle database
version 11.2.0.1” is outdated.

Correction:Oracle 11.2.0.2 and 11.2.0.3 (Standard/Enterprise Edition) (RAC and Non-RAC)
support for the Center Management for Quality Center solution has been added.

HP Financial Management User’s Guide

Insufficient description about the cost factor "role" that applies to the
entity "task planned cost"

Location:HP Financial Management User’s Guide, version 9.20, page 23
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Error: The description about the cost factor "role" that applies to the entity "task planned cost" is
insufficient.

Correction: Add a note as follows after the description about "role" on page 23 of this guide:

Note: If, for the assigned portion of the task, the assigned resource does not have a role, PPM
Centeruses the task role by default.

Installation and Administration Guide

Outdated information about the JAVA_PLUGIN_XPI_PATH parameter

Location: Installation and Administration Guide, version 9.20, page 141

Error: The document says the JAVA_PLUGIN_XPI_PATH parameter "specifies theWeb location for
downloading the cross-platform Java plug-in installer for Firefox browsers. The default setting for
this parameter is java.com/en/download/windows_xpi.jsp." This information is outdated.

Correction: The correct information shall be as follows:

The JAVA_PLUGIN_XPI_PATH parameter specifies theWeb location for downloading the cross-
platform Java plug-in installer for Firefox browsers. The default setting for this parameter is
http://javadl.sun.com/webapps/download/GetFile/1.7.0_11-b21/windows-i586/xpiinstall.exe.

Note:Normally it is not recommended to set this parameter. The XPI is installed if you install
JRE. To download and install JRE, go to
http://www.oracle.com/technetwork/java/javase/downloads/index.html.
However, if needed, you can go to the following address to find the specific web location for
downloading the .xpi file for your Firefox browser:
http://www.oracle.com/technetwork/java/javase/autodownload-140472.html.

Outdated default values or examples for Java Plug-in parameters

Location: Installation and Administration Guide, version 9.20, pages 468 and 469

Error: The default values provided for Java Plug-in related parameters are outdated.

Correction: The correct default values or examples shall be as follows:
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Parameter
Name

Description, Usage Default and Valid Values

JAVA_
PLUGIN_
CLASSID

Class ID for the Java plugin used for
the PPMWorkbench.

Default:

CAFEEFAC-0017-0000-FFFF-ABCDEFFE
DCBA

JAVA_
PLUGIN_
PATH_IE

Web location for downloading the
cross-platform Java plug-in bundle for
Internet Explorer browsers.

Warning: Internet Explorer versions
7 and 8 display a warning if the JAVA_
PLUGIN_PATH_IE value contains the
protocol identifier “http:”. If you
override the default setting for this
parameter, make sure that you
remove the protocol identifier "http:"

Default:

//java.sun.com/update/1.7.0/jins
tall-7u11-windows-i586.cab

JAVA_
PLUGIN_
PATH_NS

Web location for downloading the
cross-platform Java plug-in installer
for Netscape browsers.

Default:
http://www.oracle.com/technetwork/ja
va/javase/downloads/index.html

JAVA_
PLUGIN_
VERSION

Earliest version of the Oracle Java
plug-in used to start the PPM
Workbench.

Default: 1.7.0_11

JAVA_
PLUGIN_
XPI_ PATH

Web location for downloading the
cross-platform Java plug-in installer
for Firefox browsers.

Example:

http://javadl.sun.com/webapps/downlo
ad/GetFile/1.7.0_11-b21/windows-
i586/xpiinstall.exe

Incomplete description for the DISTINGUISHED_NAME attribute of the KNTA_
USERS_INT parameter

Location: Installation and Administration Guide, version 9.20, page 222

Error: The description of the DISTINGUISHED_NAME attribute is incomplete.

Correction: The complete description shall be as follows:

DISTINGUISHED_NAME:Maps to a unique and fixed field of the LDAP server. For example,
DISTINGUISHED_NAME = distinguishedName.
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Note:By default, the DISTINGUISHED_NAME attributemaps to distinguishedName of the
LDAP server. If distinguishedName of the LDAP server is changeable, make sure youmap
DISTINGUISHED_NAME to another field that is unique and fixed on the LDAP server.

Required if using SSO, LDAP, or NTLM as the user authenticationmode.

The WEB_CACHE_DIR parameter was not documented

Location: Installation and Administration Guide, version 9.20

Error: TheWEB_CACHE_DIR parameter was not documented in the guide.

Correction:Add the definition of theWEB_CACHE_DIR parameter to the guide as follows:

Parameter Name
(*Required,
**Required If)

Description, Usage Default and Valid
Values

**WEB_CACHE_
DIR

Specifies web cache directory.

Add this parameter to the server.conf file if it is
not there, andmake sure to use a shared folder in
clustered configuration so that whenever a chart in
portlet is loaded by PPMDashboard, it creates
charts pictures into this shared folder. Then, the
Directory Cleanup Service can automatically
clean up the older pictures files.

Required only if all the nodes of the cluster are not
located on the same physical machine AND in the
same <PPM_Home> folder.

Examples:

//<IP_
Address>/<Local_
Drive_
Letter
>$/<Shared_
Folder>/ or

<File_Server_
Name>$/<Shared_
Folder>

Confusing requirement about password when using Private Key
Authentication with Secure Shell with RSA keys

Location: Installation and Administration Guide, version 9.20, pages 110-111

Error:Step 2 says "You should not be prompted for the password. It should log on to the remote
host using the RSA key file", but Step 8.d requires a value to be provided in thePassword field.
These two steps are confusing as they seem conflicting with each other.

Correction: The password required in step 8.d for the <User_ID> in step 2 is designed to provide
backup authentication if the RSA key file fails. Therefore, the note in step 8.d shall bemodified as
follows to clearly state the purpose of the requirement:
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Note: The PPMWorkbench requires that you provide a password, regardless of whether the
authentication uses RSA. If authentication with RSA fails, the password you provide here will
be used instead to connect to the remote host.

Information on how to configure the Microsoft Telnet server missing

Location: Installation and Administration Guide, version 9.20, page 66

Error: The document does not mention how to configure theMicrosoft Telnet server onWindows
2003 and 2008 servers. (QCCR1L51668)

Correction:Add a new section to the document under the "Installing a UNIX Emulator and Telnet
Server (Windows)" heading. For details, see "ConfiguringMicrosoft Telnet Server inWindows 2003
and 2008 Servers" on page 285

Information about setting JAVA_HOME in Cygwin missing

Location: Installation and Administration Guide, version 9.20, page 64

Error: The document does not mention how to set JAVA_HOME in Cygwin.

Correction:Add the following content to the guide:

Setting the JAVA_HOME value in Cygwin

To set the JAVA_HOME value in Cygwin,

1. Add the JAVA_HOME parameter to System Variables.

For detailed instruction, youmay refer to the "Setting the JAVA_HOME Value inWindows"
section on page 64 of the document.

2. (Optional, but recommended) Set the .bash_profile file.

a. Open the <Cygwin_HOME>/.bash_profile file in a text editor.

b. Add the following to the end of the file:

export JAVA_HOME=/cygdrive/<Drive_Letter>/<JDK_HOME>

export PATH=$JAVA_HOME/bin:$PATH

c. Save the .bash_profile file and quit.
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Instructions about LDAP password encryption procedures are confusing

Location: Installation and Administration Guide, version 9.20, page 220

Error: The instructions about KINTANA_LDAP_PASSWORD encryption procedures are confusing.
(QCCR1L52183)

Correction:Replace the text for the KINTANA_LDAP_PASSWORD parameter with the following.

l KINTANA_LDAP_PASSWORD. The KINTANA_LDAP_PASSWORD parameter in the server.conf file is
an encrypted string enclosed with #!!# character delimiters.

Example

com.kintana.core.server.KINTANA_LDAP_PASSWORD=#!#encryptedstring#!#

Youmay set the KINTANA_LDAP_PASSWORD parameter in two ways:

n Run the kConfig.sh script and provide the plaintext LDAP password when prompted. The
script will write out the server.conf file with the KDTA_LDAP_PASSWORD entry encrypted as
above. Or,

n If the LDAP password change is the only change you want to make to the server.conf file,
then do the following:

i. Run kEncrypt.sh, and provide the plaintext LDAP password when prompted.

ii. Paste the encrypted string output into the server.conf file KINTANA_LDAP_PASSWORD
entry enclosed with the #!!# character delimiters as in the example above.

Oracle database parameter optimizer_mode not documented

Location: Installation and Administration Guide, version 9.20, page 127

Error:Oracle database parameter optimizer_mode is not documented in the document, whichmay
cause performance issues when the parameter is not set to ALL_ROWS.

Correction:Add the following to the document:

OPTIMIZER_MODE

The OPTIMIZER_MODE parameter establishes the default behavior for choosing an optimization
approach for the instance.

Values:
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l first_rows_n

The optimizer uses a cost-based approach and optimizes with a goal of best response time to
return the first n rows (where n = 1, 10, 100, 1000).

l first_rows

The optimizer uses amix of costs and heuristics to find a best plan for fast delivery of the first
few rows.

l all_rows

The optimizer uses a cost-based approach for all SQL statements in the session and optimizes
with a goal of best throughput (minimum resource use to complete the entire statement).

Recommended Setting

Set this parameter to all_rows.

Default permissions for PPM Center schemas not documented

Location: Installation and Administration Guide, version 9.20, page 69; UpgradeGuide, version
9.20, page 46

Error: The following two permissions are not documented.

l grant create job

l grant execute on ctxsys.ctx_ddl

Correction:Add the following two permissions to the concerning documents:

l grant create job

l grant execute on ctxsys.ctx_ddl

Missing description for the WF_DISABLE_DELEGATE_DECISION_STEP
parameter

Location: Installation and Administration Guide, version 9.20

Error: The description for the WF_DISABLE_DELEGATE_DECISION_STEP parameter is missing.

Correction:Add the following line to the document:

Release Notes
Chapter 9: Documentation Errata

Page 275 of 310HP Project and Portfolio Management Center (9.22)



Parameter Name
(*Required,
**Required If)

Description, Usage Default and
Valid Values

WF_DISABLE_
DELEGATE_
DECISION_STEP

By adding this parameter to the server.conf file and
setting it to true, you can hide theDelegate
Decision button for workflow steps where the
Decision Required option is set toAt Least One or
All. If this parameter is not set or set to false, the
Delegate Decision button will be displayed.

Default: false

Valid values:
true, false

Language Pack Release Notes

Improper Oracle database settings recommended

Location: Language Pack Release Notes, version 9.20 (page 1), 9.21 (page 7)

Error: The document recommends improper settings for Oracle database properties as follows:

l Set the following Oracle database properties in addition to the standard PPM settings:

n NLS_LENGTH SEMANTICS = CHAR

n NLS_CHARACTERSET = UTF8

n NLS_NCHAR_CHARACTERSET = UTF8

(QCCR1L52311)

Correction: The correct settings shall be as follows:

l Set the following Oracle database properties in addition to the standard PPM settings:

n NLS_LENGTH SEMANTICS = CHAR

n NLS_CHARACTERSET = AL32UTF8

n NLS_NCHAR_CHARACTERSET = AL16UTF16
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Multilingual User Interface Guide

Incorrect description of HP Demand Management notifications

Location: Multilingual User Interface Guide, version 9.20, page 23

Error: The description of "HP DemandManagement notifications" contains incorrect information.

Correction: The correct description of "HP DemandManagement notifications" is as follows:

HP DemandManagement notifications are sent to recipients in the system language of the PPM
Center instance (as selected for the PPMCenter installation). The formatting of dates and numbers
displayed in notificationmessages is based on each recipient’s formatting locale (as specified on
theRegional Settings tab of the Edit My Profile page).

Incomplete description of installing Unicode fonts for export to PDF

Location: Multilingual User Interface Guide, version 9.20, page 49

Error: The description of "Installing Unicode Fonts for Export to PDF" is incomplete.

Correction: The following information shall be added to the description:

The dashboard settings do not apply to exporting translated work plans to PDF files. For work plans
containingmultiple languages, youmust update the <PPM_Home>/server/<PPM_Server_
Name>/deploy/itg.war/WEB-INF/conf/FontOptions_<language>.properties file and change
the font to one that supports all the languages used in your work plan.

Operational Reporting Administrator’s Guide

Incorrect E-Media Suggested for BusinessObjects Enterprise Bundles

Location: Operational Reporting Administrator’s Guide, version Content Pack 1.3, page 19 and
page 104

Error: In Step f, the document incorrectly suggests to download the BusinessObjects Enterprise XI
3.1 SP5 installation bundle and the BusinessObjects Enterprise XI 3.1 SP5 FP3 upgrade bundle by
selectingHP PPM 9.10 Eng SW E-Media orHP PPM 9.20 Eng SW E-Media.

Correction: Change Step f and Step g as follows:

f. Select HP PPM 9.10 Eng SW E-Media, and then click Get Software Updates.
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g. Click Get Software for T5570-15087 (PPM OpRpt BO 3.1 SP5.3 Windows Install) (This
software also applies to PPM Center 9.20).

Insufficient information about <Op_Reports_Home> folder

Location: Operational Reporting Administrator’s Guide, version Content Pack 1.3, pages 29, 32,
33, 78, 82 and 85.

Error: The document suggests to copy the files to the <Op_Reports_Home> folder. However, the
information about this folder is insufficient.

Correction: Add a note as follows after those steps:

The <Op_Reports_Home> folder is the BusinessObjects installation directory where you extract the
installation bundle for Operational Reporting Content Pack 1.3 to.

Non-existing Folder: DB

Location: Operational Reporting Administrator’s Guide, version Content Pack 1.3, Chapter 2 and
Chapter 3

Error: The document suggests to go to the <Op_Reports_Home>/DB folder. However, the DB folder
does not exist in the installation bundle for Operational Reporting Content Pack 1.3.

Correction: Remove all occurrences of the DB folder from Chapter 2 and Chapter 3 of the
document.

Incorrect Value Suggested for SS_INDEX_LOCATION

Location: Operational Reporting Administrator’s Guide, version Content Pack 1.3, page 34

Error: The value suggested for the SS_INDEX_LOCATION parameter is incorrect.

Correction: The correct value shall be C:\hp\ppm\reporting\boe31\BusinessObjects
Enterprise 12.0\data/search.

Overview of Platform Support
Microsoft Hyper-V listed as supported

Location:Overview of Platform Support, version 9.21, page 2

Error: The following virtualization configuration items are listed in the document as supported:
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l Microsoft Hyper-V runningMicrosoft Windows 2008 SP2 Enterprise Edition (32-bit)

l Microsoft Hyper-V running (Red Hat) Linux 4 (64-bit)

This is incorrect as Hyper-V was desupported on PPMCenter version 9.20.

Correction:Remove these items from the document.

HP Program Management Configuration Guide

The PMO - CR Level validation not documented

Location: HP ProgramManagement Configuration Guide, version 9.20, page 26

Error: The PMO - CR Level validation is not documented.

Correction: The following information shall be added as a warning on page 26:

Do not edit the PMO - CR Level validation because it is seed data. Editing it can cause both the
KPMO_PROGRAM_SCOPE_CHANGE_V view and the Program Scope Change List portlet to fail.

HP Project Management User’s Guide

Legend of work plan Gantt view not documented

Location: HP Project Management User’s Guide, version 9.20, page 109

Error: Legend of work plan Gantt view is not documented.

Correction: The following information shall be added:

To view theGantt legend of a work plan, click the icon next to theEdit drop-down list on the
Work Plan page. The icon appears only when you select Gantt View for theView drop-down list.

To view theGantt legend of a Project Gantt portlet, select theShow Legend checkbox in the
Display Options section on the Edit Portlet Preferences page.

Table below provides detailed information about items included in the Gantt legend.

Legend Item Description

Status of the task is ready.

Status of the task is in progress.
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Legend Item Description

or Status of the task is complete.

Status of the task is pending predecessor.

Status of the task is cancelled.

or The task is on the critical path of a work plan.

The task contains one or more exceptions.

The task is marked as amilestone.

The task is a summary task. Its color indicates the schedule health of the
task.

The pointed task has a predecessor. The arrow starts from the preceding
task and points to the pending task.

The pointed task has an external predecessor.

Release Notes

Issue causing the error message “An Error has occurred. The parameter
(portletNoPreview) is invalid or missing.” partially fixed

Location: Release Notes, version 9.14, third edition, page 109

Error: Issue causing the error message “An Error has occurred. The parameter
(portletNoPreview) is invalid or missing.” (under the tracking number 4629313349 or
defect number QCCR1L42882) was only partially fixed.

Correction:Move the description for the issue from the Fixes section of the document to the
Known Problems and Limitations in PPM Center 9.14 section.

Reports Guide and Reference

Insufficient information about the Security tab of Report Type window in
PPMWorkbench

Location: Reports Guide and Reference, version 9.20, page 191
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Error: The information about the Restricted Security Groups field and Allowed Security Groups
field under the Security tab of Report Type window is insufficient.

Correction: Add a note as follows in the Security Tab section of this guide:

Note: Only security groups that have Edit Report Types AND View Report Types access
grant can be shown in Restricted Security Groups field and Allowed Security Groups field.

HP Resource Management User’s Guide

Missing information about Total Assignment Calculation

Location: HP ResourceManagement User’s Guide, version 9.20, page 124

Error: The information about Total Assignment Calculation is missing.

Correction: Add a table note as follows for "Total Assignment" on page 124 of this guide:

Note: Total Assignment is calculated based on the project’s Cost and Effort settings:

l If “Staffing Profile represents the work load imposed by the project” is selected, Total
Assignment includes the sum of effort scheduled in the related staffing profiles.

l If “Work plan task assignments represents the work load imposed by the project” is
selected, Total Assignment includes the sum of the effort scheduled in the related work
plan.

System Requirements and Compatibility Matrix

Documentation does not clearly state that when language packs are
applied, integrations will not work.

Location: System Requirements and Compatibility Matrix, versions 7.5, 8.x, 9.1x, and 9.2x

Error: The document does not clearly state that when language packs are applied, PPM Center
integrations will not work. (QCCR1L37602)

Correction: The following note need to be added to theAnOverview of Language Support section
of the document:
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From version 7.5 to version 9.2x, PPM Center integrations with other HP Software products or
third-party products will not work if language packs are applied. However, the following integration
solutions available since PPMCenter version 9.20 support multiple languages:

l The View Project Quality integration solution

l The integration between PPMCenter tasks and HP Agile Manager

Even if the integrated product is an English-only instance, PPM Center can still retrieves data, but
displays the data in English.

Incorrect optional products listed

Location: System Requirements and Compatibility Matrix, version 9.20, pages 19

Error: The following optional products are listed as supported:

Visual Studio Tools for Office (VSTO)

l Version 2005 SE for Microsoft Project 2003

Microsoft Office Primary Interop Assemblies for Microsoft Project

l Version 2003 for Microsoft Project 2003

Correction: These two entries shall be removed as Microsoft Project 2003 is desupported on PPM
Center 9.20.

The document does not clearly indicate whether 32-bit or 64-bit of
Microsoft Project 2010 is supported

Location: System Requirements and Compatibility Matrix, version 9.20 (page 19), version 9.21
(page 19)

Error: The document does not clearly indicate whether 32-bit or 64-bit or both of Microsoft Project
2010 (Standard/Professional) are supported.

Correction:Both 32- and 64-bit of Microsoft Project 2010 (Standard/Professional) are supported.
Add "(both 32- and 64-bit)" to all items under theMicrosoft Project section.

Supported Java™ Plug-In version

Location: System Requirements and Compatibility Matrix, version 9.20 and 9.21, page 18;
Overview of Platform Support, version 9.20 and 9.21, page 2

Error: The two documents say the following about Java™Plug-In requirements:
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l Java 7 Update 11 (7u11) or later (32-bit and 64-bit) for all supported browsers

Correction:Remove "or later" from the line.

HP Solution Integrations Guide

Missing documentation on ksc_get commands related to QC/ALM

Location: HP Solution Integrations Guide, version 9.20, page 100

Error: The document lacks information about some ksc_get special commands.

Correction:Add description about the following ksc_get commands into the document:

Special Command Description

ksc_get_QC_Assigned_To_List Gets domain users from Quality Center

ksc_get_QC_Defect_Instance_Domains_
List

Gets a list of Quality Center instance domains for
defect

ksc_get_QC_Defect_Instance_Projects_
List

Gets a list of Quality Center instance projects for
defect

ksc_get_QC_Domain_List Get a list of Quality Center domains

ksc_get_QC_Instance_Domains_List Get a list of Quality Center instance domains

ksc_get_QC_Instance_List (Not in use) Gets a list of Quality Center instances

ksc_get_QC_Instance_Projects_List Gets a list of Quality Center instance projects

ksc_get_QC_Project_List Gets the available project for the Quality Center

ksc_run_QC_Automated_Testset Runs Quality Center automated test set

Table 3-24. Special commands for integration of PPM Center with Quality Center

Formore information about how to use special commands, see theCommands, Tokens, and
Validations Guide and Reference.

Upgrade Guide

Task 17 (Prepare a Back Out Plan) shall be a mandatory task

Location: UpgradeGuide, version 9.20, page 41

Release Notes
Chapter 9: Documentation Errata

Page 283 of 310HP Project and Portfolio Management Center (9.22)



Error: The content for the task goes as follows: "If there is an error during a PROD environment
upgrade, youmay want to restore the backup of the file system and database schema so PROD
environment down time is minimal. Then restore the PROD file system and database schema to
the STAGE environment and test the upgrade again." Usage of "may" here is too weak.
(QCCR1L52588)

Correction: The content for the task shall bemodified to the following:

Task 17: Prepare a Back Out Plan

If there is an error during a PROD environment upgrade, restore the backup of the file system and
database schema so PROD environment down time is minimal. Then restore the PROD file
system and database schema to the STAGE environment and test the upgrade again.
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Configuring Microsoft Telnet Server in Windows
2003 and 2008 Servers

Microsoft Telnet server configuration involves the following tasks:

l "Configure the Shell Startup and Login Scripts" below

l "Configure the Telnet Server" on page 287

l "Set the JAVA_HOME value in Cygwin" on page 289

l "Start theMS Telnet server service" on page 290

Configure the Shell Startup and Login Scripts
For theMS Telnet server to successfully invoke the BASH shell as the command shell, the
following two scripts must be created:

l Shell startup script: cygnus.bat

l Login script: login.cmd

Configure the shell startup script (cygnus.bat)

1. Choose a location for the startup script.

Convention dictates that this script be located in the Cygwin root directory. In this example,
assume the Cygwin root directory is located at C:\Program Files\cygwin\.

Note:Youwill also need the path to the Cygwin\bin\ directory. In this example, assume
the Cygwin\bin\ directory is located at C:\Program Files\cygwin\H-i586-
cygwin32\bin\.

2. In the Cygwin root directory, create a batch file named cygnus.bat, with the following
contents:

@ECHO OFF
SET MAKE_MODE=UNIX
SET PATH=C:\PROGRA~1\cygwin\H-I586~1\bin;%PATH%
echo thank you bill >nul
bash -login -noediting -noprofile -i
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Note:

n It is important to specify the PATH in this script, even if the system environment path
already includes the Cygwin\bin\ directory.

n The line “echo thank you bill >nul” is a trick to get around a bug that prohibited the
shell from starting. For more information, visit
http://www.cygwin.com/ml/cygwin/2002-01/msg01395.html.

n It is recommended to type the above text manually into the cygnus.bat file using a
standard ASCII text editor like Notepad or VI, rather than copying and pasting. Some
Microsoft Word non-ASCII characters are not recognized by the command shell, and
can lead tomysterious errors.

Configure the login script (login.cmd)

A login cmd script is required during Telnet session initiation. This can be as simple as a single-line
“echo” statement, or it can perform additional functionality upon session startup if desired.

In the Cygwin root directory, create a .cmd file named login.cmd, with the following contents
(replace the echo string with any desiredmessage):

echo 'welcome to <machine name>'

Setting the JAVA_HOME value in Cygwin

To set the JAVA_HOME value in Cygwin,

1. Add the JAVA_HOME parameter to System Variables.

For detailed instruction, youmay refer to the "Setting the JAVA_HOME Value inWindows"
section on page 64 of the document.

2. (Optional, but recommended) Set the .bash_profile file.

a. Open the <Cygwin_HOME>/.bash_profile file in a text editor.

b. Add the following to the end of the file:

export JAVA_HOME=/cygdrive/<Drive_Letter>/<JDK_HOME>

export PATH=$JAVA_HOME/bin:$PATH

c. Save the .bash_profile file and quit.
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Configure the Telnet Server
To do so,

1. Edit theMicrosoft Telnet server registry to specify the shell startup.

There is no interface provided for specifying the shell startup script, so this must be done
directly in the windows registry. This is a simple operation -only two parameters need to be
updated.

a. Go toStart > Run, enter regedt32, and click OK.

The Registry Editor window opens.

b. Go toHKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > TelnetServer > 1.0.

When you highlight the 1.0 folder, the parameter list is displayed in the right-hand panel of
the registry window.

c. Double-click theDefaultShell entry.

Enter the full path to the bash.exe file and then click OK to apply the change.

In this example, it is C:\cygwin\bin\bash.exe.

d. Double-click theShell entry and clear the existing value.

e. Double-click theSwitchToKeepShellRunning entry and clear the existing value.

f. Double-click the LoginScript entry and change the value to

-login -noediting -noprofile -i

2. Run the Telnet administration utility to configure the Telnet server settings.

A command-line utility called tlntadmn is provided for administering properties of the Telnet
server such as the authenticationmode, port number, number of simultaneous sessions
allowed, and so on.

The authenticationmodemust be configured to usePassword authentication, not NTLM
authentication. The port must be set to the default value 23.

To do so,

Release Notes
Chapter 9: Documentation Errata

Page 287 of 310HP Project and Portfolio Management Center (9.22)



a. In a DOS command shell, you can view the current Telnet server settings by simply
running tlntadmnwith no arguments. The help screen can be displayed by typing
tlntadmn /? at the command line.

b. To configure the Telnet server forPassword authentication, use the following command:

tlntadmn config sec=-NTLM+passwd

c. To configure the Telnet server for consolemode, use the following command:

tlntadmn config mode=console
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Tip: Themode of operation can be set to either of the two available options, Console or
Stream. If you will also be supportingmanual Telnet sessions, then theConsole setting
provides additional output formatting to facilitate a human user setting, and is thus
recommended.

Note:Make sure that the Telnet port is set to 23.

3. To change the PATH settings if all the UNIX commands are not working,

a. Go toControl Panel > System > Advanced > Environment Variables > System
varibles > Path, and click Edit.

The Edit System Variable dialog opens.

b. In theVariable value field, add the following entry:

;C:\<cygwin_base_path>\usr\bin

where <cygwin_base_path> is the path where Cygwin is installed.

c. Click OK three times.

Set the JAVA_HOME value in Cygwin
To set the JAVA_HOME value in Cygwin,
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1. Add the JAVA_HOME parameter to System Variables.

For detailed instruction, youmay refer to the "Setting the JAVA_HOME Value inWindows"
section on page 64 of the document.

2. (Optional, but recommended) Set the .bash_profile file.

a. Open the <Cygwin_HOME>/.bash_profile file in a text editor.

b. Add the following to the end of the file:

export JAVA_HOME=/cygdrive/<Drive_Letter>/<JDK_HOME>

export PATH=$JAVA_HOME/bin:$PATH

c. Save the .bash_profile file and quit.

Start the MS Telnet server service
Starting and stopping theMicrosoft Telnet server is done in the samemanner as starting and
stopping any otherWindows Service.

1. Go toStart > Control Panel > Administrative Tools > Services.

The Services control panel opens.

2. To start the service, highlight the row containing Telnet Server, and click theStart button.

3. To stop the service, highlight the same row and click theStop button.
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Setting Up Integration Between PPM Center 9.2x
and HP ALM 11.52 from Scratch

This section provides information for setting up a full integration between PPMCenter version 9.2x
and HP ALM version 11.52 from scratch.

This process includes the following tasks:

l "Task 1: Update the OOTB ALM - Request For ChangeWorkflow" below

l "Task 2: Create and configure a new project in ALM" on the next page

l "Task 3: Add scripts to perform the operation on HP ALM server side" on page 303

l "Task 4: Add an integration configuration entry in PPM Center" on page 305

l "Task 5: Create a request in PPM Center" on page 306

Prerequisites
Make sure the following prerequisites aremet:

l PPMCenter version 9.2x is installed, with ALM content bundle deployed.

l TheOracle datatbase is already there

l HP ALM version 11.52 is installed

Task 1: Update the OOTB ALM - Request For Change
Workflow

To do so,

1. Log on to PPM Center as administrator.

2. From themenu bar, select Open > Administration > Open Workbench.

The PPMWorkbench opens.

3. From the shortcut bar, select Configuration > Workflows.

TheWorkflow Workbench opens to the Query tab.
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4. Click List and then, on theResults tab, double-click ALM - Request For Change.

TheWorkflow windows opens to the Layout tab.

5. Go to step 23. Non Release Sub WF, right click and select Edit Source from the context
menu.

TheWorkflow: Non Release SubWF window opens to the Layout tab.

6. Right click step 4. Quality Process Mode, and select Edit from the context menu.

TheWorkflow Step window opens to the Properties tab.

7. Update the value forRequest Status toApproved.

8. Click OK.

9. Click Save and exit the workflow completely.

Task 2: Create and configure a new project in ALM
To create a new project in Site Administration of ALM,
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1. Log on to Site Administration of ALM.

2. On the Site Projects tab, navigate to the desired location, and provide a path for your project in
thePhysical Directory field, and click Create Project.

3. In the Create Project dialog, select Create an empty project, and then click Next.

4. Enter a project name in theProject Name field, select a domain for the project from the In
Domain drop-down list, and then click Next.
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5. Select Oracle as Database Type, and then provide credentials for the DB Server in theServer
Name, DB Admin User, andDB Admin Password fields, and then click Next.

6. Specify tablespaces, and then click Next.
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7. Select project administrators, and then click Next.

8. Select extensions to activate for the project, and then click Next.
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9. Review summary of project information, select Activate project , and then click Create.

10. Click OK when the confirmationmessage box pops up.
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11. Run the following SQL script to enable hidden fields in the ALM project for the requirement
module for the integration:

update <db_name>.SYSTEM_FIELD set sf_is_active = 'Y', SF_IS_VISIBLE_IN_N
EW_BUG='111111', sf_is_system = 'N', sf_udf_version=1, sf_can_change_per
missions='Y', sf_is_transition_logic='Y', sf_grant_modify='111001' where
sf_table_name = 'REQ' and SF_COLUMN_NAME like 'RQ_REQUEST%';

commit;

Note: This script applies to HP ALM with Oracle as database.

For instructions on how to enable hidden fields in the HP ALM project for the defect
module for the integration, go to
http://support.openview.hp.com/selfsolve/document/KM1352699.

Note: The configuration information provided here is based on the out-of-the-box ALM -
Request For Change workflow. If your organization has customized any out-of-the-box
workflow, make sure you adjust the SQL script accordingly.

12. In Site Administration, deactivate the project, repair the project, and then activate the project.
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13. Check in ALM groups and permissions if the fields are active.
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14. Go toProject Lists > Requirement Status to check if any status is missing.
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The statuses are not complete.

15. Add request statuses that PPM Center workflow (ALM - Request For Change) contains but
ALM requirement does not. To do so,

a. Log on to the integrated ALM project.

b. From themenu bar, click Tools > Customize > Project Lists > Requirement Status >
New Item.

c. Set Item Name as the following PPM request status name, and add them one by one:

o Build

o Pending Approval

o Approved

o Test

o Resource Assessment

o Pending Rework

o Run Impact Analysis

o Impact Assessment
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o Ready for Review

o 6-Running Sanity Tests in Quality Center

o Backout

o Pending Requestor Sign-off

o Review Results Post Deployment

o Closed - Successful

o Closed – Failed

16. Return to the ALM project schema database.

Update the TRAN_RULES table by running the following script:

update <database schema name of your QC/ALM project>.tran_rules

set tr_rules='New,1-Requirements Setup Completed' || chr(10) || '1-Requir
ements Setup Completed,2-Test Plan Setup Completed' || chr(10) || '2-Test
Plan Setup Completed,3-Test Lab Setup Completed' || chr(10) || '4-Running
Tests in Quality Center,5-Test Execution Completed' || chr(10) || '3-Test
Lab Setup Completed,Build' || chr(10) || 'Build,Pending Approval' || chr(
10) || 'Pending Approval,Approved' || chr(10) || 'Approved,4-Running Test
s in Quality Center' || chr(10) || 'Approved,Test' || chr(10) || '4-Runni
ng Tests in Quality Center,Pending Rework' || chr(10) || 'Test,Pending Re
work' || chr(10) || '4-Running Tests in Quality Center,Resource

Release Notes
Chapter 9: Documentation Errata

Page 301 of 310HP Project and Portfolio Management Center (9.22)



Assessment' || chr(10) || 'Test,Resource Assessment' || chr(10) || 'Resou
rce Assessment,Run Impact Analysis' || chr(10) || 'Run Impact Analysis,Im
pact Assessment' || chr(10) || 'Impact Assessment,Ready for Review' || ch
r(10) || 'Ready for Review,Run Impact Analysis' || chr(10) || 'Ready for
Review,Pending Approval' || chr(10) || 'Approved,6-Running Sanity Tests i
n Quality Center' || chr(10) || 'Pending Rework,Closed - Failed' || chr(1
0) || 'Pending Rework,Build' || chr(10) || '6-Running Sanity Tests in Qua
lity Center,Closed - Failed' || chr(10) || 'Pending Rework,Test' || chr(1
0) || '6-Running Sanity Tests in Quality Center,Test' || chr(10) || 'Test
,Pending Requestor Sign-off' || chr(10) || 'Test,Backout' || chr(10) || '
Backout,Pending Requestor Sign-off' || chr(10) || 'Build,Pending Requesto
r Sign-off' || chr(10) || 'Pending Requestor Sign-off,Review Results Post
Deployment' || chr(10) || 'Review Results Post Deployment,Closed - Succes
sful' || chr(10) || 'Review Results Post Deployment,Closed - Failed'

WHERE tr_field_name = 'RQ_REQUEST_STATUS';

commit;

Note: The configuration information provided here is based on the out-of-the-box ALM -
Request For Change workflow. If your organization has customized any out-of-the-box
workflow, make sure you adjust the SQL script accordingly.

17. In Site Administration, deactivate the project, repair the project, and then activate the project.

18. Check again for TRAN_RULES in the permissions of the PPMRequest Status.
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Task 3: Add scripts to perform the operation on
HP ALM server side

Note: The configuration information provided here is based on the out-of-the-box ALM -
Request For Change workflow. If your organization has customized any out-of-the-box
workflow, make sure you adjust the scripts accordingly.

To do so,

1. Add scripts to perform the operation on HP ALM server side.

a. Log on to HP ALM as administrator.

b. From themenu bar, click Tools > Customize > Workflow > Script Edit.

The Script Editor opens.
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c. From the navigation pane, select Requirement module script, then go to the last script of
this category, copy and append the content of add requirement script.txt to the end of
the script in the editing pane.

Note: To obtain the add requirement script.txt, go to KM00630244 and click
workflow scripts to download the zip package.

d. Click Save.

The new script is added to theRequirement module script.

e. From the navigation pane, select Defect module script, then go to the last script of this
category, copy and append the content of add defect script.txt to the end of the scrip
in the editing pane.

Note: To obtain the add defect script.txt, go to KM00630244 and click workflow
scripts to download the zip package.

f. Click Save.

The new script is added to theDefect module script.

g. Exit and log off.

2. Run the SQL scripts provided by HP Software Support manually.
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For instructions on how to activate workflow script in HP ALM project, go to
http://support.openview.hp.com/selfsolve/document/KM1352700

Task 4: Add an integration configuration entry in PPM
Center

1. Log on to PPM Center.

2. From themenu bar, click Open > Administration > Integrations.

The Integration landing page opens to theManage Application Change tab.

3. In the Server Configuration Details section, select ALM – Request for Change (RFC) from
the drop-down list and click Add Integration Configuration.
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Note: TheDefault QC/ALM Folder Name is the folder that will store the requirements
created with this integration.

4. Click Next.

5. Provide values for the fields as desired or leave as is until the wizard has finished.

Task 5: Create a request in PPM Center
1. Create a request in PPM Center.

Release Notes
Chapter 9: Documentation Errata

Page 306 of 310HP Project and Portfolio Management Center (9.22)



Note: TheQC/ALM Instance andQC/ALM Domain fields are prepopulated. This also
applies to theQC/ALM Project field if there IS only one project. If you have associated
your Request Type with several projects, this field is not populated. Use a rule or populate
the field manually.

2. Follow the workflow until the request is pushed to ALM.
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3. Follow the request to closure.
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Release Notes (Project and Portfolio Management Center 9.22)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to HPSW-BTO-PPM-SHIE@hp.com.
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